
 

PanelMate® Power Pro 
Configuration Editor 
Software User’s Guide 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Eaton Corporation 
Cutler-Hammer Business Unit 
811 Green Crest Drive 
Columbus, OH  43081 



 

Preface 
Information in this manual is subject to change without notice and does not represent a 
commitment on the part of Eaton’s Cutler-Hammer, Inc. Permission is granted to duplicate 
this material without modification only for your use or the internal use of other members of 
your company or your agents to assist you in the use and servicing of products purchased 
from Eaton’s Cutler-Hammer. No permission is granted to modify this material or include this 
material in a compilation. 

RESTRICTED RIGHTS LEGEND 

Use, duplication, or disclosure by the Government is subject to restrictions set forth in 
paragraph (b)(3)(B) of the Rights in Technical Data and Computer Software clause of DAR 
7-104.9(a). Contractor/Manufacturer is Eaton Corporation’s Cutler-Hammer Business Unit, 
811 Green Crest Drive, Columbus, OH 43081. 

TRADEMARKS 

PanelMate is a federally registered trademark of Eaton Corporation. MS-DOS, Microsoft, and 
Windows are federally registered trademarks of Microsoft Corporation. Data Highway and 
Data Highway Plus are trademarks of Allen-Bradley. DeviceNet is a trademark of Open 
DeviceNet Vendor Association. Iomega is a federally registered trademark of Iomega 
Corporation. 

Commercial brand names (trademarks) of products of manufacturers or developers, other than 
Eaton Corporation or its affiliates, that appear in this manual may be registered or 
unregistered trademarks of those respective manufacturers or developers, which have 
expressed neither approval nor disapproval of Cutler-Hammer products and services. 

2002 Eaton Corporation. All rights reserved. 

Printed in the United States of America. 

P/N 01-00490-01 

 

 





2 Configuration Editor User’s Guide 

Support Services 
The goal of Eaton’s Cutler-Hammer business unit is to ensure your greatest possible satisfaction with 
the operation of our products. We are dedicated to providing fast, friendly and accurate assistance. 
That is why we offer you so many ways to get the support you need. Whether it's by phone, fax or 
mail, you can access Eaton’s Cutler-Hammer support information 24 hours a day, seven days a week. 
Our wide range of services are listed below.  

You should contact your local distributor for product pricing, availability, ordering, expediting and 
repairs. 

Website Address www.cutler-hammer.eaton.com 

Use the Cutler-Hammer website to find product information. You can also find information on local 
distributors or Cutler-Hammer sales offices. 

e-TRC  
Technical Resource Center 
(support for OI, PLC & IPC) 

VOICE: 
• 800-809-2772, selection 5  (8:00AM-5:00PM EST) 
• 414-449-7100, selection 5  (8:00AM-5:00PM EST) 
FAX: 614-882-0417 
EMAIL: CHATechSupport@eaton.com 
AFTER-HOURS PLANT DOWN EMERGENCY: 
• 800-809-2772, selection 5  (5:00PM-8:00AM EST) 
• 414-449-7100, selection 5  (5:00PM-8:00AM EST) 

If you are in the US or Canada, and have OI/PLC/IPC questions, you can take advantage of our toll-
free line for technical assistance with hardware and software product selection, system design and 
installation, and system debugging and diagnostics. Technical support engineers are available for calls 
during regular business hours. 

Information Fax-Back Service VOICE: 614-899-5323 
The latest Cutler-Hammer product information, specifications, technical notes and company news are 
available to you via fax through this direct document request service. Using a touch-tone phone, you 
can select any of the info faxes from our automated product literature and technical document library, 
enter a fax number and receive the information immediately. 

Repair and Upgrade Service 
(support for OI & IPC) 

VOICE: 
• 800-809-2772, selection 5  (8:00AM-5:00PM EST) 
• 414-449-7100, selection 5  (8:00AM-5:00PM EST) 
FAX: 614-882-3414 
EMAIL: RepairCHA@eaton.com 

If you have questions regarding the repair or upgrade of an OI/IPC, contact your local distributor. 
Additional support is also available from our well-equipped Repair and Upgrade Service department. 

European PanelMate Support 
Center 

VOICE: +41 1 806 64 44 (9:00AM-5:00PM CET) 
EMAIL: CHSupport@bfa.ch 

This center, located in Zurich, Switzerland, provides high-level quality support and product repair 
services for your PanelMate products. You will receive real-time technical and application support. 

 

mailto:CHATechSupport@eaton.com
mailto:RepairCHA@eaton.com
mailto:CHSupport@bfa.ch
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Installing the Configuration Software 

1 

In this chapter, you will learn: 

• How to install the Configuration Software 

• About the Product Features  
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Installing the Configuration Software 
The Software Kit contains a CD-ROM for fast, easy software installation. Select Install Software, and 
then select the software files you wish to install: 

• Configuration Software files 
• Configuration Database files 
• Transfer Utility files 
• Executive Firmware files 
• PanelMate PC Runtime files 

Note: Before installing the configuration software, make sure that you close all open applications. 

Note: If installing the PanelMate Runtime Software only, deselect the other selections and only 
check the box for the PanelMate PC Runtime selection. 

Note: If you are upgrading your configuration software, you do not need to install the Configuration 
Database files. However, if you do not deselect this box, your existing database will be 
renamed and a new database will be installed. On-screen prompts detail available options. 

Note: PanelMate PC default fonts are not automatically installed in the Windows Font directory. 
Follow the installation prompts to install the PanelMate fonts and reboot the PC prior to 
running PanelMate PC. 

After selecting the directory and subcomponent files to install, press the Install button. When the 
installation is finished, press the YES button in the Question dialog box to review the readme.txt file. 
The readme.txt file lists all the issues addressed from the previous version of software, lists the 
enhancements to the current version of software, and lists the new issues with the current version of 
software. After reviewing the readme.txt file, press the OK button in the Installation Complete dialog 
box. You may then install the drivers you need, or exit the installation utility. 
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Product Features 
The following product features can be purchased from Cutler-Hammer. If you have purchased the 
feature, the feature must be selected in the New Configuration dialog box or the Configuration 
Properties dialog box in the configuration software. 
Note that some features are standard and cannot be disabled. 

Color Display 
The Color Display Feature allows you to select a color configuration. If this box is not checked, the 
configuration will be grayscale. 

High Capacity Unit 
The High Capacity Unit feature allows you to create a larger number of pages and messages than 
permitted in the Standard Capacity environment.  Refer to the table below for feature limits.  Note that 
all PanelMate Power Series models with Catalog Item numbers that end in X (e.g. 52PKHX), all 
PanelMate Power Pro models and PanelMate Pro LT models come with the High Capacity feature 
already installed.  If necessary, users can expand their PanelMate Power Series units to High Capacity 
by ordering option PMUPGRADE. 

Product Type  Maximum 
Number of Pages 

PanelMate Power Series 1500 50 2500 
All other PanelMate Power Series models 100 5000 
PanelMate PC 200 10000 

Note that the complexity of the configuration may reduce the number of pages and messages in the 
PanelMate unit. 

Advanced Trending Template 
The Advanced Trending Template feature allows you to configure Advanced Trending Templates 
which display a history of a reference’s value over a period of time. Advanced trending features 6 pens 
that can be triggered by time or event. 
For information on configuring an Advanced Trending Template, refer to the Line Trend Template 
topic. 
Note that ALL PanelMate Power Series units with Catalog Item numbers that end in X (e.g. 
52PKHX), PanelMate Power Pro units and PanelMate Pro LT come with the Advanced Trending 
Template feature already installed.  The Advanced Trending Template option is included in the 
Catalog Item PMUPGRADE or the required software can be downloaded from the Cutler-Hammer 
website for free. 

 

 

Allen-Bradley DH-485 
The Allen-Bradley DH-485 feature allows you to communicate to the Allen-Bradley DH-485 
Highway. 

Modicon Modbus 
The Modicon Modbus feature allows you to communicate to Modicon PLCs via the Modicon Modbus 
or Modicon Modbus Plus. 

Note that ALL PanelMate Power Series units with Catalog Item numbers that end in X (e.g. 
52PKHX), PanelMate Power Pro units and PanelMate Pro LT come with the Modicon Modbus feature 
already installed.  The Modicon Modbus option is included in the Catalog Item PMUPGRADE or the 
required software can be downloaded from the Cutler-Hammer website for free. 
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Dynamic Graphics 
The Dynamic Graphics feature allows symbols to change colors and shapes dynamically on PanelMate 
Power Series 1500 models. 

Note that ALL PanelMate Power Series 1500 units with Catalog Item numbers that end in X (e.g. 
1555THX) come with the Dynamic Graphics feature already installed.  The Dynamic Graphics feature 
option is included in the Catalog Item PMUPGRADE or the required software can be downloaded 
from the Cutler-Hammer website for free. 

256 Greyscale/Color (Model 1555/1575)  
The 256 Greyscale/Color (Model 1555/1575) feature enhances the PanelMate Power Series 1500. 

If you have a PanelMate Power Series 1500 (Model 1555) and you select the 256 Greyscale/Color 
feature, you will have 256 shades of gray (instead of the standard 4 solid/4 blinking shades), 
PowerAnimation, and PowerBlink. 

If you have a PanelMate Power Series 1500 (Model 1575) and you select the 256 Greyscale/Color 
feature, you will have a 256 color palette (instead of the standard 8 solid/8 blinking colors), 
PowerAnimation, and PowerBlink. 

PowerAnimation allows you to create animation by defining a series of graphic objects which blink in 
sequence and PowerBlink allows you to create graphic objects which blink at different rates. 

I/O Count Expansion (Model 1155/1175) 
The I/O Count Expansion feature increases the number of I/O references allowed by the PanelMate 
Pro LT 1100.  By default, the PanelMate Pro LT 1100 allows up to 64 I/O references in a 
configuration.  Additional I/O references can be purchased, in groups of 64 I/O references, up to a 
maximum of 512 I/O references.  Refer to Chapter 12: Using Tags for more information on how a 
PanelMate Pro LT 1100 counts I/O references 

CAUTION: Once a tag upgrade is loaded onto a PanelMate Pro LT 1100, it is there permanently. It 
cannot be removed or relocated to another unit or back to the tag key. Careful planning in determining 
the number of actual tag references that are to be used should be exercised before loading a tag 
upgrade. 
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Main Screen 

2 

In this chapter, you will learn: 

• About the Main Screen 

• About the File Menu selections 

• About the Edit Menu selections 

• About the Object Menu selections 

• About the View Menu selections 

• About the Window Menu selections 

• About the Help Menu selections 

• About the Toolbar selections 

• About the Color Selection Palette 

• About the Status Bar 

• About Tool Palette selections 
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Main Screen 
The Main Screen appears when you run the PanelMate Configuration Editor. 

   
The Database TreeView Window will appear on the Main Screen. For more information about the 
Database TreeView Window, refer to the Database Treeview Window topic. 
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File Menu 
The File menu varies depending upon whether the database is open. 

Tip: When the database is open, the Database Treeview Window will appear. 
If the database is not open, the following File Menu will appear. 

  
If the database is open, the following File Menu will appear. 

  
The selections in the File Menu are described below. Note that some of the selections are available 
from the toolbar. Refer to the toolbar topic for more information. 

Open Database: Opens the Open Database dialog box and allows you to select a database. 

Backup Database: Opens the Backup Database dialog box and allows you to backup your database. 

Close: Closes the database. 

Save: Saves the highlighted configuration to the database. 

Save As: Opens the Save As dialog box. This selection is used if you wish to save a configuration to 
the database under a new name. 

Convert: Opens the Conversion dialog box. This selection is used if you wish to convert a 
configuration from one model to another (e.g., PanelMate Power Series 2000 to PanelMate Power 
Series 3000). 
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Verify: Opens the Verify Application dialog box. This selection checks all PLC references and 
expressions. 

References =>Tags: Performs a reference-to-tag replacement operation. Refer to Chapter 12: Using 
Tags for more information on this operation. 

Import: Opens the Import dialog box. This selection allows you to import the selected configuration 
file into the database. 

Export: Opens the Export dialog box. This selection allows you to export the selected configuration 
file from the database to a current version configuration file. 

Export As: Opens the Export As dialog box. This selection will export the selected configuration file 
from the database to an earlier version configuration file (e.g., V2.1X). 

VCP Transfer: Executes the PanelMate Transfer software. This selection allows you to transfer 
configuration files, execute firmware, and drivers to and from the PanelMate unit. 

Tip: Before a configuration file can be transferred to a PanelMate unit, the configuration file 
must be exported. 

Print: Opens the Configuration Editor Reports dialog box. This selection allows you to print a hard 
copy of the current configuration. 

For information on printing an image of a configuration page, refer to the Printing a Configuration 
Page topic. 

Exit: Ends the PanelMate Configuration Editor session. 
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Open Database 
When you choose the Open Database dialog box from the File Menu, the Open Database dialog box 
will appear. 

 
The Open Database dialog box allows you to select a PanelMate database. The default database 
(named model) is created during the installation process. The model database is actually a group of 
files located in the model subdirectory under the PanelMate Configuration Editor directory 
(c:\pmconfig by default). Many files (over 100) make up a PanelMate database. 

Other PanelMate databases can be accessed from the Open Database dialog box by selecting the drive 
and folder in which a valid PanelMate database resides. A single file from the database (pmconfig.db) 
indicates that the folder contains a viable database. Once a folder is selected which has a valid 
database and the OK button is clicked, the Configuration Editor will open the database, display the 
Database Treeview Window, and allow you to create or edit a configuration. 

If you install new configuration software that has an upgraded database and attempt to open an earlier 
version of the database, the Upgrade Database dialog box will appear. (Note that not every new 
configuration software version will have an upgraded database.) The Upgrade Database dialog box 
allows you to upgrade any earlier version of the database to be compatible with the new configuration 
software. For more information on upgrading the database, refer to the Upgrade Database topic. 

See the Configuration Editor Problems topic if problems are encountered when attempting to open a 
database. 
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Upgrade Database 
If you install new configuration software that has an upgraded database and attempt to open an older 
version of the database, the Upgrade Database dialog box will appear. (Note that not every new 
configuration software version will have an upgraded database.) 

  
The Upgrade Database dialog box allows you to upgrade any earlier version of the database to be 
compatible with new configuration software. The default upgrade directory is created by adding the 
subdirectory \backup\v320cfgs to your current database directory. Make sure you store the original 
database to a directory other than the standard backup directory used in the Backup Database dialog 
box. To change the upgrade directory, click on Directory to upgrade database button and enter the 
directory pathname. 

Press the Upgrade button to upgrade your database. When completed, a Print button will appear to 
allow you to print the upgrade progress. 
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Backup Database 
When you choose the Backup Database dialog box from the File Menu, the Backup Database dialog 
box will appear. 

  
The Backup Database dialog box allows you to backup your database. The default backup directory 
is created by adding the subdirectory \backup\v420cfgs to your current database directory. To change 
the backup directory, click on Directory to backup database button and enter the directory 
pathname. 

Press the Backup button to backup your database. When completed, a Print button will appear to 
allow you to print the backup progress. 
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Save As 
When you select a configuration filename in the Database Treeview Window and choose the Save As 
selection from the File Menu or click on the Save button in the toolbar, the Save As dialog box will 
appear. 

  
The Save As dialog box allows you to save a configuration file. This selection is used if you are 
saving a new configuration or if you wish to save a configuration under another name. 
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Conversion 
When you select a configuration filename in the Database Treeview Window and choose the Convert 
selection from the File Menu, the Conversion dialog box will appear. 

 
This Conversion dialog box allows you to convert a configuration file from one PanelMate hardware 
model to another (e.g., PanelMate Power Series 2000 to PanelMate Power Series 3000). If there are 
any conversion issues between PanelMate models, a dialog box will appear which will state the issues 
and ask if you wish to continue with the conversion. If you press the Yes button to continue, be aware 
of the issues noted in the dialog box. 

When converting to a PanelMate Power Series 1500 configuration, note the following items. 

• If your configuration has PowerGraphics, the graphics cannot be converted unless the 
PanelMate Power Series 1500 has the PowerGraphics option installed. 

• If your configuration exceeds the capacity of the standard PanelMate Power Series 1500, but 
does not exceed the capacity of the expanded PanelMate Power Series 1500, the Capacity 
Expansion Kit option will be selected in the New Configuration dialog box for the converted 
configuration. 

• If your configuration exceeds the capacity of the expanded PanelMate Power Series, an error 
message will be displayed and the configuration will not be converted. 

Refer to the Product Features topic for more information about the Capacity Expansion Kit. 
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Verify Application 
When you select a configuration filename in the Database Treeview Window and choose the Verify 
selection from the File Menu, the Verify Application dialog box will appear. 

 
The Verify selection checks all PLC references and expressions in all configured dialog boxes and lists 
all invalid or illegal PLC references and expressions which would prevent a valid export. 
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Import 
When you choose the Import selection from the File Menu, the Import dialog box will appear. 

  
The Import dialog box allows you to import a configuration file into the database. Note that earlier 
PanelMate Power Series configuration files and PanelMate Series V2.1X configuration files may also 
be imported. 

PanelMate Series V2.1X configuration files will have one of the following extensions:  

PanelMate Series 2000 Grayscale .PC1 or .PC2 

PanelMate Series 2000 Color .PC5 or .PC6 

PanelMate Series 3000 Grayscale .PC1 or .PC2 

PanelMate Series 3000 Color .PC5 or .PC6 

PanelMate Series 4000 .PC3 or .PC4 

Tip: Once the configuration file is imported, it can be exported to a current configuration 
file, to an earlier PanelMate Power Series configuration file, or to a PanelMate Series 
V2.1X configuration file. Refer to the Export and Export As topics for more information 
on exporting configurations. 

The Import selection and Export selection in the File Menu may be used to copy configurations from 
one personal computer to another. After export, a configuration (.PPS file) can be copied to another 
computer and imported into another PanelMate database. When using this method to copy 
configurations, please note the following issues: 

• Test message numbers in Display Templates and Variable-Sized Display Templates are not 
exported. Therefore, all test message numbers in an imported configuration are set to zero (0). 

• Group attributes are not exported. If a configuration had groups prior to export, the imported 
configuration would show all objects ungrouped. 

• The displayed states for Indicator, Variable-Sized Indicator, and Variable-Sized Graphic 
Templates are not exported. On import, the selected state of Variable-Sized Indicators is set 
to state one (1), and Indicator Templates and Variable-Sized Graphic Templates are set to 
state five (5). 

An alternate method for copying configurations from one system to another is by copying all database 
files to a new database directory on the target system. Shareware, zip, and unzip utilities are available 
to easily do this via floppy disk. This method will retain all Configuration Editor information including 
test messages, groups, and indicator selections. 

CAUTION: Before proceeding with the alternate method described above, ensure that the database 
window is closed in the PanelMate configuration software. Failure to close the database before 
copying the files may cause the database to become locked. 
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Export 
Tip: If you wish to export to an earlier PanelMate Power Series configuration file or to a 

PanelMate Series V2.1X configuration file, refer to the Export As topic for more 
information. 

Note that configuration files must be exported before being transferred to the PanelMate unit. 

When you select a configuration filename in the Database Treeview Window and choose the Export 
selection from the File Menu, the Export dialog box will appear. 

  
The Export dialog box allows you to export a configuration file for the current Configuration Editor 
software version.  

The Export selection and Import selection in the File Menu may be used to copy configurations from 
one personal computer to another. After export, a configuration (.PPS file) can be copied to another 
computer and imported into another PanelMate database. When using this method to copy 
configurations, please note the following issues: 

• Test message numbers in Display Templates and Variable-Sized Display Templates are not 
exported. Therefore, all test message numbers in an imported configuration are set to zero (0). 

• Group attributes are not exported. If a configuration had groups prior to export, the imported 
configuration would show all objects ungrouped. 

• The displayed states for Indicator, Variable-Sized Indicator, and Variable-Sized Graphic 
Templates are not exported. On import, the selected state of Variable-Sized Indicators is set 
to state one (1), and Indicator Templates and Variable-Sized Graphic Templates are set to 
state five (5). 

An alternate method for copying configurations from one system to another is by copying all database 
files to a new database directory on the target system. Shareware, zip, and unzip utilities are available 
to easily do this via floppy disk. This method will retain all Configuration Editor information including 
test messages, groups, and indicator selections. 
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Export As 
The Export As dialog box allows you to export to an earlier PanelMate Power Series configuration 
file or to a PanelMate Series V2.1X configuration file for earlier Configuration Editor software 
versions. 

Tip: If you wish to export to a current PanelMate Power Series configuration file, refer to the 
Export topic for more information. 

Tip: For guidelines to consider before exporting to a V2.1X configuration, refer to the V2.1X 
Export Guidelines topic. 

Note that configuration files must be exported before being transferred to the PanelMate unit. 

When you select a configuration filename in the Database Treeview Window and choose the Export 
As selection from the File Menu, the Export As dialog box will appear. 

  
Before the configuration file is exported, the configuration file will be verified. The verification 
process checks for the following: 

• Number of messages 

• Number of pages 

• Presence of PowerGraphics 

• Compatibility issues 
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If you select to export to a PanelMate Series V2.1X configuration file, a V2.11 Options dialog box 
will appear. 

 
You can check the Graphics Option box to set the graphics option in the V2.1X configuration file. If 
the Graphics Option box is not checked, the variable-sized graphics and symbols will not be exported. 

After the V2.11 Options dialog box appears, the configuration file will be verified and the results of 
the verification will be displayed in the Verification Status dialog box. Refer to the Verification 
Status topic for more information. 

For more information about the verification process for exporting, see the V2.1X Export Guidelines 
topic or the V2.1X Export Errors topic. 
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Verification Status 
If you choose to export to a V2.1X configuration file in the Export As dialog box, the configuration 
file will be verified and then the Verification Status dialog box will appear. 

  
The Verification Status dialog box displays the configuration options of the file, the items that will 
not be exported, and the reason for not exporting the items. 

Note that if you correct any errors, you must export the configuration file again. If you leave the 
Verification Status dialog box open while making changes to your configuration, the changes will not 
be exported. The configuration is always exported exactly as it appears in the Verification Status 
dialog box. For more information about the verification process for exporting, see the V2.1X Export 
Errors topic or the V2.1X Export Guidelines topic. 

The selections on the Verification Status dialog box are described below. 

Continue: Exports the configuration according to the results listed in the Verification Results list. 

Cancel: Closes the dialog box without exporting the configuration. 

Print: Prints a hard copy of the verification list on the default printer. 
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V2.1X Export Guidelines 
When exporting to a V2.1X configuration, the following guidelines should be considered. 

Text strings are decomposed into individual character elements. 
V2.1X does not support text strings.  

All text elements on a page are used to create a single V2.1X Static Page Symbol that is made up 
of individual character elements. You can place and edit the Character Elements individually. 

The Auto-Centering attribute is lost during export. 
V2.1X does not support auto centering. Everything is exported as left justified. 

The Direct Select (Touchscreen Only) field is lost during export. 
The Direct Select (Touchscreen Only) in the System Parameters field is not supported by V2.1X. 

Colors are converted to their closest match. 
V2.1X configurations contain up to eight colors. Some PanelMate Power Series configurations 
contain up to 256 colors. 

Blinking foreground colors are lost during export. 
Blinking foreground colors are not supported by V2.1X. 

The default label Reset PLC Comm is changed to Enable Fault Relay. 
PanelMate Power Series 1500 is exported as PanelMate Series 2000/PanelMate Series 3000 when 
going to V2.1X. The default label Reset PLC Comm does not exist. 

Maintenance Template options Allow on Page, Enable Writes, and Protection are lost 
during export. 

Maintenance Templates are not supported by V2.1X. 

Some System Parameter fields are converted during export. 
Scan Delays (Screen, Alarm, Message, and Trend) are exported as part of the PLC Name and Port 
Table. 

The Screen Blanking Inactivity Period is rounded to the nearest 20 minute interval. 

The Control Bit Reset Delay is rounded to the nearest 250 mSec interval. 

The Password Protection Time Out is rounded to the nearest five minute interval. 

The Maintenance Template Soft Key Prompts, Contrast Adjustment Soft Key Prompts, 
Touchscreen Button Templates, Touchscreen Keypad Entry Labels, Touchscreen 
Control Keys, and the Switch To Two Column Keypad and Switch to Three Column 
Keypad labels from the Setup Page are lost during export. 

These Online Labels are not supported by V2.1X. 

The Refresh Background Graphics Online feature on the Variable-Sized Graphics 
Template - VS Graphics Attributes Tab dialog box is not exported. 

This option is not supported by V2.1X. 
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V2.1X Export Errors 
Before the configuration file is exported, the configuration file is checked for features not supported 
by V2.1X configuration software. If there are features that cannot be exported, you will see one or 
more of the following error messages: 

Error Message Reason for Error 

Any element is not on a character boundary (X, 
Y). 

X must be a multiple of 8. 
Y must be a multiple of 16. 

Symbol offset is not on a character boundary 
(X, Y). 

X must be a multiple of 8. 
Y must be a multiple of 16. 

Any element overlaps another element. Overlapping elements are not allowed in 
V2.1X. 

The Graphics Option is not set. Set this option on the V2.1X Options dialog 
box if graphics are used. 

PowerGraphics are included. Symbols and static graphics containing 
PowerGraphics are not supported by V2.1X.  

PowerGraphics include lines, rectangles, 
polygons, ellipses, and arcs. 

PanelMate Power Series templates are included. PanelMate Power Series templates such as Line 
Trend and Variable-Sized Control Button are 
not supported by V2.1X. 

Any element is positioned on the top or bottom 
row, or the right hand column. 

PanelMate Power Series units have an 
additional row at the top and bottom of the 
display, and an additional column at the left 
side. 

Any element is not an even character height. The pixel height of all V2.1X elements must be 
a multiple of 16 (16, 32, 48, etc.). 

Any element is not an even character width. The pixel width of all V2.1X elements must be 
a multiple of 8 (8, 16, 24, etc.). 

 
 

Tip: To make sure that all objects are on a character boundary prior to export, go to each 
page and select all objects using the Edit - Select All pull-down menu, then turn on the 
character cell grid with the Edit - Snap To Grid pull-down menu.  
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Error Message Reason for Error 

If the page number or message number in a 
PanelMate Power Series configuration exceeds 
the maximum page number or maximum 
message number allowed in the V2.1X 
configuration software, the page or message 
will not be exported. 

For example, if a PanelMate Power Series 
configuration has pages numbered 90 through 
95 and you export the configuration to a 
PanelMate Series 2000 un-expanded unit which 
can contain 10 pages (numbered 0-9), no pages 
will be exported because all page numbers are 
greater than 9. 

The PanelMate Series 2000 and PanelMate 
Series 3000 can have a maximum limit of 10 
pages (numbered 0-9) and 100 messages 
(numbered 1-100). 

The PanelMate Series 2000 Expanded and the 
PanelMate Series 3000 Expanded can have a 
maximum limit of 30 pages (numbered 0-29) 
and 500 messages (numbered 1-500). 

The PanelMate Series 4000 can have a 
maximum limit of 10 pages (numbered 0-9) and 
250 messages (numbered 1-250). 

The PanelMate Series 4000 Expanded can have 
a maximum limit of 30 pages (numbered 0-29) 
and 500 messages (numbered 1-500). 

More than 10 PLCs are configured. V2.1X supports up to 10 PLCs. 

A PLC configured on port 1, port 2, or I/O is 
not supported by V2.1X. 

PanelMate Power Series supports a number of 
PLCs which V2.1X does not. 

A device driver associated with the default 
device name (in the PLC Name And Port Table) 
is not supported by V2.1X. 

In the PLC Name And Port Table, if no device 
name is given to a PLC, the PLC assumes the 
default device name. 

If the driver associated with the default name is 
not supported by V2.1X, the default device 
name will not be exported. 

A Symbol name is too long. V2.1X Symbol names can be no longer than six 
characters. 
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Configuration Editor Reports 
When you select a configuration filename in the Database Treeview Window and choose the Print 
selection from the File Menu or click on the Print button from the toolbar, the Configuration Editor 
Reports dialog box will appear. 

  
The fields in the Configuration Editor Reports dialog box are described below. 

Report Type: Allows you to select the type of report you wish to print.  There are three types of 
reports that can be printed, as listed below. 

Configuration Details: Allows you to print reports on various details of the 
total configuration, as selected using the Report Options button. 

<Report Options ...>: Opens the Configuration Editor Report Options 
dialog box. This selection allows you to select the report options. 

PLC Cross Reference: Allows you to print a detailed cross reference of the 
tags used in the Configuration. See Chapter 12: Using Tags for more 
information. 

Symbol Library: Allows you to print a list of the symbols available in the 
symbol library. 

Pages: Allows you to select the pages you wish to print, or click the <Select All Pages> button. 

<Select All Pages>: Allows you to select all pages listed in the Pages box for printing. 

<Print Reports>: Allows you to print the Configuration Report you have configured. 

<Printer Setup>: Allows you to view the standard Microsoft Windows Print Setup dialog box. The 
options you see may vary depending upon the type of printer installed in your system. 

<Exit>: Closes the dialog box without printing. 

<Help>: Calls for online help. 
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Configuration Editor Reports Options 
Note that the Print function does not support printing the System Online Labels and Fonts. 

When you press the Report Options button on the Configuration Editor Reports dialog box, the 
Configuration Editor Report Options dialog box will appear. 

 
The Configuration Editor Report Options dialog box allows you to select which options will appear 
on your printed report. 

The fields in the Configuration Editor Reports Options dialog box are described below. 

Configuration Header: Prints information contained in the Configuration Properties dialog box. 

System Parameters: Prints information from the System Parameters dialog boxes for the selected 
configuration. 

PLC Name and Port Table: Prints information from the PLC Name and Port Table dialog boxes 
for the selected configuration. 

Directory of Configuration Pages: Prints a list of all pages and page properties. 

Message Library: Prints the contents of the Message Library. 

Template Data: Prints all template property information (in text format) for all templates (both fixed 
and variable-sized) found on the selected pages. 

Graphic Data: Prints all object property information (in text format) for all static graphics found on 
the selected pages. 

Note that the Print function does not support graphic printing of PanelMate pages. In order to print 
pixel image copies of PanelMate pages, use the built-in Windows clipboard feature to copy a bitmap 
image of the page to the clipboard (Print Screen key or Alt and Print Screen keys). Then use a 
standard bitmap editor, such as Windows Paintbrush, to edit and/or print an image of the page to a 
printer. Refer to the Printing a Configuration Page topic for more information 

Check the desired report options then click the OK button to return to the Configuration Editor 
Reports dialog box. 
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Printing a Configuration Page 
For information on printing a configuration page from the PanelMate software, refer to the steps 
below. 

1. Open the configuration page you wish to print and maximize the page. 

2. Create a rectangle the size of the entire page. The rectangle should have a white fill and white 
pen. Move the rectangle to the back. (This step is optional and is intended to provide a white 
background for templates and graphics if your printer does not print solid black well.) 

3. Hold the Alt key and press the Print Screen button on your keyboard to place an image of the 
configuration software screen in the Windows clipboard. (Note that any graphics software 
package can be used to edit and print the image by choosing the Paste selection within the 
graphics software package. The following steps use the Paintbrush software as an example.) 

4. Minimize the PanelMate software to an icon. 

5. Open the Paintbrush software and maximize the screen. 

6. Under the View Menu in Paintbrush, deselect the Tools and Linesize and Palette selections. 
(This step allows the entire configuration page to be displayed.) 

7. Under the Edit Menu, choose the Paste selection and the configuration page image will be 
pasted from the Windows clipboard. 

8. You may edit the configuration page image or print the page as it appears. 

For information on editing the configuration page image in the Paintbrush software, refer to the steps 
below. 

9. Select the Cutout tool and outline the desired part of the page you wish to print. 

10. Under the Edit Menu, choose the Cut selection to cut the desired part of the page. 

11. Under the File Menu, choose the New selection to start a new session. 

12. Under the Edit Menu, choose the Paste selection to paste the contents of the clipboard on the 
new screen. 

13. Print the page. 
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Edit Menu 
The Edit Menu is shown below. 

  
Objects can be edited using keys on the keyboard. For information on editing objects using the 
keyboard, refer to the Editing Graphics topic 

The selections in the Edit Menu are described below. Note that some of the selections are available 
from the toolbar. Refer to the toolbar topic for more information. 

Undo: Reverses the last operation you performed. For example, if you cut an object, Undo makes it 
re-appear. There are several levels of Undo (the exact number depends upon your memory resources). 

Redo: Reverses the effect of the last Undo command. There are several levels of Redo (the exact 
number depends upon your memory resources). 

Cut: Erases a selected object(s) from the screen and places the object(s) on the Windows clipboard. 

Copy: Copies a selected object(s) to the Windows clipboard, but does not erase the object(s) from 
the screen. 

Paste: Copies object(s) from the Windows clipboard into the current configuration page. 

It is not recommended to copy and paste bitmaps to and from the clipboard. To insert a bitmap, use the 
bitmap tool on the tool palette. 

Tip: Graphics can be pasted from other software packages onto a configuration page. Refer 
to the Using Graphics from Other Software topic for more information. 

Tip: Complex objects pasted into a configuration should be re-sized using the software 
package in which the drawing was created. Copying objects to the clipboard from other 
software packages tends to multiply the number of objects. Attempting to resize these 
objects in the Configuration Editor may cause a General Protection Fault. 
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Delete: Erases selected object(s) from the screen and does not place the object(s) in the Windows 
clipboard. 

Note that the Configuration Software cursor may remain as an “hourglass” when deleting objects even 
after the deletion is complete. When the mouse is moved, the original cursor will return if the deletion 
is complete. 

Select All: Selects all objects in the current configuration page. 

Select Next: Selects the next object - in the order in which objects were created. 

Select Previous: Selects the previous object - in the order in which objects were created. 

Note that the keyboard keys used to select, resize, move, select next, or select previous objects will not 
function on a configuration page when another window has been selected. For example, if an object is 
selected and the cursor is placed inside of the color selection palette and the Arrow keys are used to 
select different colors on the palette, the Arrow keys cannot be used to move the selected object unless 
the configuration page and the object are re-selected. This also applies when an object is selected and 
the cursor is placed inside of the Select Font box or the Pen Width box on the toolbar. 

Snap To Grid: If this item is checked, objects are automatically aligned with an invisible on-screen 
grid when existing objects are moved or new objects are placed on the page. The grid is set up on 8x16 
pixel boundaries for character-based alignment. The Snap To Grid is intended to facilitate 
development of V2.1X configurations. 

Note that resize does not function on a group if the snap-to-grid feature is enabled. 
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Object Menu 
The Object Menu is shown below. 

  
Objects can be edited using keys on the keyboard. For information on editing objects using the 
keyboard, refer to the Editing Graphics topic. 

The selections in the Object Menu are described below. Note that some of the selections are available 
from the toolbar. Refer to the toolbar topic for more information. 

Properties...: Opens the Object Properties dialog box for the selected object. Use this selection to 
edit specific object information. You can also use the F2 key as a shortcut key. 

Group: Joins selected objects together into a group object. The group object is contained within a 
single bounding rectangle and can be moved, resized, etc. Note that you can group objects (lines, 
rectangles, etc.), but you cannot group templates. 

Tip: When configurations containing groups are imported, the objects within those groups 
will appear as individual objects and not part of a group. Since groups have no function 
in the online configuration, the exported file does not maintain group attributes. 

Ungroup: Separates a group object into its individual component objects. 

Bring To Front: Brings the selected object(s) to the front (top) of a stack of objects. If more than one 
object is selected, the objects maintain their relative position in the stack. 

Send To Back: Sends the selected object(s) to the back (bottom) of a stack of objects. If more than 
one object is selected, the objects maintain their relative position in the stack. 
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Align: Opens a pop-up menu that allows you to select the type of alignment you prefer. All selected 
objects will be aligned with the last object selected. Note that you can align objects (lines, rectangles, 
etc.), but you cannot align templates. 

Lefts: Aligns the objects along their left edges. 

Centers: Aligns the objects along their vertical centerlines. 

Rights: Aligns the objects along their right edges. 

Tops: Aligns the objects along their top edges. 

Middles: Aligns the objects along their horizontal centerlines. 

Bottoms: Aligns the objects along their bottom edges. 

Distribute: Distributes or evenly spaces three or more selected objects vertically and horizontally. 
Note that you can distribute objects (lines, rectangles, etc.), but you cannot distribute templates. 

Vertically: Distributes the objects along their vertical centerlines. 

Horizontally: Distributes the objects along their horizontal centerlines. 

Make Equal Size: Makes two or more selected objects equal in size to the last object selected. Note 
that you can make objects (lines, rectangles, etc.) equal size but you cannot make templates equal size. 

Width: Makes the objects equal in width. 

Height: Makes the objects equal in height. 

Both: Makes the objects equal in both width and height. 

Reshape: Displays vertical box handles on the selected polygon or arc. Drag the handles to re-shape 
the object. 

Make Symbol: Opens the Make Symbol dialog box. This selection will make a symbol from a group 
of selected objects (lines, rectangles, etc.). 

Break Symbol: Breaks a symbol into the original component objects. 
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Object Properties 
When you choose the Properties selection under the Object Menu or double click on any object on a 
page, the Object Properties dialog box for that object will appear. 

Object Properties is a set of three tabbed dialog boxes used to select the object’s attributes, location, 
size, and visibility. The dialog boxes are listed below. 

• Object Properties - Attributes Tab 

• Object Properties - Location And Size Tab 

• Object Properties - Visibility Tab 

Tip: The Object Properties - Visibility Tab dialog box only appears when you double click on a 
Text object. 

Note that it is not possible to resize a fixed template with the size handles. To resize a fixed template, 
you must use the Object Properties dialog box. 
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Object Properties - Attributes Tab 
The Object Properties - Attributes Tab dialog box is shown below. 

  
The Object Properties - Attributes Tab dialog box allows you to change the color and pen width of 
a selected object. 

The fields in the Object Properties - Attributes Tab dialog box are described below. 

Colors 
Pen: Allows you to select the foreground color or intensity for the object. The Pen button will display 
the standard Color Selection Palette. 

Fill: Allows you to select the background color or intensity for the object. The Fill button will display 
the standard Color Selection Palette. 

Pen Width: Allows you to enter a pen width for the selected object. 
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Object Properties – Location and Size Tab 
The Object Properties - Location and Size Tab dialog box is shown below. 

 
The Object Properties - Location and Size Tab dialog box allows you to change the pixel location 
and size of a selected object. 

The fields in the Object Properties - Location and Size Tab dialog box are described below. 

Location in Pixels 
X: Allows you to move the object to the left or right on the configuration page. The value entered in 
the X field determines the distance in pixels from the left edge of the page. 

Y: Allows you to move the object up and down on the configuration page. The value entered in the Y 
field determines the distance in pixels from the top of the page. 

Size In Pixels 

Height: Allows you to enter the height in pixels of the selected object. Note that you can re-size and 
re-shape an object by dragging one of the selection handles with the selection tool. 

Width: Allows you to enter the width in pixels of the selected object. Note that you can re-size and re-
shape an object by dragging one of the selection handles with the selection tool. 

Tip: Objects can be resized using keys on the keyboard. For information on editing objects 
using the keyboard, refer to the Editing Graphics topic. 
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Object Properties - Visibility Tab 
Tip: The Object Properties - Visibility Tab dialog box only appears when you double click on a 

Text object. 
Note that a Text object that has the Refresh Affected Graphics Online field or the Enable Conditional 
Visibility field checked cannot be made into a symbol. 

The Object Properties - Visibility Tab dialog box is shown below. 

 
The Object Properties - Visibility Tab dialog box allows you to configure the refresh graphics and 
visibility features. 

The fields in the Object Properties - Visibility Tab dialog box are described below. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the Text object to be refreshed to properly reflect the layering of 
objects on the page whenever the symbol is updated. 

Enable Conditional Visibility: Allows you to determine if the Text object will appear on a page 
based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not 
checked, the Text object will always appear on the page. 

It is important to note that an text object that is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the text object is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the Text object 
will be erased and all template updating will be deactivated when in Run Mode. If the Visibility 
Expression evaluates to true (not equal to zero), the Text object will appear and all template updating 
will be activated when in Run Mode. 
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Make Symbol 
A symbol is a collection of graphic objects grouped together and given a name. The allowable objects 
for a symbol are lines, rectangles, ellipses, arcs, polygons, text, and bitmaps. If there are any fixed 
templates, variable-sized templates, variable-sized control buttons, or symbols in the collection of 
objects you wish to make into a symbol, the Make Symbol selection in the Object Menu will be 
disabled. Also note that if you have a Text object selected and the Refresh Affected Graphics Online 
field or the Enable Conditional Visibility field is checked in the Object Properties - Visibility Tab 
dialog box, the Make Symbol selection will be disabled. 

When a group of allowable objects are selected on a configuration page and you choose the Make 
Symbol selection from the Object Menu, the Make Symbol dialog box will appear. 

 
The Make Symbol dialog box allows you to create symbols. 
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The fields in the Make Symbol dialog box are described below. 

Symbol Name: Allows you to enter the name of the symbol you wish to create. Note that when a 
symbol has been created, the symbol name will appear in the Database Treeview Window under the 
Symbol Library selection. For more information on the Symbol Library, refer to the Symbol Library 
topic. 

Symbol Origin Offset: Displays the symbol’s origin offset (in pixels). The default Symbol Origin 
Offset for X and Y is 0 and 0 (no offset). 

X: Displays the X origin offset in pixels. 

Y: Displays the Y origin offset in pixels. 

Preview: Displays the selected symbol in the Preview box if the Show Preview box is selected. 

Show Preview: Allows the selected symbol to be shown in the Preview box. 

Once a symbol has been created, you may double click on the symbol to view the Symbol Properties 
dialog box. Refer to the Symbol Properties topic for more information. 

Note the following items: 

• The objects that make up a symbol cannot be edited. If you wish to change an object within a 
symbol, you must select the symbol on the configuration page and choose the Break Symbol 
selection under the Object Menu to break the symbol into the original separate objects. The 
objects may be edited and then you may choose the Make Symbol selection from the Object 
Menu again. 

• If you create a symbol that contains a circle, the circle may be displayed slightly out of 
position (1 pixel in X or Y dimension) in Run Mode compared to what is displayed in the 
Configuration Software. 
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View Menu 
The View Menu is shown below. 

 
The selections in the View Menu are described below. 

Toolbar: Shows or hides the toolbar at the top of the screen. When the toolbar is visible, a check mark 
appears beside this menu item. 

Status Bar: Shows or hides the status bar at the bottom of the screen. When the status bar is visible, a 
check mark appears beside this menu item. 

Tool Palette: Shows or hides the tool palette. When the tool palette is visible, a check mark appears 
beside this menu item. 
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Window Menu 
The Window Menu is shown below. 

 
The selections in the Window Menu are described below. 

Cascade: Arranges all open windows so they overlap. The title bar of all windows remains visible so 
you can easily select a window. 

Tile: Arranges all open windows side-by-side so there is no overlap. 

Arrange Icons: Arranges all icons in orderly rows. To reduce a configuration window to an icon, 

click its   button. 

1 Configurations: Lists all open windows, including those that have been reduced to icons. To make a 
window active, select its name from the list. 

Note that when a Configuration Page Window is opened, the Window Menu will not display the 
Configuration Page Window as an open window. 
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Help Menu 
The Help Menu is shown below. 

 
The selections in the Help Menu are described below. 

Contents: Goes to the first topic of the Configuration Editor help file. 

Using Help: Provides general information about using help. This is the standard Windows help file. 

About PM Config: Displays the About PanelMate Configuration Editor dialog box and lists 
system information. 
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About PanelMate Configuration Editor 
When you choose the About PM Config selection in the Help Menu, the About PanelMate 
Configuration Editor dialog box will appear. 

  
The information in the About PanelMate Configuration Editor dialog box is listed below: 

• Name of the Configuration Editor, version number, and copyright information. 

• Amount of free memory 

• Presence of math co-processor 

• Amount of free disk space 
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Toolbar 
When the Toolbar selection is checked under the View Menu, the Toolbar will appear on the Main 
Screen. 

  
You can use the Toolbar buttons to perform many of Configuration Editor’s standard operations. The 
Toolbar buttons are described below. 

 Save: Saves the current configuration to disk. 

 Print: Prints a hard copy of the current configuration. 

 Cut: Removes the selected object from the configuration, and places it on the Windows 
clipboard. 

 Copy: Places a copy of the selected object on the Windows clipboard, but does not remove it 
from the configuration. 

 Paste: Pastes the contents of the Windows clipboard into the current configuration. 

 Undo: Un-does the previous operation. 

 Redo: Re-does the operation previously un-done. 

 Bring To Front: Brings a selected object to the front (top) of a stack of objects. 

 Send To Rear: Sends a selected object to the rear (bottom) of a stack of objects. 

 Align Left: Aligns all selected objects along the left edge of the last object selected. 

 Align Center: Aligns all selected objects along the vertical centerline of the last object selected. 

 Align Right: Aligns all selected objects along the right edge of the last object selected. 

 Select Font: Select a font for the selected text object. 

 Fill Colors: This button consists of two parts. Click the paint can icon to fill the selected 
object with the color shown in the box. Click the arrow icon to display the Color Selection Palette. 

 Pen Colors: This button consists of two parts. Click the pencil icon to set the pen color of the 
selected object to the color shown in the box. Click the arrow icon to display the Color Selection 
Palette. 

 Pen Width: Choose a pen width for the selected object. Note that the Pen Width value in the 
Toolbar is not fully visible when using a large font video driver. 

 Help: Makes context-sensitive help available. When you click this button, the cursor displays a 
question mark. Then, click most on-screen features for context-sensitive help. 
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Color Selection Palette 
When you click the down arrow buttons on the Pen Color button or Fill Color button in the toolbar, 
the Color Selection Palette will appear. 

  
The Color Selection palette allows you to select pen color (or shade) and fill color (or shade). You can 
choose: 

• Colors (on color units only) 

• Blinking colors (on color systems only) 

• Shades of gray 

• Blinking shades of gray  

Note the following Color Palette items: 

• You can move the Color Selection Palette by clicking the left mouse button and dragging the 
palette to the desired position on the screen. The Color Selection Palette will then have a 
small title and icon that will indicate whether it is the Pen Color or Fill Color palette. 

• If the 256 Greyscale/Color option is installed on the PanelMate Power Series 1500, additional 
colors or shades of gray will be available. 

• In order for the color palette to accurately represent the color and blink characteristics of the 
PanelMate online unit, the video driver selected from the Windows Control Panel must be a 
256 color driver. If the video driver is not a 256 color driver (either 16 color or more than 256 
color), the color palette shown in the Configuration Editor will not match that of the online 
unit. 

• The black color displayed in row 1, column 1 and row 3, column 1 are colors selected to be 
compatible with PanelMate versions prior to the PanelMate Power Series. If these colors are 
selected, then the number of characters displayed in a 1-cell template will be reduced from 12 
to 10. 
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Status Bar 
When the Status Bar selection is checked under the View Menu, the Status Bar will appear on the 
Main Screen. 

  
The Configuration Editor uses the Status Bar at the bottom of the window to display messages and 
information about the current status of the application. 
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Tool Palette 
When the Tool Palette is selected in the View Menu, the Tool Palette will display when you open a 
page. 

  
The Tool Palette buttons are listed below. 

 Selection  Reshape  Line 

 Rectangle  Ellipse  Arc 

 Polygon  Text  Symbol 

 Bitmap  Indicator Template  Readout Template 

 Bar Template  Table Template  Bar Trend Template 

 Line Trend Template  Display Template  VS Indicator Template 

 VS Bar Template  VS Readout Template  VS Display Template 

 VS Graphic Template  VS Control Button  
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Selection Tool 
The Selection tool allows you to select objects on the current page. A selected object is enclosed in a 
bounding box having handles (small squares) at the corners of the bounding box, and at the center of 
every side. Use the Selection tool to drag the handles to re-size or re-shape the object. 

To select more than one object, press the Shift key while you click the desired objects. You can also 
use the Selection tool to draw a dotted selection box (marquee) around multiple objects to select them. 

Reshape Tool 
The Reshape tool allows you to re-shape selected arcs and polygons. 

To reshape an arc or polygon ... 

14. Select the Reshape tool. 

15. Click the object you wish to reshape. An arc displays two handles (squares) and a polygon 
displays a handle at the ends, and at each vertex (corner). 

16. Place the cursor over a handle and it changes to a cross. 

17. Drag the handle to reshape the object. 

Tip: If the reshape tool is used on an arc and the cursor is inside the arc, the arc is converted 
to a pie shape or a chord. 

To add a node (vertex) to a polygon ... 

18. Press the Ctrl key. 

19. Place the cursor on the line where you wish to add a node. A plus sign (+) appears. 

20. Click and drag the cursor away, then release the Ctrl key. 

To delete a node on a polygon ... 

1. Place the cursor on the node you wish to delete. A plus sign (+) appears. 
2. Press the Ctrl key and click once to delete the node. 

Line Tool 
The Line tool allows you to place a line object on the page. Place the cursor on the configuration page, 
press the mouse button, and drag to create a line. While using this tool, press the Shift key to constrain 
the line to a 45° angle. 

Rectangle Tool 
The Rectangle tool allows you to place a rectangle object on the page. Place the cursor on the 
configuration page, press the mouse button, and drag to create a rectangle. While using this tool, press 
the Shift key to constrain the rectangle to a square. 
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Ellipse Tool 
The Ellipse tool allows you to place an ellipse object on the page. Place the cursor on the configuration 
page, press the mouse button, and drag to create an ellipse. While using this tool, press the Shift key to 
constrain the ellipse to a circle. 

Arc Tool 
The Arc tool allows you to draw an arc, chord, or pie-shaped object on the page. Place the cursor on 
the configuration page, press the mouse button, and drag to create an arc. While using this tool, press 
the Shift key to constrain the arc to a circular shape. 

To draw a chord or pie shape ... 

1. Draw an arc. 

2. Reshape it using the Reshape tool. For information on the Reshape tool, refer to the Reshape 
Tool topic. 

The maximum arc size that can be displayed in Run Mode is 358°. To check the arc size, double-click 
on the arc to open the Object Properties dialog box. 

Polygon Tool 
The Polygon tool allows you to place a polyline (a jagged line) or a closed polygon (multi-sided 
figure) on the configuration page. 

To create a polyline ... 

1. Select the polygon tool. 
2. Click to place the first point, then release the mouse button. As you move the mouse, a rubber 

band line follows the cursor. 
3. Click to place the next point. 
4. Continue until the polyline is complete. 

To create a polygon ... 

1. Perform steps 1-3 (under Creating A Polyline) to draw the polygon shape. 
2. Place the last point very near the first one. It is not necessary to place it exactly on top. The 

polygon is automatically completed. 
Note that you may use the Reshape tool to reshape a polyline or a polygon. For more information on 
the Reshape tool, refer to the Reshape Tool topic. 

Text Tool 
The Text tool allows you to place a text object on the page. 
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Symbol Tool 
The Symbol tool allows you to place a symbol object on the page. When the Symbol tool is selected 
from the tool palette and you click on the configuration page, the Select Symbol dialog box will 
appear. For more information on the Select Symbol dialog box, refer to the Select Symbol topic. 

Note that graphics can be pasted from other software packages onto a configuration page and made 
into a symbol. Refer to the Using Graphics from Other Software topic for more information. 

Select Symbol 
When you select the Symbol tool or the Variable-Sized Graphic Template tool from the tool palette 
and click on a configuration page, the Select Symbol dialog box will appear. 

  
The Select Symbol dialog box is used to select an existing symbol to place on a configuration page. 

The fields in the Select Symbol dialog box are described below. 

Symbol Name: Displays the lists of symbol names. Note that you may scroll through the symbol name 
list and preview each symbol if the Show Preview box is selected. 

Symbol Origin Offset: Displays the symbol’s origin offset (in pixels). 

X: Displays the X origin offset in pixels. 

Y: Displays the Y origin offset in pixels. 

Preview: Displays the selected symbol in the Preview box if the Show Preview box is selected. 

Show Preview: Allows the selected symbol to be shown in the Preview box. 
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Bitmap Tool 
The Bitmap tool allows you to place a bitmap object (picture) on the page. When this tool is selected 
and you click a configuration page, a standard Open Bitmap File dialog box will appear. 

Bitmaps are used for backgrounds or other objects it is not easy or convenient to draw. Bitmaps reside 
in disk files having a .BMP extension. 

Graphics can be pasted from other software packages onto a configuration page. Refer to the Using 
Graphics from Other Software topic for more information. 

Tip: Bitmaps use a lot of memory. The larger the bitmap, the more memory is consumed. 

Open Bitmap File 
When you select the Bitmap tool from the tool palette and click on a configuration page, the Open 
Bitmap File dialog box will appear. 

 
The Open Bitmap File dialog box will allow you to select the bitmap you wish to use. 
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Indicator Template Tool 
The Indicator Template tool allows you to place an Indicator Template on the page. Indicator 
Templates are the lights and buttons of a control panel. They indicate and control the status of devices 
by turning them on or off. Refer to the Indicator Template topic for more information. 

Readout Template Tool 
The Readout Template tool allows you to place a Readout Template on the page. Readout Templates 
are designed to replace numeric and digital readout devices found on a conventional control panel, and 
to supply the functionality often provided by CRT-based devices. Refer to the Readout Template 
topic for more information. 

Bar Template Tool 
The Bar Template tool allows you to place a Bar Template on the page. Bar Templates are the analog 
meters and face plates of a control panel. They indicate a value in analog fashion using a bar graph 
that shows these values in graphical form: 

• Current value 

• Steeping 

• High and low alarm levels  
Refer to the Bar Template topic for more information. 

Bar Trend Template Tool 
The Bar Trend tool allows you to place a Bar Trend Template on the page. Bar Trend Templates 
collect, store, and display data to provide a historical perspective on how: 

• A single data point has changed 

• A data point may behave in the future 
Refer to the Bar Trend Template topic for more information. 

Table Template Tool 
The Table Template tool allows you to place a Table Template on the page. Table Templates display a 
table of values and accept numeric entry for all the items in the table. Refer to the Table Template 
topic for more information. 

Line Trend Template Tool 
The Advanced Trending Template box must be selected in the New Configuration dialog box or in 
the Configuration Properties dialog box before a Line Trend Template can be created 
The Line Trend Template tool allows you to place a Line Trend Template on the page. Line Trend 
Templates collect, store, and display data to provide a historical perspective on how: 

• A single data point has changed 

• A data point may behave in the future 
Refer to the Line Trend Template topic for more information. 
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Display Template Tool 
The Display Template tool allows you to place a Display Template on the page. Display Templates are 
used like standard LED or LCD message units or displays. Refer to the Display Template topic for 
more information. 

Variable-Sized Indicator Template Tool 
The Variable-Sized Indicator Template tool allows you to place a Variable-Sized Indicator Template 
on the page. Variable-Sized Indicator Templates let you use small indicators to create high-density 
status displays on your page. Refer to the Variable-Sized Indicator Template topic for more 
information. 

Variable-Sized Bar Template Tool 
The Variable-Sized Bar Template tool allows to place a Variable-Sized Bar Template on the page. 
Variable-Sized Bar Templates are the analog meters and face plates of a control panel. They indicate a 
value in analog fashion using a bar graph that shows these values in graphical form: 

• Current value 

• Setpoint 

• High and low alarm levels 
Refer to the Variable-Sized Bar Template topic for more information. 

Variable-Sized Readout Template Tool 
The Variable-Sized Readout Template tool allows you to place a Variable-Sized Readout Template on 
the page. Variable-Sized Readout Templates are designed to replace numeric and digital readout 
devices found on a conventional control panel, and to supply the functionality often provided by CRT-
based devices. Refer to the Variable-Sized Readout Template topic for more information. 

Variable-Sized Display Template Tool 
The Variable-Sized Display Template tool allows you to place a Variable-Sized Display Template on 
the page. Variable-Sized Display Templates are designed to replace LED or LCD message units or 
display readouts. Refer to the Variable-Sized Display Template topic for more information. 

Variable-Sized Graphic Template Tool 
The Variable-Sized Graphic tool allows you to place a Variable-Sized Graphic Template on the page. 
Variable-Sized Graphic Templates consists of one or more symbols and are used to indicate the status 
of a device and to control the device (e.g., by turning it ON or OFF). Refer to the Variable-Sized 
Graphic Template topic for more information. 

Variable-Sized Control Button Tool 
The Variable-Sized Control Button tool allows you to place a Variable-Sized Control Button Template 
on the page. Variable Sized Control Button Templates are used to provide momentary control to the 
PLC or to issue a local page change command. Refer to the Variable-Sized Control Button 
Template topic for more information. 
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Database Treeview Window 

3 

In this chapter, you will learn: 

• About the Database Treeview Window 

• How to open a New Configuration 

• How to open a New Configuration Page 

• How to set the Configuration Properties 

• How to set the Page Properties 
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Database Treeview Window 
The Database Treeview Window appears on the Main Screen. 

 
The Database Treeview Window allows you to create and edit configuration pages and is the main 
interface used to access the Configuration Software. This window displays the database in a tree-like 
structure similar to the Microsoft Windows File Manager.  

To expand and contract the database tree, you may double-click on the icons or click once on the + or - 
symbol next to the icons. Note that if an icon does not have a + or - symbol, there are no additional 
levels.  

The buttons on the Database Treeview Window are described below. 

New: Opens the New Configuration dialog box or the New Configuration Page dialog box 
depending on which icon is selected. 

If you have the Configurations icon, a PanelMate model icon, or a configuration name icon selected 
and click the New button, the New Configuration dialog box will appear. 

If you have the Configurations Pages icon selected and click the New button, the New Configuration 
Page dialog box will appear.  

Open: Opens or expands the currently selected icon in the database tree. For example, if you select a 
configuration page name and click the Open button, the configuration page will open. If you select the 
Symbol Library icon and click the Open button, the symbol names (if configured) will appear. (You 
must select the symbol name and click the Open button to view the Symbol Library dialog box.) 

Delete: Allows you to delete a selected configuration or a selected configuration page. 

Properties: Opens the Configuration Properties dialog box or the Page Properties dialog box 
depending on which icon is selected. 

If you have a configuration name selected and press the Properties button, the Configuration 
Properties dialog box will appear. 

If a configuration page is selected and press the Properties button, the Page Properties dialog box 
will appear. 
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New Configuration 
When the Configurations icon, a PanelMate model icon, or a configuration name icon is selected and 
the New button is clicked in the Database Treeview Window, the New Configuration dialog box 
appear. 

  
The New Configuration dialog box allows you to create a new configuration. 

The fields in the New Configuration dialog box are described below. 

Product Type: Allows you to select the product for which the configuration is being created. 

Preview: Displays a generalized view of the selected product type. 

Configuration 
Name: Allows you to enter the name of the configuration. 

Description: Allows you to enter a brief description of the configuration. 
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Product Features 

The following Product Features can also be selected in the Configuration Properties dialog box. 

Color Display: Allows you to select a color configuration. If this box is not checked, the 
configuration will be grayscale.  

High Capacity Unit: Allows you to create a larger number of pages and messages than permitted 
in the Standard Capacity environment. Refer to the table below for feature limits. 

 
 
Product Type 

Maximum 
Number of 
Pages 

Maximum 
Number of 
Messages 

PanelMate Power Series 1500 50 2500 

All other PanelMate Power Series models 100 5000 

PanelMate PC 200 10000 

Note that the complexity of the configuration may reduce the number of pages and messages in 
the PanelMate unit. 

Advanced Trending Template: Allows you to configure Advanced Trending Templates which 
display a history of a reference’s value over a period of time. Advanced trending features 6 pens 
that can be triggered by time or event. 

For information on configuring an Advanced Trending Template, refer to the Line Trend 
Template topic. 

Allen-Bradley DH-485: Allows you to communicate to the Allen-Bradley Data Highway. 

Modicon Modbus: Allows you to communicate to Modicon PLCs via the Modicon Modbus or 
Modicon Modbus Plus. 

Dynamic Graphics: Allows symbols to change colors and shapes dynamically on PanelMate 
Power Series 1500 models. 

256 Greyscale/Color (Model 1555/1575): Enhances the PanelMate Power Series 1500. 

If you have a PanelMate Power Series 1500 (Model 1555) and you select the 256 Greyscale/Color 
feature, you will have 16 shades of gray (instead of the standard 8 shades), PowerAnimation, and 
PowerBlink. 

If you have a PanelMate Power Series 1500 (Model 1575) and you select the 256 Greyscale/Color 
feature, you will have a 256 color palette (instead of the standard 16 colors), PowerAnimation, 
and PowerBlink. 

PowerAnimation allows you to create animation by defining a  series of graphic objects which 
blink in sequence and PowerBlink allows you to create graphic objects which blink at different 
rates. 

Auto Centering 

Device Names: Allows you to automatically center all Device Names within templates which 
have Device Names on all pages of this configuration. 

Indicator Labels: Allows you to automatically center all Indicator Labels within the Indicator 
Template label area on all pages of this configuration. 

Control Button Labels: Allows you to automatically center all Control Button Labels for all 
templates which have control buttons defined on all pages of this configuration. 
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New Configuration Page 
When the Configurations Pages icon is selected and the New button is clicked in the Database 
Treeview Window, the New Configuration Page dialog box will appear. 

 
The New Configuration Page dialog box is used to determine features for individual configuration 
pages and to determine features for the Maintenance Template. For more information about the 
Maintenance Template, refer to the Maintenance Template topic. For more information about the 
Maintenance Template topic, refer to the Maintenance Template topic in the Online Operation 
User’s Guide. 

The fields in the New Configuration Page dialog box are described below. 

Page 
Number: Allows you to enter the page number for the new configuration page. 

Title: Allows you to enter a title for the new configuration page. 
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Protection: Allows you to control access to a page by selecting a type of protection for the new 
configuration page. The selections are listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
Tip: If a page is password protected, but is selected as the startup page in the Startup Page field in 
the System Parameters - General Tab dialog box, password protection will be ignored on initial 
bootup. 

The page will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option which may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 

Maintenance Templates 
Maintenance Templates are designed to replace TCAM (timer/counter access module) and RAP (register 
access panel) devices that are typically used during the setup and troubleshooting of PLCs. 

Allow On Page: Allows you to determine if the Maintenance Template will display on the current 
page. 

Enable Writes: Allows you to determine if the operator can change the data or just monitor it. If this 
box is checked, the data is read/write, otherwise the data is read-only. 

CAUTION: Make your selection based on the expertise of operators and maintenance 
personnel. 
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Protection: Allows you to select a type of protection for displaying Maintenance Templates on the 
current page. The selections are listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
The Maintenance Template will not be displayed unless the operator provides the correct password or 
unlocks the security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option which may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 

For additional information about Maintenance Templates, see the Maintenance Template topic. For 
more information about the Maintenance Template topic, refer to the Maintenance Template topic 
in the Online Operation User’s Guide. 

Flexible Page Layout 

The Flexible Page Layout feature is intended for use on touchscreen units only. 

If a flexible item appears on top of a template or graphic on your configuration page, the underlying 
template or graphic will be deleted when the configuration is exported. 

Page Status Banner: Allows you to determine if the Page Status Banner will appear on the screen of 
your touchscreen unit. Note that if you do not want the Page Status Banner to appear, you must select 
the Flexible Page Layout field in the System Parameters - General Tab dialog box and de-select the 
Page Status Banner box. 

Default Buttons: Allows you to determine if the default buttons will appear on the screen of your 
touchscreen unit. Note that if you do not want the Default Buttons to appear, you must select the 
Flexible Page Layout field in the System Parameters - General Tab dialog box and de-select the 
Default Buttons box. 

Alarm Table: Allows you to determine if alarms will appear on the screen of your touchscreen unit. 
Note that if you do not want alarms to appear, you must select the Flexible Page Layout field in the 
System Parameters - General Tab dialog box and de-select the Alarms Table box. 

Cancel Key: Allows you to determine if the CANCEL key will appear on the screen of your 
touchscreen unit. Note that if you do not want the CANCEL key to appear, you must select the 
Flexible Page Layout field in the System Parameters - General Tab dialog box and de-select the 
Cancel Key box. 
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Configuration Properties 
When a configuration name is selected in the Database Treeview Window and the Properties button is 
clicked, the Configuration Properties dialog box will appear. 

  
The Configuration Properties dialog box displays configuration, product features, and auto-centering 
information. 

The fields in the Configuration Properties dialog box are described below. 

Product Type: Displays the product type. 

Version: Displays the configuration software version number. 

Configuration 
Name: Displays the name assigned when the configuration was created in the New 
Configuration dialog box. You may change this name to save the configuration under a new 
name. 

Last Modified Time: Displays the time of the last modification to the configuration. 

Last Modified Date: Displays the date of the last modification to the configuration. 

Description: Displays the description entered when the configuration was created in the New 
Configuration dialog box. You can edit the description as required. 
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Product Features 
The following Product Features can also be selected in the New Configuration dialog box. 

Color Display: Allows you to select a color configuration. If this box is not checked, the 
configuration will be grayscale.  

High Capacity Unit: Allows you to create a larger number of pages and messages than permitted 
in the Standard Capacity environment. Refer to the table below for feature limits. 

 
 
Product Type 

Maximum 
Number of 
Pages 

Maximum 
Number of 
Messages 

PanelMate Power Series 1500 50 2500 

All other PanelMate Power Series models 100 5000 

PanelMate PC 100 10000 

Note that the complexity of the configuration may reduce the number of pages and messages in 
the PanelMate unit. 

Advanced Trending Template: Allows you to configure Advanced Trending Templates which 
display a history of a reference’s value over a period of time. Advanced trending features 6 pens 
that can be triggered by time or event. 

For information on configuring an Advanced Trending Template, refer to the Line Trend 
Template topic. 

Allen-Bradley DH-485: Allows you to communicate to the Allen-Bradley Data Highway. 

Modicon Modbus: Allows you to communicate to Modicon PLCs via the Modicon Modbus or 
the Modicon Modbus Plus. 

Dynamic Graphics: Allows symbols to change colors and shapes dynamically on PanelMate 
Power Series 1500 models. 

256 Greyscale/Color (Model 1555/1575): Enhances the PanelMate Power Series 1500. 

If you have a PanelMate Power Series 1500 (Model 1555) and you select the 256 Greyscale/Color 
feature, you will have 16 shades of gray (instead of the standard 8 shades), PowerAnimation, and 
PowerBlink. 

If you have a PanelMate Power Series 1500 (Model 1575) and you select the 256 Greyscale/Color 
feature, you will have a 256 color palette (instead of the standard 16 colors), PowerAnimation, 
and PowerBlink. 

PowerAnimation allows you to create animation by defining a  series of graphic objects which 
blink in sequence and PowerBlink allows you to create graphic objects which blink at different 
rates. 

Auto Centering 

Device Names: Allows you to automatically center all Device Names within templates which 
have Device Names on all pages of this configuration. 

Indicator Labels: Allows you to automatically center all Indicator Labels within the Indicator 
Template label area on all pages of this configuration. 

Control Button Labels: Allows you to automatically center all Control Button Labels for all 
templates which have control buttons defined on all pages of this configuration. 

 



 Chapter 3: Database Treeview Window 65 

Page Properties 
When a configuration page is selected in the Database Treeview Window and the Properties button is 
clicked, the Page Properties dialog box will appear. 

 
The Page Properties dialog box is used to determine features for individual configuration pages and 
to determine features for the Maintenance Template. For more information about the Maintenance 
Template, refer to the Maintenance Template topic. For more information about the Maintenance 
Template topic, refer to the Maintenance Template topic in the Online Operation User’s Guide. 

The fields in the Page Properties dialog box are described below. 

Page 
Number: Allows you to enter a page number for the configuration page. 

Title: Allows you to enter a title for the page. 
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Protection: Allows you to control access to individual pages. If the 
operator does not enter the correct password or if operator cannot unlock 
the security keyswitch wired to the PanelMate unit, the page will not be 
displayed. The selections available are listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B Only 

Tip: If a page is password protected, but is selected as the startup page in the Startup 
Page field in the System Parameters - General Tab dialog box, password protection 
will be ignored on initial bootup. 

The page will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option which may be ordered as a spare part from the Cutler-
Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the 
PanelMate Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 

Maintenance Templates 
Maintenance Templates are designed to replace TCAM (timer/counter access module) and RAP 
(register access panel) devices that are typically used during the setup and troubleshooting of PLCs. 

Allow On Page: Determines if the operator can display the pop-up Maintenance Template over 
the current page. 

Enable Writes: Determines if the operator can change the data or just monitor data in the 
Maintenance Template. If the Enable Writes box is selected, the data is read/write. If the Enable 
Writes box is not selected, the data is read-only. 

CAUTION: Make your selection based on the expertise of operators and 
maintenance personnel. 
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Protection: Allows you to select a type of protection for displaying 
Maintenance Templates on the current page. The selections are listed 
below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
The Maintenance Template will not be displayed unless the operator provides the correct 
password or unlocks the security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option which may be ordered as a spare part from the Cutler-
Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the 
PanelMate Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 

For additional information about Maintenance Templates, see the Maintenance Template topic. 
For more information about the Maintenance Template topic, refer to the Maintenance 
Template topic in the Online Operation User’s Guide. 

Flexible Page Layout 

The Flexible Page Layout feature is intended for use on touchscreen units only. 

If a flexible item appears on top of a template or graphic on your configuration page, the underlying 
template or graphic will be deleted when the configuration is exported. 

Page Status Banner: Allows you to determine if the Page Status Banner will appear on the 
screen of your touchscreen unit. Note that if you do not want the Page Status Banner to appear, 
you must select the Flexible Page Layout field in the System Parameters - General Tab dialog 
box and de-select the Page Status Banner box. 

Default Buttons: Allows you to determine if the default buttons will appear on the screen of your 
touchscreen unit. Note that if you do not want the Default Buttons to appear, you must select the 
Flexible Page Layout field in the System Parameters - General Tab dialog box and de-select the 
Default Buttons box. 

Alarm Table: Allows you to determine if alarms will appear on the screen of your touchscreen 
unit. Note that if you do not want alarms to appear, you must select the Flexible Page Layout field 
in the System Parameters - General Tab dialog box and de-select the Alarms Table box. 

Cancel Key: Allows you to determine if the CANCEL key will appear on the screen of your 
touchscreen unit. Note that if you do not want the CANCEL key to appear, you must select the 
Flexible Page Layout field in the System Parameters - General Tab dialog box and de-select the 
Cancel Key box. 
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Font Editor 

4 

In this chapter, you will learn: 

• About the Font Editor 

• About character sets  
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Font Editor 
When you double click on the Normal, Graphic, Double High, or Quad selection under Screen Fonts 
in the Database Treeview Window, the Font Editor dialog box will appear. 

  
The Font Editor dialog box allows you to edit existing characters or create new characters while still 
viewing the page layout. 

The three buttons at the top of the Font Editor dialog box are described below. 

  This button will set all pixels to white in the 8x16 pixel box. 

  This button will set all pixels to black in the 8x16 pixel box. 

  This button will invert all pixels to the opposite color (i.e., black pixels to white pixels and white 
pixels to black pixels) in the 8x16 pixel box.  

The 8x16 pixel box gives you the ability to create custom characters by redefining or creating a new 
character in the 8 x 16 pixel bitmap box for each character. The character set may be selected in the 
Normal Font to Use field and the font may be selected in the Selected Font field. 

The fields in the Font Editor dialog box are described below. 

Normal Font to Use: Allows you to select a character set. The character sets are listed below. 

• English 

• Danish1 

• French1 

• French2 

• German1 

• Spanish1 

• Swedish1 

 



70 Configuration Editor User’s Guide 

Selected Font: Allows you to select the font to edit. The selections available are Normal, Graphics, 
Double High, and Quad. To view the Normal characters, refer to the English Font topic. To view 
Graphic characters, refer to the Graphics Font topic. 

Note that the Double High and Quad fonts are only available if you selected the Redefine Quad Font 
or Redefine Double High Font fields in the System Parameters - General Tab dialog box. 

The table below lists the fonts and the number of characters that can be edited. 

 
Fonts 

Number of 
Standard Font Characters 

Number of 
Extended Font Characters 

Normal 10 

ASCII characters 22-31 138 
ASCII characters 22-31 and 128-255 

Graphic 26 
ASCII characters 101-126 

154 
ASCII characters 101-126 and 128-255 

Double High 126 
ASCII characters 1-126 

254 
ASCII characters 1-126 and 128-255 

Quad 126 
ASCII characters 1-126 

254 
ASCII characters 1-126 and 128-255 

If you have strings using extended font characters and you disable the Enable Extended Fonts field in 
the System Parameters - General Tab dialog box, the strings will be truncated after and including 
the first character from the extended area (characters 128-255) of the font when the configuration is 
exported. 

To access the extended fonts, the Enable Extended Fonts field must be selected in the System 
Parameters - General Tab dialog box. 

Note that when redefining a character or editing a character that already exists in a font, the font will 
be changed on all pages where it is used. 

Selected Character 
ASCII Char: Displays the ASCII character number for the character selected in the character 
selection window.  

Recall Key: Displays the recall key or combination of keys you must enter to get the character to 
display. 

Character Selection Window: Displays characters from the character set you selected in the Selected 
Font field. When a character has been selected, the character will be displayed in the 8x16 pixel box. 
You may use the scroll bar to scroll through the character set. 
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English Font 
To enter the following characters, press the recall key(s). Refer to the examples below. 

Examples: 

To enter the character /, press the recall keys ~Q. 

To enter the character C, press the recall key C. 

To enter the character ®, press the recall keys ALT+0174. 
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Danish1 Font 
To enter the following characters, press the recall key(s). Refer to the examples below. 

Examples: 

To enter the character Æ, press the recall keys ~W. 

To enter the character C, press the recall key C. 

To enter the character ®, press the recall keys ALT+0174. 
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French1 Font 
To enter the following characters, press the recall key(s). Refer to the examples below. 

Examples: 

To enter the character É, press the recall keys ~]. 

To enter the character C, press the recall key C. 

To enter the character ®, press the recall keys ALT+0174. 
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French2 Font 
To enter the following characters, press the recall key(s). Refer to the examples below. 

Examples: 

To enter the character î, press the recall keys ~]. 

To enter the character C, press the recall key C. 

To enter the character ®, press the recall keys ALT+0174. 
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German1 Font 
To enter the following characters, press the recall key(s). Refer to the examples below. 

Examples: 

To enter the character ü, press the recall keys ~[. 

To enter the character C, press the recall key C. 

To enter the character ®, press the recall keys ALT+0174. 
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 Chapter 4: Font Editor 81 

Spanish1 Font 
To enter the following characters, press the recall key(s). Refer to the examples below. 

Examples: 

To enter the character Ñ, press the recall keys ~Y. 

To enter the character C, press the recall key C. 

To enter the character ®, press the recall keys ALT+0174. 
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Swedish1 Font 
To enter the following characters, press the recall key(s). Refer to the examples below. 

Examples: 

To enter the character ö, press the recall keys ~X. 

To enter the character C, press the recall key C. 

To enter the character ®, press the recall keys ALT+0174. 
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Graphic Font 
To enter the following characters, press the recall key(s). Refer to the examples below. 

Examples: 

To enter the character  , press the recall keys ~Q. 

To enter the character  , press the recall key N. 
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Symbol Library 

5 

In this chapter, you will learn: 

• About the Symbol Library 

• About the Symbol Properties 

• About the Symbol Origin 
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Symbol Library  
For information on creating symbols, refer to the Make Symbol topic. 

When symbols have been created in the configuration and you click on a symbol name under the 
Symbol Library selection in the Database Treeview Window, the Symbol Library dialog box will 
appear. 

  
The Symbol Library dialog box allows you to view all symbol names that have been created for your 
configuration. 

The fields in the Symbol Library dialog box are described below. 

Symbol Name: Displays the name of the symbol you selected. Note that you may scroll through the 
symbol name list and preview each symbol if the Show Preview box is selected. 

Symbol Origin Offset: Displays the symbol’s origin offset (in pixels). The default Symbol Origin 
Offset for X and Y is 0 and 0 (no offset). 

X: Displays the X origin offset in pixels. 

Y: Displays the Y origin offset in pixels. 

Preview: Displays the selected symbol in the Preview box if the Show Preview box is selected. 

Show Preview: Allows the selected symbol to be shown in the Preview box. 

If the Symbol Library Preview Window is not displaying the selected symbol, simply open any 
configuration page and the functionality will be restored. 

You may double click on a symbol on a configuration page to view the Symbol Properties dialog 
box. Refer to the Symbol Properties topic for more information. 

The objects that make up a symbol cannot be edited. If you wish to change an object within a symbol, 
you must select the symbol on the configuration page and choose the Break Symbol selection under 
the Object Menu to break the symbol into the original separate objects. The objects may be edited and 
then you may choose the Make Symbol selection from the Object Menu again. 
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Symbol Properties 
When you double click on a symbol on a configuration page, the Symbol Properties dialog box will 
appear. 

  
The Symbol Properties dialog box allows you to change the pixel location and the X-Y offset of the 
symbol and preview the selected symbol. 

The fields in the Symbol Properties dialog box are described below. 

Symbol Name: Displays the name of the symbol you selected. Note that you may scroll through the 
symbol name list and preview each symbol if the Show Preview box is selected. 

Symbol Origin Offset: Displays the symbol’s origin offset (in pixels). The default Symbol Origin 
Offset for X and Y is 0 and 0 (no offset). The blinking crosshair in the bounding box represents the 
origin location. All of the objects that make up a symbol are drawn using an offset from the origin. 

X: Displays the X origin offset in pixels. 

Y: Displays the Y origin offset in pixels. 

Preview: Displays the selected symbol in the Preview box if the Show Preview box is selected. 

Show Preview: Allows the selected symbol to be shown in the Preview box. 
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Pixel Location: Allows you to change the pixel location for the selected symbol.  

X: Allows you to move the symbol to the left or right on the configuration page. The value 
entered in the X field determines the distance in pixels from the left edge of the page. 

Y: Allows you to move the symbol up and down on the configuration page. The value entered in 
the Y field determines the distance in pixels from the top of the page. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the symbol to be refreshed to properly reflect the layering of objects 
on the page whenever the symbol is updated. 

Enable Conditional Visibility: Allows you to determine if the symbol will appear on a page based on 
the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the 
symbol will always appear on the page. 

Note that a symbol that is invisible because the Visibility Expression evaluates to false, will still 
impose the same memory and polling response impact as when the symbol is visible. Therefore, the 
visibility feature should not be used to circumvent page number or capacity limitations. 

It is also important to note that if you attempt to layer more than two symbols and use the Enable 
Conditional Visibility feature to display different states of a symbol on a PanelMate Power Series 
1500 unit, the PanelMate unit’s performance may be sluggish. If this occurs, the Dynamic Graphics 
option should be installed and Variable-Sized Graphic objects should be used to display the different 
symbol states.  

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the symbol 
will be erased and all template updating will be deactivated when in Run Mode. If the Visibility 
Expression evaluates to true (not equal to zero), the symbol will appear and all template updating 
will be activated when in Run Mode. 

<Origin>: Opens the Symbol Origin dialog box. This button allows you to change the selected 
symbol’s Origin Offset. 
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Symbol Origin 
When you press the Origin button on the Symbol Properties dialog box, the Symbol Origin dialog 
box will appear. 

  
The Symbol Origin dialog box allows you to change the offset of the selected symbol’s origin. 

CAUTION: Changing the origin affects ALL occurrences of this symbol in this 
configuration! 

The fields in the Symbol Origin dialog box are described below. 

Symbol Origin Offset: Allows you to change the offset of the symbol’s origin. Note that if you 
modify the offset, you will be modifying the offset of the actual symbol in the Symbol Library that 
may be used on several pages throughout the configuration. If you increase the X and Y offsets, the 
objects in the symbol will move left and down respectively. If you decrease the X and Y offsets, the 
objects in the symbol will move right and up respectively. The blinking crosshair will remain at a 
constant position that is the origin location. 

The values in the X and Y offsets are added to the original offset of each object from the upper-left 
corner of the bounding box. If an object in the symbol was originally 20 pixels in X from the blinking 
crosshair and you modified the X origin offset to be 10, the object would be drawn 30 pixels (20 + 10 
= 30) from the blinking crosshair. Likewise, if you modified the X origin offset to be -10, the object 
would be drawn 10 pixels (20 + (-10) = 10) from the blinking crosshair. 

X: Allows you to offset the symbol to the left or right. 

Y: Allows you to offset the symbol up or down. 

For more information on the Symbol Origin Offset, refer to the Symbol Origin Offset Example. 
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Symbol Origin Offset Example 
A circle has been created with a height of 100 pixels and a width of 100 pixels and made into a 
symbol. The blinking crosshair that represents the origin appears in the upper-left corner. The X and Y 
origin offset is 0 and 0. Refer to the figure below. 

  
To offset the symbol so the origin appears in the center of the circle, change the X and Y origin offset 
to -50 and -50. Refer to the figure below. 

  
Now when symbol is used, the location you click on the configuration page will be at the center of the 
circle instead of the upper-left corner. 
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System Parameters  

6 

In this chapter, you will learn: 

• About the System Parameters - General Tab dialog box 

• About the System Parameters - Password Tab dialog box 

• About the System Parameters - Communications Tab dialog box 

• About the System Parameters - Remote Tab dialog box 
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System Parameters 
When you double click on the System Parameters selection in the Database Treeview Window, the 
System Parameters dialog box will appear. 

System Parameters are a set of four tabbed dialog boxes used to edit system parameters. The System 
Parameters are used by the PanelMate unit while it is in Run Mode. The dialog boxes are listed below. 

• System Parameters - General Tab 

• System Parameters - Password Tab 

• System Parameters - Communications Tab 

• System Parameters - Remote Tab 
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System Parameters – General Tab 
The System Parameters - General Tab dialog box is shown below. 

  
The fields in the System Parameters - General Tab dialog box are described below. 

Audio Output 
Operator Input: Sets the volume of the audio tones used as feedback for operator inputs. 

Alarms: Sets the volume of alarm annunciation. 

Inactivity Periods 

Screen Blanking: Determines the time the PanelMate unit waits, without operator input, before 
blanking the screen. This function helps prolong the life of the monitor. 

To prevent “screen burn”, the PanelMate unit waits the indicated number of minutes. If there is no 
operator input during this time, the PanelMate unit displays a screensaver that shows PanelMate 
units randomly appearing. 

Any operator input resets the Screen Blanking timer and recalls the previously displayed page. 
The page is also recalled automatically if any template or variable-sized template goes into alarm 
or if an automatic page change occurs. 

Tip: If you are creating a PanelMate PC configuration, it is recommended that you use 
the Screen Blanking feature instead of the Windows screen saver. 

Automatic Cancel: Determines the time the PanelMate unit waits, without operator input, before 
de-selecting a template. This function helps prevent accidental usage of the control buttons if you 
leave a template or variable-sized template selected after use. 

Any operator input resets the Automatic Cancel timer. 

Note that the Automatic Cancel time-out also resets the Screen Blanking timer. 
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Fonts 

Redefine Quad Font: Allows you to re-define the Quad Font. When the Redefine Quad Font box 
is selected, custom characters can be created in the Font Editor. Refer to the Font Editor topic for 
more information. 

Redefine Double-High Font: Allows you to re-define the Double-High font. When the Redefine 
Double-High Font box is selected, custom characters can be created in the Font Editor. Refer to 
the Font Editor topic for more information. 

Enable Extended Fonts: Allows you to extend the character set from 128 characters to 256 
characters. The extended characters can be customized. Refer to table in the Selected Font section 
in the Font Editor topic for more information. 

Page 

Startup Page Number: Allows you to enter the page number of the page to be displayed first 
when the PanelMate unit enters the Run Mode. 

Control Bit Reset Delay: Sets the delay between the bit-set and bit-clear commands sent to a 
PLC from the control buttons. Since control buttons can be pressed (causing bit-set) and released 
(causing bit-clear) very quickly, some PLC programs need time to sense the bit-set command 
before receiving a bit-clear command. 

Page Status Line Display: Determines how the Page Status Line is displayed during Run Mode. 
The Page Status Line will display only the pages in alarm in a first-in-first-out (FIFO) format.  

Tip: If you are creating a V2.1X configuration for a PanelMate unit with 10 pages (numbered 0-9), 
the Standard selection can be selected if you wish to display all page numbers. The intensity or 
color of each number will indicate the status of that page. 

Enable Host Display Window: Allows you to enable an extra page that can receive and display 
data from a host computer. The Host Display Window uses the entire 3x5 template display area. 
Data is sent from the host computer via the Generic Protocol. 

Refer to the Generic Protocol Driver Manual for more information about the Host Display 
Window. 

Note that if you are creating a PanelMate PC configuration, do not enable the Host Display 
Window. 

Allow Immediate Page Change: Determines if a PLC can change the displayed page (through the 
Page Change Register field) while the PanelMate unit has a template or variable-sized template 
selected. 

If the Allow Immediate Page Change field is selected, the page change can occur even if the 
operator is in the process of entering information. 

If the operator is pressing a control button at the time a page change from the PLC occurs, the 
CANCEL key will need to be pressed to initiate the page change. 

If the Allow Immediate Page Change field is not selected, the page change will not occur until all 
templates and variable-sized templates are de-selected (such as when the CANCEL key has been 
pressed). 
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Direct Select (Touchscreen Only): Allows one-touch selection on touchscreen units for variable-
sized templates. For example, instead of having to step through multiple objects to get to a variable-
sized template, you can touch the object to immediately select it.  

The Direct Select feature also enables one-touch operation for the Variable-Sized Control Buttons. For 
more information about Variable-Sized Control Buttons, refer to the Variable-Sized Control Button 
Template topic. 

Note that The Direct Select (Touchscreen Only) feature is intended for use on PanelMate touchscreen 
units and PanelMate PC units only. 

Flexible Page Layout: Allows you to use the entire 640 x 464 pixel page for templates and 
PowerGraphics. When the Flexible Page Layout box is selected, you can determine which flexible 
items will not appear on the page by de-selecting the Page Status Banner box, Alarm Table box, 
Cancel Key box, or Default Buttons box in the New Configuration Page dialog box or the Page 
Properties dialog box. Refer to the New Configuration Page or Page Properties topic for more 
information. 

Note that if a flexible item appears on top of a template or graphic on your configuration page, the 
underlying template or graphic will be deleted when the configuration is exported. 
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System Parameters – Password Tab 
The System Parameters - Password Tab dialog box is shown below. 

  
The fields in the System Parameters - Password Tab dialog box are described below. 

Passwords 
Password A: Allows you to enter a numeric password between 0 and 65535. Passwords can be 
used to limit operator access to pages, offline mode, date/time change, and numeric entry from 
templates. 

The default Password A sent with the demonstration screens is 1. 

Note that passwords above 65535 or passwords with leading zeroes are not supported in Run 
Mode. 

Overwrite Password A: Determines whether Password A already set in the PanelMate online 
unit will be overwritten when a new configuration is downloaded. You may want the operator to 
learn a pair of passwords that will not change with every new configuration. 

If the Overwrite Password A box is not selected, new passwords will be ignored when a new 
configuration is downloaded. 

If the Overwrite Password A box is selected, the passwords saved in the new configuration 
become active when the configuration is downloaded. 

Allow Password A Change: Determines whether Password A can be changed during Run Mode. 

If the Allow Password A Change box is not selected, the password cannot be changed. Note that 
the Change Password A template will not appear on the Setup Page in Run Mode. 

If the Allow Password A Change box is selected, the password can be changed by an operator 
having the password. To change the password in Run Mode, select the Change Password A 
Template on the Setup Page. 
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Password B: Allows you to enter a numeric password between 0 and 65535. Passwords can be 
used to limit operator access to pages, offline mode, date/time change, and numeric entry from 
templates. 

The default Password B sent with the demonstration screens is 2. 

Note that passwords above 65535 or passwords with leading zeroes are not supported in Run 
Mode. 

Overwrite Password B: Determines whether password B already set in the PanelMate online unit 
will be overwritten when a new configuration is downloaded. You may want the operator to learn 
a pair of passwords that will not change with every new configuration. 

If the Overwrite Password B box is not selected, new passwords will be ignored when a new 
configuration is downloaded.  

If the Overwrite Password B box is selected, the passwords saved in the new configuration 
become active when the configuration is downloaded. 

Allow Password B Change: Determines whether Password B can be changed during Run Mode. 

If the Allow Password B Change box is not selected, the password cannot be changed. Note that 
the Change Password B Template will not appear on the Setup Page in Run Mode. 

If the Allows Password B Change box is selected, the password can be changed by an operator 
having the password. To change the password in Run Mode, select the Change Password B 
Template on the Setup Page. 

Password Protection 

Entry into Offline Mode: Allows you to select a type of protection for entering into the Offline 
Mode. The selections are listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
The page will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the Password A and Password B fields. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the 
PanelMate Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 
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Set Date/Time: Allows you to select a type of protection for setting the date and time. The 
selections are listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
The page will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit.  

Password A and Password B are defined in the Password A and Password B fields. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the 
PanelMate Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 

Page Password Timeout: Allows the password to be valid for a defined number of minutes 
before timing out. Note that a value of 0 (zero) indicates that there is no timeout period. 

 



 Chapter 6: System Parameters 101 

System Parameters – Communications Tab 
The System Parameters - Communications Tab dialog box is shown below. 

  
The fields in the System Parameters - Communications Tab dialog box are described below. 

Scan Delay In Seconds 

Scan delay is the amount of time the PanelMate unit will wait upon receiving data from the PLC 
before the it requests another update from the PLC. 

Note that a value of 0 (zero) causes the PanelMate unit to continually scan. The maximum value is 
99.99 seconds. For best performance, set the delay to the longest interval your application will permit. 
A minimum of 1.0 seconds is recommended. 

Screen: Sets the scan delay for page updates while in Run Mode. A value of 0 causes the 
PanelMate unit to update a page as fast as possible. The maximum value is 99.99 seconds. 

Alarm: Sets the scan delay for updates of all alarms while in Run Mode. A value of 0 causes the 
PanelMate unit to update background alarms as fast as possible. The maximum value is 99.99 
seconds. 

All PLC references in the System Parameters dialog box will be polled as part of the Alarm 
Scan. 

Message: Sets the scan delay for updates from all register references (defined in messages) while 
in Run Mode. A value of 0 causes the PanelMate unit to update the register values as fast as 
possible. The maximum value is 99.99 seconds. 
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Trend: Sets the scan delay for updates from the PLC of all register references for Bar Trend 
Templates and Line Trend Templates while in Run Mode. A value of 0 causes the PanelMate unit 
to update the register values as fast as possible. The maximum value is 99.99 seconds. 

Note that the interval evaluated in the Interval Expression field in the Bar Trend Template - Bar 
Trend Attributes Tab dialog box or the Line Trend Template - Line Trend Attributes Tab 
dialog box should be as long, if not longer, then the Trend Scan Delay. 

For information about calculating the trend value sample rate, refer to Interval Expression field in 
the Bar Trend Template - Bar Trend Attributes Tab dialog box or the Line Trend Template - 
Line Trend Attributes Tab dialog box. 

Retry Delay: Determines if there will be a delay between communication attempts when there is lost 
communications. When the Retry Delay box is selected, the PanelMate unit will increase the time 
interval of attempts to re-establish communications as the length of time that the PanelMate unit and 
the PLC are not communicating increases. If this feature is enable, it will prevent several PLCs on a 
network from becoming busy unnecessarily if communications have not taken place over a long period 
of time. When the Retry Delay box is not selected, the PanelMate unit will immediately and 
continuously attempt to re-establish communications. If this feature is not enabled, it will prevent any 
delays that may occur after successfully sending data to the PLC. 

Bit Zero After Comm Fault: Provides the capability to reset (i.e., write zeroes to) all PLC bits 
configured in the PLC Bit Reference fields for each control button. Note that any bit writes in 
Variable-Sized Control Buttons configured as Normally Closed, Momentary will have a 1 written to 
PLC bits instead of a 0 when a reset operation occurs. The PLC bits will reset when a PLC 
communication error has been cleared (i.e., communication with the PLC has been re-established) and 
the Enable Fault Relay control button is pressed.  

The Bit Zero After Comm Fault field also controls whether the PLC control bits are reset on power-up 
of the PanelMate unit. If the Bit Zero After Comm Fault box is selected, the automatic reset of all PLC 
bits will be enabled at both power-up and after a communications fault reset. If the Bit Zero After 
Comm Fault box is not selected, the automatic reset of PLC bits will be disabled at both power-up and 
after a communications fault reset. 

Note: If the Bit Zero After Comm Fault box is selected, the Fault Relay De-energize On Alarm 
box must be de-selected.  

If the fault relay is enabled via the Remote Enable Fault Relay Bit (from the PLC) field, the Bit Zero 
After Comm Fault field is disabled. The Bit Zeros After Com Fault field is only applicable when the 
Enable Fault Relay control button is pressed. 

Refer to Appendix B, Momemtary Pushbutton Operation, in the PanelMate Power Series Online 
Operation User’s Guide for more information on momentary pushbutton precautions. 

Fault Relay De-energize On Alarm: Allows you to control what happens to the PanelMate unit’s 
fault relay when a alarm occurs. If the Fault Relay De-energize on Alarm box is selected, the fault 
relay will be de-energized when a communication error or system error occurs, when power is lost, 
when an alarm condition is detected, or when the PanelMate unit is put into offline mode. If the Fault 
Relay De-energize on Alarm box is not selected, the fault relay will only de-energize when a 
communication error or system error occurs, when power is lost, or when the PanelMate unit is put 
into offline mode. 

If the Fault Relay De-energize On Alarm box is selected, the Bit Zero After Com Fault box must be 
disabled. 
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System Parameters – Remote Tab 
The System Parameters - Remote Tab dialog box is shown below. 

The fields in the System Parameters - Remote Tab dialog box are described below. 

Note:  Bit references are used in the System Parameters – Remote Tab dialog box fields. If you 
have an associated .csv file for tags and have tags assigned for these references, you can 
access your tag names and references by using the  button. You can also access them 
by entering a left bracket ([) or by entering a comma (,) after entering the PLC device 
name. For more information on tags, refer to Chapter 12: Using Tags. 

Remote Alarm Acknowledge Bit 
Only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left 
blank, the features will be disabled. 

To PLC: Allows you to set a bit in the PLC when the Acknowledge All Alarms control button is 
pressed during Run Mode. 

From PLC: Allows you to scan a bit in the PLC and acknowledge all current alarms when the bit 
is set. 

Remote Silence Alarm Horn Bit 
Only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left 
blank, the features will be disabled. 

To PLC: Allows you to set a bit in the PLC when the Silence Alarm Horn button is pressed 
during Run Mode. 

From PLC: Allows you to scan a bit in the PLC and silence the alarm horn when the bit is set. 
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Remote Enable Fault Relay Bit 
Only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left 
blank, the features will be disabled. 

To PLC: Allows you to set a bit in the PLC when the Enable Fault Relay control button is 
pressed during Run Mode. 

From PLC: Allows you to scan a bit in the PLC and enable the fault relay when the bit is set. 

Page Change Register 
For information on changing pages by pressing a control button, refer to the Page Change with Delay 
Example topic. 

Only register references are allowed in these boxes. Expressions may not be entered. If these boxes are 
left blank, the features will be disabled. 

To PLC: Allows you to write the page number of the currently displayed page to a register in the 
PLC during Run Mode. Note that there are two unique page numbers. The Alarm Page number is 
10000 and the Setup Page number is 10001. All other pages will use the page number defined in 
the New Configuration Page dialog box or the Page Properties dialog box. 

From PLC: Allows you to scan a register in a PLC and change to the page number matching the 
register value. When a new valid page number is detected in the Page Change Register, the title 
bar will blink. The page does not change immediately if the operator has selected a control 
template, but waits until the control template is de-selected. This requirement can be changed if 
the Allow Immediate Page Change box is selected in the Systems Parameters - General Tab 
dialog box. 

If the Page Change Register receives a valid page number that is the same as the number in the 
register, it will not change pages. 

If the Page Change Register receives an invalid number, it will remain on the current page. 

If the operator is pressing a control button at the time a page change from the PLC occurs, the 
CANCEL key will need to be pressed to initiate the page change. 

Note that the Page Change Register will override Page Password Protection. If necessary, use 
Remote Sending of Passwords and PLC ladder logic to implement a protection scheme. 

Remote Sending Of Passwords 
Only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left 
blank, the features will be disabled. 

Password A: Allows you to set a bit in the PLC when the operator enters valid passwords during 
Run Mode. The bit is set when the password is logged-in on the Setup Page during Run Mode. 

Password B: Allows you to set a bit in the PLC when the operator enters valid passwords during 
Run Mode. The bit is set when the password is logged-in on the Setup Page during Run Mode. 

Hardware Selection: Allows you to set a bit in the PLC when an external keyswitch is turned on 
during Run Mode. The bit is set when the hardware contact is closed and the keyswitch is closed 
(on). 

 



 Chapter 6: System Parameters 105 

Reset Clock To 00:00:00 Bit: Allows you to scan a bit in the PLC and reset the PanelMate unit’s 
system clock when the bit is set. (The clock will reset each time you change to a page that has the reset 
clock bit set to 1.) 

Note that only bit references are allowed in these boxes. Expressions may not be entered. If these 
boxes are left blank, the features will be disabled. 

The date is changed to the day closest to the current time. The following examples show how the date 
is affected by the clock synchronization bit. 

Time/Date Before Reset Time/Date After Reset 

23:30:10 December 10, 1997 00:00:00 December 11, 1997 

00:30:10 December 13, 1997 00:00:00 December 13, 1997 

12:00:00 December 24, 1997 00:00:00 December 25, 1997 

11:59:59 December 27, 1997 00:00:00 December 27, 1997 

Remote Mode Change: Allows the PanelMate unit to accept remote mode changes from Run Mode 
to Transfer Mode (or vice-versa) from a personal computer over a network. It also determines the 
manner in which the remote mode change will occur. The selections are listed below. 

NEVER A remote mode change is not allowed. 
IMMEDIATE The remote mode change will occur instantly. 

DEFAULT The remote mode change will occur when the PanelMate 
unit is in a default state (no templates or symbols are 
selected on screen).  

ACCEPT An operator must accept the remote mode change at the online unit. 
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Page Change with Delay Example 
The ladder program below shows a page change with a time delay. 

  
This ladder program will allow the operator to change pages by pressing a control button on the 
PanelMate unit. The second move ensures that there will be a change in the register next time I1 is 
pressed. 

Note that the timers can be adjusted to lengthen or shorten the time delay. 
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PLC Name and Port Table 

7 

In this chapter, you will learn: 

• About the PLC Name and Port Table dialog box 

• About the Port Settings dialog box 

• About the Unsolicited Device dialog box 

• About the Generic Protocol dialog box 

• About the AB DH-485 Maximum Node Address dialog box 

• About the Allen-Bradley Remote I/O Setup dialog box 

• About the GE Fanuc Genius I/O dialog box 

• About the Reliance DCSNet Interface Drop dialog box 

• About the DeviceNet Setup dialog box 

• About the Tag Name File dialog box 

• About OPC Client Connectivity 

• About DDE Client and Server Communications 
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PLC Name and Port Table 
When you double click on the PLC Name and Port Table selection in the Database Treeview Window, 
the PLC Name and Port Table dialog box will appear. 

  
The PLC Name and Port Table dialog box allows you to set communication port parameters, PLC 
device names, and ID numbers. 

The fields in the PLC Name and Port Table dialog box are described below. 

Port Parameters 
Port/Device Use/Local ID: Displays the configurable ports installed on your PanelMate unit, the 
device assigned to the port, and the local ID. 

If a PanelMate PC configuration has a serial communications driver assigned to a serial port 
which is not available within Windows NT, an error message will appear when you run the 
configuration. To troubleshoot the possible conflicts, check the Ports configuration and Devices 
configuration in the Control Panel or check the Windows NT Diagnostics in the Administrative 
Tools (Common). 

Device Use: Displays the device assigned to the port. You can select various PLC drivers, Serial 
Printer, or No Usage from the Device Use box. The selection chosen in the Device Use box will 
appear in the Port/Device Use/Local ID box. Different device drivers will appear in the list for the 
Device Use box depending on the port you have selected in the Port/Device Use/Local ID box. 
Note that only device drivers that have been installed from the driver disks will appear. 
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Local ID: Assigns a number to the PanelMate unit on a PLC network. See the appropriate 
Communication Driver Manual for PLC-dependent local ID# information. 

Do not use the same number for the Local ID and the remote ID. 

<Port Settings>: Displays the Port Settings dialog box. The Port Settings dialog box is used to 
select the communication parameters for the selected port. Refer to the Port Settings topic for 
more information. 

<Unsolicited Device>: Displays the Unsolicited Device dialog box. The Unsolicited Device 
dialog box is used to assign a name and a model to an unsolicited device on the I/O port that is the 
only port that accepts unsolicited messages for communication. Refer to the Unsolicited Device 
topic for more information. 

<Generic>: Displays the Generic Protocol dialog box. The Generic button appears when you 
select Generic Protocol in the Device Use box. Refer to the Generic Protocol topic for more 
information. 

<DH-485>: Displays the AB DH-485 Maximum Node Address dialog box. The DH-485 button 
appears when you select DH-485 in the Device Use box. Refer to the AB DH-485 Maximum 
Node Address topic for more information. 

<Remote I/O>: Displays the Allen-Bradley Remote I/O Setup dialog box. The Remote I/O 
button appears when you select Allen-Bradley Remote I/O in the Device Use box. Refer to the 
Allen-Bradley Remote I/O Setup topic for more information. 

<Genius I/O>: Displays the Genius I/O dialog box. The Genius I/O button only appears when 
you select Genius I/O in the Device Use box. Refer to the GE Fanuc Genius I/O dialog box topic 
for more information. 

<DCSNet>: Displays the Reliance DCSNet Interface Drop dialog box. The DCSNet button 
appears when you select Reliance DCSNet in the Device Use box. Refer to the Reliance DCSNet 
Interface Drop topic for more information. 

<DeviceNet>: Displays the DeviceNet Setup dialog box. The DeviceNet button appears when 
you select DeviceNet in the Device Use box. Refer to the DeviceNet Setup topic for more 
information. 

PLC Name Parameters 
Item/Name/Port/Model/Remote ID: Displays the item number, PLC name, port number, model, 
and remote ID. If you choose the <New Entry> selection, you can configure a new PLC using 
default values for the Name, Port, Model, and Remote ID fields. 

If you select <New Entry>, the Copy, Paste, and Delete buttons will be disabled.  

Name: Allows you to enter names for each PLC to be addressed. This name is used by the 
PanelMate unit and does not make reference to the PLC directly. This name should be used when 
specifying word and bit addresses during page development 

Port: Allows you to define which ports will be used to communicate to each PLC. If a port has 
been configured as No Usage or Serial Printer, the port number will not appear in the Port field. 

Model: Allows you to choose from a list of model types for each device. You should choose the 
model most closely related to the device being used. 

Remote ID: Allows you to define the ID or node of each device. 
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<Add>: Allows you to add a new entry to the Item/Name/Port/Model/Remote ID box. If you 
select a port in the Port field, select a model in the Model field, and configure the Name and 
Remote ID fields, you can click the Add button to add a new entry to the 
Item/Name/Port/Model/Remote ID box. 

<Change>: Allows you to change a selected entry in the Item/Name/Port/Model/Remote ID 
box. If you select an entry in the Item/Name/Port/Model/Remote ID box and make a change 
to the Name, Port, Model, and Remote ID fields, you can click the Change button to change 
an entry in the Item/Name/Port/Model/Remote ID box. 

<Copy>: Allows you to copy a selected entry in the Item/Name/Port/Model/Remote ID box. 
If you select an entry in the Item/Name/Port/Model/Remote ID box and you can click the 
Copy button to copy an entry. After copying, you can use the Paste button to paste a copy of 
the entry elsewhere in the Item/Name/Port/Model/Remote ID box. 

<Delete>: Allows you to remove an entry from the Item/Name/Port/Model/Remote ID box. If 
you select an entry in the Item/Name/Port/Model/Remote ID box and click the Delete button, 
the entry will be removed. 

<Paste>: Allows you to paste an entry after copying an entry from the 
Item/Name/Port/Model/Remote ID box. If you select an entry in the 
Item/Name/Port/Model/Remote ID box and click the Paste button, the entry will be pasted 
after the entry you selected. 

<Tag File...>: Displays the Tag Name File dialog box. The Tag File... button appears when 
you select any PLC in the Item/Name/Port/Model Remote ID box. Refer to the Tag Name 
File topic and Chapter 12: Using Tags for more information. 

<OPC Setup>: This button only appears when OPC Server is selected in the Device Use 
field, and a device name is selected in the PLC Name Parameters that is assigned to the 
OPC Server. It is used to define the server name and the access path name. When selected, 
the OPC Server Setup for Device dialog box will appear. 

NOTE: The format for determining an access path is server-dependent. 

The OPC Server option is only available for PanelMate PC Pro configurations. For more 
information, refer to OPC Client Connectivity 

.
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<DDE Setup>: This button only appears when DDE Server is selected in the Device Use field, 
and a device name is selected in the PLC Name Parameters that is assigned to the DDE Server. 
When selected, the DDE Server Setup for Device dialog box will appear. 

The DDE Server option is only available for PanelMate PC Pro configurations. For more 
information, refer to DDE Client and Server Communications and your DDE Communications 
Manual. 

<Default PLC Name>: Allows you to enter one of the PLC names or Unsolicited Device names. 
Any word or bit address used in the configuration that does not specifically state the name of a 
PLC will be assumed to be referring to the default PLC. It is to your advantage to use the name of 
the PLC most often referenced.  

If you delete or change the selected default name, the first name in the 
Item/Name/Port/Model/Remote ID box will automatically become the Default PLC Name. 
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Port Settings 
When the Port Settings button is clicked on the PLC Name and Port Table dialog box, the Port 
Settings dialog box will appear. 

  
The Port Settings dialog box is used to select the communication parameters for the selected port. 

Note that depending upon the device selected in the Device Use box, some communication parameters 
may be disabled. If one of the choices is disabled, refer to the appropriate Communication Driver 
Manual for the settings. 

The fields in the Port Settings dialog box are described below. 

PORT#: Displays the port selected in the Port/Device Use/Local ID box in the PLC Name and Port 
Table dialog box. 

Electrical: Allows you to set the type of electrical communication for the port. You have three 
choices: RS232, RS422, and 485. 

Baud Rate: Allows you to set the data transfer speed used in communications. 

Data Bits: Allows you to set the number of data bits used in communication. You can select 5, 6, 7, 
and 8 data bits. 

Stop Bits: Allows you to set the number of stop bits used in communications. You can select 1, 1.5, or 
2 stop bits. 

Parity: Allows you to set the parity type used in communication. You can select None, Odd, or Even. 
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Unsolicited Device 
When the Unsolicited Device button is clicked on the PLC Name and Port Table dialog box, the 
Unsolicited Device dialog box will appear. 

  
The Unsolicited Device dialog box is used to assign a name and model to an unsolicited device. 

The fields in the Unsolicited Device dialog box are described below. 

PORT#: Displays the port selected in the Port/Device Use/Local ID box in the PLC Name and Port 
Table dialog box. 

Name: Allows you to define names for each PLC to be addressed. You use this name when specifying 
word and bit addresses that will display unsolicited data only. References specified with an 
Unsolicited Device Name will not be polled by the PanelMate unit and will only be updated by an 
unsolicited write from the PLC. 

Note that unsolicited references are initialized as zeroes. 

Model: Allows you to define the model type of each PLC that supports unsolicited writes. 

The PLC model type in the MSG instruction, configured in the PLC ladder logic, must match the PLC 
type in the Unsolicited Model field. 

For more information about unsolicited data, refer to the Allen-Bradley Communication Driver 
Manual or the Modicon Communication Driver Manual. 
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Generic Protocol 
To configure the Generic Protocol dialog box, the following steps must be completed. 

1. A port must be selected and Generic must be selected in the Device Use field in the PLC Name 
and Port Table dialog box. 

2. Click the Generic button and the Generic Protocol dialog box will appear. 

The Generic Protocol dialog box is shown below. 

  
The Generic Protocol dialog box is used to configure serial ports that use the Generic Protocol for 
communication. 

The fields in the Generic Protocol dialog box are described below. 

PORT#: Displays the port selected in the Port/Device Use/Local ID box in the PLC Name and Port 
Table dialog box. 

Name: Allows you to define names for each device to be addressed. This name is used when 
specifying word and bit addresses during page development. 

Type: Defines the addressing method (octal or decimal) to be used in the PanelMate unit. 

ID# included: Specifies whether the ID number of the PanelMate unit will be used in the 
communication frames. 

BCC/Bit# included: Specifies whether each Generic Protocol frame includes BCC/Bit# error 
checking for the frame. 

For more information about Generic Protocol, refer to the Generic Protocol Communication Driver 
Manual. 
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AB DH-485 Maximum Node Address 
To configure the AB DH-485 Maximum Node Address dialog box, the following steps must be 
completed. 

1. The Allen-Bradley DH-485 box must be selected in the New Configuration dialog box or the 
Configuration Properties dialog box. 

2. A port must be selected and Allen-Bradley Data Highway 485 must be selected in the Device Use 
field in the PLC Name and Port Table dialog box. 

3. Click the DH-485 button and the AB DH-485 Maximum Node Address dialog box will appear. 

The AB DH-485 Maximum Node Address dialog box is shown below. 

  
The AB DH-485 Maximum Node Address dialog box is used to select the maximum node address of 
the DH-485 network. 

The fields in the AB DH-485 Maximum Node Address dialog box are described below. 

PORT# Displays the I/O port which was selected in the Port/Device Use/Local ID box in the PLC 
Name and Port Table dialog box. 

Maximum Node Address: Set the maximum node address. This parameter should be set as low as 
possible to minimize the amount of time used in soliciting data when initializing the link and 
minimizes the amount of unnecessary token passes. 

The Maximum Node Address must match the maximum node address of all other devices on the DH-
485. 

For more information about Data Highway 485 communication, refer to the Allen-Bradley 
Communication Driver Manual. 
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Allen-Bradley Remote I/O Setup 
To configure the Allen-Bradley Remote I/O Setup dialog box, the following steps must be 
completed. 

1. The I/O port must be selected and Allen-Bradley Remote I/O must be selected in the Device Use 
field in the PLC Name and Port Table dialog box. 

2. Configure the Name, Port, Model, Remote ID, and Default PLC Name and click the Add button 
to place the information in the Item/Name/Port/Model/Remote ID box in the PLC Name and 
Port Table dialog box. 

3. Note that the selection chosen in the Model field will determine the number of racks that will 
appear in the Allen-Bradley Remote I/O Setup dialog box. When configuring the I/O port for 
Allen-Bradley Remote I/O communication, select the PLC-3 model for PLCs with more than 
seven racks. PLC models (e.g., PLC 5/40, 5/60, 5/80, etc.) that have more than seven racks must 
use the PLC-3 model selection to address racks above seven. 

4. Click the Remote I/O button and the Allen-Bradley Remote I/O Setup dialog box will appear. 

The Allen-Bradley Remote I/O Setup dialog box is shown below. 

  
The Allen-Bradley Remote I/O Setup dialog box is used to configure the PanelMate unit for remote 
I/O communication. 

The fields in the Allen-Bradley Remote I/O Setup dialog box are described below. 

PLC Model: Displays the PLC model selected in the PLC Name and Port Table dialog box. 
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Active Rack: Allows you to define which racks are to be simulated by the PanelMate unit on the 
network. 

Rack Size: Selects the quarter racks. Each full rack can be split into a quarter rack or any multiple 
of a quarter racks (i.e., ¼, ½, ¾, or full rack). 

A blank entry shows the rack is inactive. A status of ¼, ½, ¾, or F shows the rack to be active and 
indicates the starting quarter for a fractional rack. A dash (-) indicates this rack is reserved. 

See the Active Rack Example. 

Note that when using a PLC 2/30, if the PanelMate unit is configured as active groups within a 
rack other than the highest group, then the PLC will not scan for any groups higher than those the 
PanelMate unit is simulating (physical groups or groups simulated on another AcceleratI/On 
board). To avoid this situation, make the PanelMate unit the highest active group within a rack 
and only configure one PanelMate unit active on any one rack. 

Block Transfer Addressing: Allows you to define the word offset base in all monitored and active 
Block Transfers as OCTAL or DECIMAL. The default is octal. 

The Block Transfer Addressing field only applies to the word offset. Bits within the words are 
addressed as octal (0-7 and 10-17). 

Active Block Transfer Table: Allows you to configure active block transfers between the PanelMate 
unit and a PLC. You may define up to 16 active block transfers, A through P, each with up to 64 
words. 

Direction: This column defines the direction of the block transfer. The available selections are 
NONE, READ, WRITE, COMMON, and PASS-THROUGH. 

NONE indicates that there will not be a transfer. Note that when NONE is selected the other 
boxes in this group are disabled. 

READ allows the PLC to read a block of data from the PanelMate unit. 

WRITE allows the PLC to write a block of data to the PanelMate unit. 

COMMON allows the PLC to read data from and write data to the PanelMate unit. 

PASS-THROUGH indicates that the block transfer is reserved for the pass-through feature. The 
PASS-THROUGH selection can only configured for one block transfer. 

All of the selections describe communication from the PLC’s point of view. 

Rack: Defines the rack being used by the block transfer. The available selections are determined 
by the Active Rack Table. 

Group: Defines the group number within the quarter rack being used by the block transfer. The 
selections available are 0 through 7. 

Slot: Defines the slot number within the group being used by the block transfer. The available 
selections are 0 and 1. 

Size: Defines the size in 16-bit words of the block transfer. The available selections are decimal 
numbers from 1 to 64. If the Direction is selected as PASS-THROUGH, the size is fixed at 64. 

For more information about Remote I/O, refer to the Allen-Bradley Communication Driver Manual. 
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Active Rack Example 
The example below shows a PanelMate unit simulating a full rack on rack 0, ¾ of rack 1 beginning 
with quarter 2, and ½ of rack 2 beginning with quarter 1. 
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GE Fanuc Genius I/O 
To configure the GE Fanuc Genius I/O dialog box, the following steps must be completed. 

1. The I/O port must be selected and Genius I/O must be selected in the Device Use field in the PLC 
Name and Port Table dialog box. 

2. Click the Genius I/O button and the GE Fanuc Genius I/O dialog box will appear. 

The GE Fanuc Genius I/O dialog box is shown below. 

  
The fields in the GE Fanuc Genius I/O dialog box are described below. 

Port#: Displays the I/O port that was selected in the PLC Name and Port Table dialog box. 

Global Data Length: Specifies the number of bytes of Global Data the PanelMate unit will transmit 
each bus scan onto the Genius I/O bus. The valid range for Global Data Length is 0 to 128 bytes (0 to 
64 words). 

For more information about Genius I/O, refer to the GE Fanuc Communication Driver Manual. 
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DeviceNet Setup 
To configure the DeviceNet Setup dialog box, the following steps must be completed. 

1. The I/O port must be selected and DeviceNet must be selected in the Device Use field in the PLC 
Name and Port Table dialog box. 

2. Click the DeviceNet button and the DeviceNet Setup dialog box will appear. 

The DeviceNet Setup dialog box is shown below. 

 
Note that when devices are added, changed, copied, or pasted to the Node/Message Type Table, the 
devices are sorted in ascending order by their MACID and then sorted in alphabetical order of their 
Label. 

The DeviceNet Setup dialog box is used to configure the PanelMate unit for DeviceNet 
communication. 

The fields in the DeviceNet Setup dialog box are described below. 

Label: Allows you to enter a name that is used to reference messages. This field is limited to 13 
alphanumeric characters. Note that the first letter must be an alpha character. 

You can enter up to 379 labels. 

MACID: Defines the MACID (node address) embedded in the 11-bit CAN (Controller Area Network) 
identifier. The valid range is 0 to 63. 

In most cases, the MACID will contain the slave address. If the message type is BSC (bit strobe 
command), the MACID field must contain the master address.  

A configuration will typically have only one BSC message type entered in the Node/Message Type 
Table. 
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Message Type: Allows you to define the type of message. The message types are listed below: 

PC Poll Command 

PR Poll Response 

BSC Bit Strobe Command 

BSR Bit Strobe Response 

CS Change of State 

MCSA Master Change of State Acknowledge 

MCS Master Change of State 

CSA Change of State Acknowledge 

Length: Defines the length of the message in bytes. The range is 0 to 400 bytes. 

<Add>: Allows you to add a device to the Node/Message Type Table by configuring the Label, 
MACID, Message Type, and Length fields and pressing the Add button. 

<Change>: Allows you to change a device that has been selected in the Node/Message Type Table by 
re-configuring the Label, MACID, Message Type, and Length fields and pressing the Change button. 

<Copy>: Allows you to copy a device that has been selected in the Node/Message Type Table. 

<Paste>: Allows you to paste a device in the Node/Message Type Table. Note that a device must be 
copied from the Node/Message Type Table before you can paste a device in the table. 

<Delete>: Allows you to delete a device in the Node/Message Type Table. 

For more information about DeviceNet, refer to the DeviceNet Communication Driver Manual. 
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Tag Name File 
Note:  It may be helpful to review Chapter 12: Using Tags prior to configuring the Tag Name 

File dialog box 
To configure the Tag Name File dialog box, the following steps must be completed. 

1. Select a PLC from the Device Use box in the PLC Name and Port Table. 

2. Click on the PLC in the PLC Name Parameters box.  

3. Click on the Tag File... button. 

The Tag Name File dialog box is shown below. 

The fields in the Tag Name File dialog box are described below. 

Tag Name File: Allows you to enter the path and name of the tag name .csv file. The Open button is 
available to assist you in locating your .csv file. 

Open: Allows you to browse and select the path for the Tag Name file. When the Open button is 
pressed, the Open Existing Tag Name File dialog box will appear. 

Tag Name Column: Allows you to select the column number of the .csv file that contains the Tag 
Name. 

Reference Column: Allows you to select the column number of the .csv file that contains the PLC I/O 

address reference. 

Note:  When using a Cutler-Hammer NetSolver Tag Name file, select the same column for 
both the Tag Name Column and the Reference Column. 
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Select Tag Start Row: Allows you to select the beginning row of the tag data. Since most .csv files 
contain some header information, it is necessary to identify the first row of actual tag data. 

Edit: If you wish to modify, add or delete any tag information in you .csv file, wyou will need to use 
another Windows application such as Notepad or Excel. The Edit button, combined with your 
selection of either the Notepad or Excel radio buttons, will launch the selected program. 

New: If you have a PanelMate configuration that was developed without tags, you can export your 
references to a .csv file using the New... button. Once created, you can associate the .csv file with a 
device in your source configuration or any other PanelMate configuration. Refer to Chapter 12: 
Using Tags for more information. 

Note:  The Tag Name File information will be saved into the PLC Name and Port Table in the 
PanelMate database. Only devices defined in the PLC Name Parameters box can have an 
associated .csv file. 
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OPC Client Connectivity 
Note:  OPC client connectivity is only available for PanelMate PC Pro. This functionality is not 

available for other PanelMate Power Series/Power Pro/Pro LT products. 

OLE for Process Control (OPC) is based on Microsoft’s COM/DCOM technology. OPC allows client 
applications access to any data source (device or database) in a consistent manner. PanelMate PC Pro 
is able to communicate as an OPC Client. Refer to the OPC Server documentation for information on 
installing, configuring, or troubleshooting the OPC Server. 

Operator Station Setup 
The following example outlines how to configure a PanelMate PC Pro operator station as an OPC 
Client. 

1. Open the OPC server configuration utility/program, and configure the server. After the server has 
been configured, close the server configuration utility. 

2. Open the PLC Name and Port Table. In the Device Use field, select OPC Server. 

Note:  The OPC Server can be configured on any port that is not being used. The port assignment 
is unrelated to the physical connection between the OPC Server and the PLC or device to 
which the OPC Server communicates. 

3. In the Name field, enter the device name. In this example, the name is plc1. 

4. Click on the Add button. The device's name will appear in the PLC Name Parameters window. 

5. Select the device in the PLC Name Parameters window. The OPC Setup button will appear. 
Click on the button to open the OPC Server Setup for Device dialog box. The example dialog 
box below represents a potential setup for a PLC device. Note that the format for determining an 
access path is server-dependent and may be different than the example shown. 
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Note:   As you configure each device and add it into the PLC Name Parameters field, you 
need to define the server name and access path for that device. 

6. Develop the PanelMate PC Pro configuration pages. 

7. Export the PanelMate PC Pro configuration. When you have completed your configuration, it 
must be exported before you can execute the configuration in the runtime software. To export 
a configuration, select the configuration name in the Database Treeview Window and choose 
the Export selection from the File menu. 

8. Double-click on the .PPS file to run the PanelMate PC Pro application. You may also create a 
shortcut to run your PanelMate PC Pro configuration. To create a shortcut within Explorer: 

• Right-click on the .PPS filename and choose Create Shortcut. 

• Right-click on the new icon and choose Properties. 

• In the Shortcut Properties dialog box, choose the Shortcut Tab. 

• In the Target field, enter the PMC.EXE pathname, the .PPS configuration filename, and 
the unsecure mode parameter for the runtime software. Note that the unsecure mode 
parameter is entered to allow you to view both the OPC Server and OPC Client 
applications. 

For an example of an entry in the Target field, refer to the line below. 
c:\pmconfig\ntonline\pmc.exe opcdemo.pps –u 
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DDE Client and Server Communications 
Note:  DDE communications is only available for PanelMate PC Pro. This functionality is not 

available for other PanelMate Power Series/Power Pro/Pro LT products. 

The PanelMate PC Pro operator station may be used as a DDE Client (i.e., obtain data from another 
Windows program.) Examples of other applications that may be used as DDE Servers to the 
PanelMate PC Pro operator station are listed below. 

• A weigh scale feeder system that has a serial communication interface program running on the 
personal computer and with DDE Server capability. 

• An SPC package that performs statistical calculations on data read from the PLC by the 
PanelMate PC Pro operator station (PanelMate PC Pro acting as a DDE Server) and provides 
results to the PanelMate operator station for display (PanelMate PC Pro acting as a DDE Client). 

The following example outlines how to configure a PanelMate PC Pro operator station as a DDE 
Client. 

1. Open the PLC Name and Port Table. In the Device Use field, select DDE Server. 

2. In the Name field, enter the logical device's name. In this example, the name is EXCEL 1. 

3. Click on the Add button. The device's name will appear in the PLC Name Parameters window. 

4. Select the connection in the PLC Name Parameters window. The DDE Setup button will 

appear. Click on the button to open the DDE Server Setup for Device dialog box. 

5. In the Server Name field, enter the name of the program (e.g.Excel). Each DDE server has only 
one server name. 

6. Topic Name field: All DDE servers support at least one topic.  
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7. Start Server Command field: This command is the pathname of the DDE server application 
if it is not already running. This field may be a blank line, which means that an attempt is not 
made to start the DDE server application if it is not already running. It is important to note that 
a line full of white spaces does not constitute a blank line. The white spaces will be sent to the 
DDE server application to be started, which will result in an error. 

8. DDE Execute field: This command is sent to the DDE server after a conversation has been 
initiated with the DDE server. This conversation only occurs one time at PanelMate PC 
startup. This field may be a blank line, which means that a DDE execute command is not sent 
to the DDE server. It is important to note that a line full of white spaces does not constitute a 
blank line. The white spaces will be sent to the DDE server application to be started, which 
will result in an error. 

9. In the Validation Time Out Value field, enter a value between 0 and 60 seconds. A zero 
value indicates that no connection validation will be done. Other values determine how often 
the PanelMate PC Pro operator station will check to make sure the DDE server is still running 
if data updates have not been sent within the time window. 

For information on configuring a PanelMate PC Pro operator station as a DDE client, refer to your 
DDE Connectivity Communication Driver Manual. 

The PanelMate PC Pro operator station may also be used as a DDE Server (i.e., supply data to 
another Windows program.) Examples of other applications that may be used as DDE Clients to 
the PanelMate PC Pro DDE Server are listed below. 

• A Microsoft Access database application which extracts PLC or controller data from the 
PanelMate PC Pro operator station and acts as an SQL Server to a host computer over an 
Ethernet network. 

• A Microsoft Visual Basic application that displays pop-up windows that appear on top of 
PanelMate PC Pro screens. 

• A Microsoft Visual Basic application or Microsoft Excel spreadsheet which configures a 
recipe or machine setup by writing to PanelMate PC Pro’s DDE Server. 

• A Microsoft Access database or Microsoft Excel spreadsheet that provides reports using data 
from a PanelMate configuration. 

For information on using a PanelMate PC Pro operator station as a DDE server, refer to your 
DDE Connectivity Communication Driver Manual. 
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Message Libary 

8 

In this chapter, you will learn: 

• About the Message Library 

• About Register References within Messages 
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Message Library 
Note that all messages to be shown in a Display Template or a Variable-Sized Display Template must 
be defined in the Message Library. It is recommended to define the messages in the Message Library 
before configuring a Display Template or a Variable-Sized Display Template. 

When you double click on the Message Library selection in the Database Treeview Window, the 
Message Library dialog box will appear. 

  
The Message Library dialog box allows you to create new messages and edit or replace existing 
messages in the Message Library.  

The fields in the Message Library dialog box are described below. 

Preview: Displays the currently selected message with the selected colors and font. 

Markings above the Preview box show the maximum message width for 3-wide, 4-wide, and 5-wide 
Display Templates. These markings indicate where the right edge of the Display Template will display 
the last character. 
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Msg#/Message/Destination: Displays the messages (as unformatted text) in the Message Library. The 
message selected in this box also displays in the Preview box. If more than one message is selected, 
the last one displays in the Preview box. The Msg#/Message/Destination box has three fields. The 
fields are described below. 

Msg#: Displays the message number. The message number is used to recall the message in the 
Display Template and Variable-Sized Display Template. All messages appear in numerical order. 
The number of messages that can be entered will vary depending on the product model and the 
options installed.  

Refer to the Capacity Expansion Kit section in the Product Options topic for information about 
the number of messages you can enter. 

Message: Displays the message text. A single message may contain up to five register references 
and clock or calendar references. (Refer to the Register References within Messages topic or the 
Clock and Calendar References within Messages topic for more information.) While in Run 
Mode, the register references are replaced with the numeric register content from the PLC. 

Destination: Displays the destination of the message (i.e., Screen, Printer, or Both).  

To select one message, place the cursor on the message then click the left mouse button. A selected 
message displays in the highlight color. 

To select a range of messages, select the first message, and then press the Shift key while you select 
the second message. All messages between the two messages will be selected. You can also drag the 
cursor to select a range of messages. Select the first message, then drag up or down. 

To select two or more messages, select the first message, then press the Ctrl key while you select the 
second message. Both messages are selected, but messages in between will not be selected. 

Message: Allows you to edit an existing message or create a new one. As you type, the message 
selected in the Msg#/Message/Destination box is updated. 

To create a new message, select an unused message number in the Msg#/Message/Destination box. 
You can type your new message in the Message field. 

To edit or replace a message, select a message in the Msg#/Message/Destination box. You can then 
edit the message in the Message field. 

FG: Allows you to select the foreground color of the message (or messages) selected in the 
Msg#/Message/Destination box. Note that you can choose blinking or non-blinking colors. 

BG: Allows you to select the background color of the message (or messages) selected in the 
Msg#/Message/Destination box. Note that you can choose blinking or non-blinking colors. 

Font: Allows you to select a font for the message (or messages). The selections available are Normal, 
Double High, and Quad. 

Note that you should test all message combinations that you expect to use before going online. Each 
line of text is totally independent, so be careful when making intensity or color and character size 
selections. Quad or double-high character lines can interfere with each other. 

Destination: Allows you to select the destination of the message. The selections available are Screen, 
Printer, or Both. Note that Display Templates containing messages with the Destination field 
configured as Both or Printer will not print in Run Mode if a screen saver is active. This is not a 
characteristic of Variable-Sized Display Templates if the Global Message field is configured as Yes in 
the Variable-Sized Display Template - Expressions Tab dialog box. 
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<Copy>: Copies a selected message (or messages) to the Windows clipboard. 

<Paste>: Places a message (or messages) from the clipboard to destinations you have selected in the 
Msg#/Message/Destination box. You can paste messages anywhere into the list, but the number of 
selected destinations must equal the number of messages on the clipboard. 

<Clear>: Erases the selected message (or messages) from the Msg#/Message/Destination box, but 
does not place them on the clipboard. 

<Undo>: Allows you to undo the previous editing or formatting change. 

<Redo>: Allows you to redo the previous undo. 

<Find>: Opens the Find dialog box. In the Find dialog box, enter the text string you wish to search 
for in the Find What field, choose the Match Whole Word Only or the Match Case selections if either 
or both selections apply, and select the direction of the search.  

Once you have entered the text string, you may click the Find Next button to find the next occurrence 
of the text string or press the Cancel button to close the Find dialog box. 

The Find and Replace functions start searching from the selected line in the 
Msg#/Message/Destination box. 

<Replace>: Opens the Replace dialog box. In the Replace dialog box, enter the text string you wish 
to search for in the Find What field, enter the replacement text string in the Replace With field, and 
then choose the Match Whole Word or Match Case selections if either or both selections apply.  

Once you have entered the text strings, you may click the Find Next button to find the next occurrence 
of the text string, click the Replace button to the replace the text string, click the Replace All button to 
replace all occurrences of the text string, or press the Cancel button to close the Replace dialog box. 
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Register References within Messages 
Within the PanelMate unit, you can reference PLC register locations within a message to display the 
numeric register content within the message while in Run Mode. You may use the following format to 
display the contents of the registers. 

$tw.d(expression) 

The following items need to be noted when putting register references in messages: 

• If a value is too large to display in the specified format width, a string of Xs (XXXXX) is 
displayed for the value. For example, if a message is defined as three characters, but the value 
from the PLC is four characters, the resultant will be displayed is XXX. 

• When the Message Expression is true, embedded references are updated on the screen but not 
sent to the printer. Messages configured for BOTH or PRINTER are sent to the printer when 
the Message Expression changes, and also when you change pages. 

• If a hard-coded value (e.g., 100) is placed in the Message Expression designated as Global, 
the message will only print once at bootup. 

• A message containing multiple PLC references will print to the screen or printer multiple 
times—once for each reference in the message. 

For more information on register reference formats, refer to the General Format, Decimal-Based 
Formats, Decimal Place Formats, Binary-Based Formats, or Formatting Examples topic. 
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General Format 
A message containing multiple PLC references will print to the screen or printer multiple times—once 
for each reference in the message. 

The general format expression is shown below. 

$tw.d(expression) 

where ... 

$ = format indicator 

t = type of numeric display 

I - Integer 
H - Hexadecimal 
B - Binary 
E - Exponential 
D - Floating decimal real value 
O - Octal 
F - Fixed decimal real value 
A - ASCII character 

w = Total field width including decimal point, negative sign (-), and positive sign (+) 

. = Separator between width of format and the number of decimal places 
(used with F or E format) 

d = Number of decimal places (used with F or E format) 

Format type D (floating decimal point) permits the decimal point to float in the display depending on 
the register’s value. This contrasts with format type F (fixed decimal point) which formats a value with 
a fixed decimal location. Format type F may be useful when creating a column of values. 

Floating decimal point format type should not be confused with floating point mathematics or floating 
point data types that cannot be read or manipulated in the PanelMate unit. 
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Each format has a maximum number of characters it can display, and a number cannot be completely 
displayed if the format description is too small. The following are the width limits for each format 
type. 

I11 = Largest Integer value width is 11 

H8 = Largest Hexadecimal value width is 8 

O11 = Largest Octal value width is 11 

B32 = Largest Binary value width is 32 

D65 = Largest Floating Decimal Point value width is 65 

F65.d = Largest Fixed Decimal Point value width is 65 

E65.d = Largest Exponential value width is 65 

A = Largest ASCII character width is 2. (The least significant 16 bits are used in this 
order: high byte, low byte). When using both characters, ensure the PanelMate unit’s 
default format can read numbers that use the high byte. An alternate word reference 
format may be necessary, i.e., #U16. 

d = decimal places 

For examples using the General Format Expression, refer to the General Format Expression 
Examples topic. 
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General Format Examples 

If the message is: 

“Current tank level is $I3([123]) gallons.” and the value in register 123 is 567, the online message 
will be: 

“Current tank level is 567 gallons.” 

If the message is: 

“Production rate per press is $D5([456]/17) units per hr.” and the value in register 456 is 7890, the 
online message will be: 

“Production rate per press is 464.1 units per hr.” 

If the message is: 

“Part name in line 1 is $A([200#U16]).” and the value in register 200 is 16693, the online 
message will be: 

“Part name in line 1 is A5” 

Note that with the #U16 format, the PanelMate unit can read and display the ASCII equivalent of 
16693. 
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Decimal-Based Formats 
The decimal-based format types are: 

1. Integer 

2. Floating decimal point real value 

3. Fixed decimal point real value 

4. Exponential 

All the decimal-based numeric formats are right-justified and padded with leading blanks if necessary. 

If a value for a decimal format has too many digits for the specified format size, a string of *s (****) is 
displayed for the value. 

Decimal Place Formats 
For the fixed decimal point format (F), the number for the total width of the formatted value (w) must 
be at least one greater than the number of decimal places (d). If negative values will be displayed, “w” 
must be at least two greater than “d”. 

For the exponential format (E), the total width of the formatted value (w) must be at least eight greater 
than the number of decimal places (d). 

Binary-Based Formats 
The binary-based format types are: 

1. Hexadecimal 

2. Octal 

3. Binary 

For binary-based formats, digits are inserted for the entire width of the format size; there is no blank 
padding. If a value for a binary format has too many digits for the specified format size, the most 
significant digits of the value are truncated until the number will fit in the size specified. 

Example: 

value = 300 

Presentation with H4 format: 012C 

Presentation with H2 format: 2C 

 



 Chapter 8: Message Library 137 

Formatting Examples 

The following table shows examples of the different formatting types. The data type, actual data, and 
visual appearance are shown. The heading on the column for visual appearance marks 13 column 
locations to help reference the placement of characters. 

 
  Columns 
Type Data 0 1 2 3 4 5 6 7 8 9 0 1 2 
I5 324   3 2 4         
I4 521  5 2 1          
I2 -8.73 - 9            
I3 7321 * * *           
I4 824.67  8 2 5          
D7 421.45 4 2 1 . 4 5 0       
D4 23.45 2 3 . 5          
H3 255 0 F F           
H5 -255 F F F 0 1         
H2 300 2 C            
O4 54 0 0 6 6          
O3 88.45 1 3 0           
O1 21 5             
B9 100 0 0 1 1 0 0 1 0 0     
B4 86 0 1 1 0          
F5.1 523.46 5 2 3 . 5         
F10.4 253.21   2 5 3 . 2 1 0 0    
F5.2 326.23 * * * * *         
F8.3 -43.888 - 4 3 . 8 8 8       
F5.0 397.52 3 9 8           
E12.3 -324.1 - 3 . 2 4 1 E + 0 2    
E13.2 0.06734 6 . 7 3 E - 0 2      
E9.0 156.2 2 E + 0 2         
D4 999.89 1 0 0 0          
D6 6245.21 6 2 4 5 . 2        
D1 0.04 0             
D1 9.12 9             
D4 82345.2 * * * *          
D3 -1.444 - 1            
F7.3 619.52 6 1 9 . 5 2 0       
F7.2 619.52 6 1 9 . 5 2        
F6.2 619.52 6 1 9 . 5 2        
F5.3 619.52 - - - - -         
F5.1 619.52 6 1 9 . 5         
D7 619.52 6 1 9 . 5 2 0       
D6 619.52 6 1 9 . 5 2        
D5 619.52 6 1 9 . 5         
D4 619.52 6 2 0           
D3 619.52 6 2 0           
E12.4 619.52 6 . 1 9 5 2 E + 0 2    
E12.3 619.52 6 . 1 9 5 E + 0 2     
A 16693 A 5            
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Clock and Calendar References within Messages 
Time and date information from the PanelMate unit’s internal clock can be included in messages sent 
to the screen and/or printer. The Clock and Calendar Access formats are as follows: 

$(mon) month 
$(day) day 
$(year) year 
$(hour) hour (24 hour time format) 
$(min) minutes 
$(sec) seconds 
$(time) hour:minute:second 
$(date) month/day/year 
$(clk) hour:minute:second month/day/year 

Note the following items: 

• Parameter names are not case sensitive. 

• This information is updated when the page is displayed, but is not updated dynamically. 
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System Online Labels 

9 

In this chapter, you will learn: 

• About the System Online Labels 
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System Online Labels 
When System Online Labels is selected from the Database Treeview Window, the System Online 
Labels dialog box will appear. 

  
The System Online Labels dialog box is used to change the labeling for most of the PanelMate unit 
screens. 

The fields in the System Online Labels dialog box are described below. 

Online Options 
Startup Labels: Allows you to select the Standard or User labels to display at startup. If you 
select Standard, the PanelMate unit will display the default label set. If you select User, the 
PanelMate unit will display the labels you create in the System Online Labels dialog box. 

Allow Label Set Switching: Allows you to switch between the two label sets during online 
operation if this field is checked. If this field is not checked, only the labels selected in the Startup 
Labels field will be displayed. 

Preview: Previews the online label you are working on. 
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Label Category To Edit: Allows you to select the label category you wish to edit. When you select a 
label category, the user-defined labels will appear in the User Online Label field and the standard 
labels will appear in the Standard Online Label field. 

The following list shows the label categories that may be edited: 

• Miscellaneous Soft Key Prompts 

• Maintenance Template Soft Key Prompts 

• User Entry Soft Key Prompts 

• Setup Page 

• Error Messages 

• Miscellaneous Text 

• Display System/Configuration Info 

• Alarm Text 

• Contrast Adjustment Soft Key Prompts 

• Touchscreen Button Templates 

• Touchscreen Keypad Entry Labels 

• Touchscreen Control Keys 
User Online Label: Displays user-defined labels for the label category selected in the Label Category 
to Edit field. If you select a label in this list, the label will display in the Label field where it can be 
edited. 

Standard Online Label: Displays default standard labels for the label category selected in the Label 
Category to Edit field. Most labels that appear in the Standard Online Labels scroll box cannot be 
edited. 

For safety purposes when creating online labels in another language, the Change Online Labels label 
in the Miscellaneous Soft Key Prompts category will remain in English when User Online Labels are 
displayed. The user-defined label for Change Online Labels will only be shown when the Standard 
Online Labels are displayed. 

Label: Allows you to edit the label selected in the User Online Label scroll box. Any labels the are 
edited in the Label field will be reflected in the Preview box and in the User Online Label scroll box. 

Font: Allows you to select a font for the label you are editing. The choices are Normal, Graphic, 
Double High, and Quad font. 

In order to select the Double High or Quad font, the Redefine Double High Font field or the Redefine 
Quad Font field must be selected in the System Parameters - General Tab dialog box. Once one or 
both fields are selected, the characters must be redefined in the Font Editor before the characters will 
appear in the Preview field in the System Online Labels dialog box. 
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System Online Labels – Miscellaneous Soft Key Prompts 
When Miscellaneous Soft Key Prompts is selected in the Label Category to Edit field, the following 
dialog box will appear. 

 
The following set of online labels can be edited in the System Online Labels dialog box when 
Miscellaneous Soft Key Prompts is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 
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Standard Online Labels 

• Change Online Labels 

• View or Acknowledge Alarms 

• Get Page 

• Directory 

• Scroll Up 

• Scroll Down 

• Acknowledge Selected Alarm 

• Acknowledge All Alarms 

• Get Alarm Page 

• Host Display Window 

• Silence Alarm Horn 

• Enable Fault Relay (PanelMate PC and all PanelMate Power Series models excluding 
PanelMate Power Series 1500 and PanelMate Pro LT 1100) 

• Reset PLC Com (PanelMate Power Series 1500 and PanelMate Pro LT 1100) 

• Change Value 

• Clear 

• Home 

• Select Table Entry 

• Return and Select 

• More Buttons 

• Setup Page 

• Execute 

• Set Date 

• Set Time 

• Yes 

• No 
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System Online Labels – Maintenance Template Soft Key Prompts 
When Maintenance Template Soft Key Prompts is selected in the Label Category to Edit field, the 
following dialog box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when 
Maintenance Template Soft Key Prompts is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Maintenance Template 

• Activate 

• Deactivate 
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System Online Labels – User Entry Soft Key Prompts 
When User Entry Soft Key Prompts is selected in the Label Category to Edit field, the following 
dialog box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when User 
Entry Soft Key Prompts is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Enter Password A: 

• Enter Password B: 

• Enter Passw. A/B: 

• Enter Old Password A: 

• Enter Old Password B: 

• Enter New Password A: 

• Enter New Password B: 

• Reenter New Password: 

• Enter Date (MM-DD-YY): 

• Enter Time (HH-MM-SS): 

• Enter New Value: 
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System Online Labels – Setup Page 
When Setup Page is selected in the Label Category to Edit field, the following dialog box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when Setup 
Page is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Change Password A 

• Change Password B 

• Log-in Password A 

• Log-in Password B 

• Log-out Password A 

• Log-out Password B 

• Set Date and Time 

• Enter Offline Mode 

• Display System/Config. Information 

• Switch to Two Column Keypad 

• Switch to Three Column Keypad 
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System Online Labels – Error Messages 
When Error Messages is selected in the Label Category to Edit field, the following dialog box will 
appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when Error 
Messages is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Hardware Selection Disabled. Change Selection. 

• Invalid Entry. Press Any Key to Continue. 

• Invalid Entry. Reenter the Password. 

• Invalid Entry. Improper Confirmation. Reenter the Password. 
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System Online Labels – Miscellaneous Text 
When Miscellaneous Text is selected in the Label Category to Edit field, the following dialog box will 
appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when 
Miscellaneous Text is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Directory of Page Titles 

• Press Directory for Additional Pages 

• ALARM PAGE 

• HOST DISPLAY WINDOW 

• SETUP PAGE 

• PAGE 

• <NO CONTROL> 

• Current Date: 

• Press Page Number Below 

• Remote Mode Change Requested OK to Proceed? 
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System Online Labels – Display System/Configuration Info. 
When Display System/Configuration Info. is selected in the Label Category to Edit field, the following 
dialog box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when 
Display System/Configuration Info. is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• USER CONFIGURATION 

• EXECUTIVE FIRMWARE 

• INSTALLED DRIVERS 

• Name: 

• Version: 

• Date/Time: 

• Free Bytes: 

• Used Bytes: 

• Options: 

• Company/ID: 

• Model: 

• Product: 

• Network: 
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System Online Labels – Alarm Text 
When Alarm Text is selected in the Label Category to Edit field, the following dialog box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when Alarm 
Text is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Clrd 

• Ackd 

• LOW ALARM 

• HIGH ALARM 
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System Online Labels – Contrast Adjustment Soft Key Prompts 
When Contrast Adjustment Soft Key Prompts is selected in the Label Category to Edit field, the 
following dialog box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when 
Contrast Adjustment Soft Key Prompts is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Adjust Contrast 

• Invert 

• Lighter 

• Darker 

• Save Setting 
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System Online Labels – Touchscreen Button Templates 
When Touchscreen Button Templates is selected in the Label Category to Edit field, the following 
dialog box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when 
Touchscreen Button Templates is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Cleaning Mode 

• Calibrate Touchscreen 
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System Online Labels – Touchscreen Keypad Entry Labels 
When Touchscreen Keypad Entry Labels is selected in the Label Category to Edit field, the following 
dialog box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when 
Maintenance Template Soft Key Prompts is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 

Standard Online Labels 

• Enter New Reference: 

• Enter New PLC Name: 
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System Online Labels – Touchscreen Control Keys 
When Touchscreen Control Keys is selected in the Label Category to Edit field, the following dialog 
box will appear. 

  
The following set of online labels can be edited in the System Online Labels dialog box when 
Touchscreen Control Keys is selected in the Label Category to Edit field. 

Tip: When changing online labels, be aware of the spaces before and after the new label. The 
spaces will determine the placement of the label when the PanelMate unit enters Run 
Mode. 
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Standard Online Labels 

• DEL 

• >> 

• << 

• SPACE 

• SEL 

• CLEAR 

• MORE 

• DIR 

• ENTER 

• RSEL 

• ALARM 

• ACCPT 

• PREV 

• NEXT 

• RETRN 
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Templates 
 

10 

In this chapter, you will learn: 

• About the Indicator Template 

• About the Readout Template 

• About the Bar Template 

• About the Table Template 

• About the Bar Trend Template 

• About the Line Trend Template 

• About the Display Template 
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Indicator Template 
Indicator Templates are designed to be used as the lights and buttons of a control panel and are used to 
indicate the status of devices and to control them, e.g., by turning them on or off. 

  
The Indicator Template consists of three tabbed dialog boxes that are listed below. 

• Indicator Template - Indicator Attributes Tab 

• Indicator Template - Indicator States Tab 

• Indicator Template - Control Definitions Tab 
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Indicator Template – Indicator Attributes Tab 
The Indicator Template - Indicator Attributes Tab dialog box is shown below. 

  
The fields in the Indicator Template - Indicator Attributes Tab dialog box are described below. 

Device Name: Allows you to enter a device name. The device name will display in the upper area of 
the template in the normal font. You may press the Return key to insert a carriage return.  

The Device Name field has an auto centering capability. If you wish to center the Device Name, check 
the Device Names box in the Auto Centering field in the Configuration Properties dialog box. 

Note that the name used in the Device Name field may be part of an alarm message. Be aware that 
only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. 
The Device Name field allows you to enter more than 22 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 

Template Size In Cells 
Height: Displays the height of the Indicator Template as 1. This value cannot be changed. 

Width: Allows you to enter the width of the Indicator Template as 1 or 2. 
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Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the template to be refreshed to properly reflect the layering of 
objects on the page whenever the template is updated. 

Indicator Label Font: Defines the font used in the status (lower) area of the template. You can select 
Normal, Double-High, or Quad font. For maximum readability, choose the largest size that fits in the 
template. 

Enable Conditional Visibility: Allows you to determine if the template will appear on a page based 
on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the 
template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Indicator Template – Indicator States Tab 
The Indicator Template - Indicator States Tab dialog box is shown below. 

  
The fields in the Indicator Template - Indicator States Tab dialog box are described below. 

Indicator Label/Conditional Expression/Alm/Ack: Displays five lines that define various states of 
the device. This includes indicator label text, conditional expressions, alarm status, and 
acknowledgment status 

Conditional Expression: Allows you to enter a conditional expression. The conditional expression 
can be a numerical, logical or relational expression that evaluates to true or false. When a numerical 
expression is evaluated if the result is even (least significant bit = 0), the value is false, and if the result 
is odd (least significant bit = 1), the value is true.  

In Run Mode, if an expression is satisfied (true or false), the characteristics defined for that line are 
used to display the template. If more than one expression is satisfied at the same time, the line with the 
highest priority displays. Line 1 has the highest priority and line 5 has the lowest. 

When an expression results in an invalid equation (e.g., division by zero, etc.), no value or graphics 
are If a true expression goes false in a later scan, the display for the true expression is erased. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refer to the appropriate Communication Driver Manual for information regarding the format for 
specific PLC word references. 

Refer to the list of Conditional Expression Operators for more information. 

Indicator Label: Allows you to enter a label for the Indicator Template. This field accepts normal-
sized characters entered in the Indicator Label box. The Indicator Template will limit the number of 
characters you can enter depending upon the template size (normal or double-wide) or character size 
(normal, double high, or quad). 

Be sure to view the template on the page to ensure the desired appearance. 

The Indicator Label field has an auto centering capability. If you wish to center the Indicator Label, 
check the Indicator Labels box in the Auto Centering field in the Configuration Properties dialog 
box. 
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FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

Alarm 
Alarm: Allows you to designate any line of the template definition as an alarm state. If the Alarm 
box is selected and the conditional expression evaluates to be true, an alarm message will be 
placed in the alarm list and sent to the printer if one is configured. 

If the Alarm box is selected, the condition associated with the alarm will be monitored at all times, 
regardless of the page being displayed. Judicious use of the alarm state is recommended to 
maximize the response time of the PanelMate unit. 

Acknowledge: Allows you to determine if the associated alarm must be acknowledged before the 
alarm is removed from the alarm list. 

If the Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Acknowledge box is not 
selected, the alarm message will be automatically removed from the list when the alarm condition 
clears.  

Note that a cleared alarm message will be sent to the printer if one is configured. 
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Indicator Template – Control Definitions Tab 
The Indicator Template - Control Definitions Tab dialog box is shown below. 

  
The fields in the Indicator Template - Control Definitions Tab dialog box are described below. 

Control Label/PLC Bit Reference: Displays the control labels and PLC bit references and allows 
you to define the control buttons on the right side of the PanelMate unit. Line 1 corresponds to the top 
control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all 
control buttons. Simply leave a line blank if you do not want a control button at a particular location. 

If a control button is defined, a small arrow will be displayed in the lower left corner of a template to 
indicate to the operator that a control function is available. 

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the 
referenced bit (e.g., 120 00) to 1. When the button is released, a separate command is sent to set the bit 
to a 0 (zero), thus providing a momentary input to the PLC. If a maintained input is desired, the bit 
may be latched in PLC logic. 

Control Label: Allows you to enter a label for a control button. This field accepts three lines of 
normal-sized alphanumeric characters. The text does not automatically wrap. Press the Return key to 
insert a carriage return. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

PLC Bit Reference: Allows you to enter a PLC bit reference for the control button. This field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. You cannot use expressions or conditional logic. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Readout Template 
Readout Templates are designed to be used as numerical readout devices on a control panel and are 
used to display a digital value. The PanelMate unit also provides two ways for the operator to change a 
PLC value. 

  
The Readout Template consists of three tabbed dialog boxes that are listed below. 

• Readout Template - Readout Attributes Tab 

• Readout Template - Expressions Tab 

• Readout Template - Control Definitions Tab 
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Readout Template – Readout Attributes Tab 
he Readout Template - Readout Attributes Tab dialog box is shown below. T

  

The fields in the Readout Template - Readout Attributes Tab dialog box are described below. 

Device Name: Allows you to enter a device name. The device name will display in the upper area of 
the template in the normal font. You may press the Return key to insert a carriage return.  

The Device Name field has an auto centering capability. If you wish to center the Device Name, check 
the Device Names box in the Auto Centering field in the Configuration Properties dialog box. 

Note that the name used in the Device Name field may be part of an alarm message. Be aware that 
only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. 
The Device Name field allows you to enter more than 22 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 

Template Size In Cells 
Height: Displays the height of the Readout Template as 1. This value cannot be changed. 

Width: Allows you to enter the width of the Readout Template as 1 or 2. 

Value 1 Font: Allows you to select the font for the characters used in the status (lower) area of the 
Readout Template. The selections are Normal, Double-High, or Quad. For maximum readability, 
choose the largest size that fits in the template. 

Note that redefining the Double-High or Quad fonts limits your character size choices. 

The maximum number of digits for a Readout Template is based upon the combination of template 
size and character size. 

• A 1-wide template with normal characters can display 9 digits. 

• A 1-wide template with quad characters can display 6 digits. 

• A 1-wide template with double high characters can display 9 digits. 

• A 2-wide template with normal characters can display 18 digits. 

• A 2-wide template with quad characters can display 12 digits. 

• A 2-wide template with double high characters can display 18 digits. 
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Units: Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” 
or “gals”. The Units field accepts alphanumeric characters. This field is not displayed on a single-
width template when Value 2 is displayed. 

Decimal Places: Allows you to determine how the number will be formatted when displayed. This 
field accepts the numbers 0 through 9. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the template to be refreshed to properly reflect the layering of 
objects on the page whenever the template is updated. 

Enable Conditional Visibility: Allows you to determine if the Readout Template will appear on a 
page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not 
checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Readout Template – Expressions Tab 
The Readout Template - Expressions Tab dialog box is shown below. 

  

The fields in the Readout Template - Expressions Tab dialog box are described below. 

Value 1: Allows you to enter a value expression. The result of this expression will be the value 
displayed in the Readout Template. 

When viewing the Readout Template, Value 1 will be in the center of the template. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

The following examples of expressions use a generic format. Refer to the appropriate Communication 
Driver Manual for information regarding the format for specific PLC word references. 

[123] 
The expression can be a single word reference. This example references word 123. 

([123]*10)+[124] 
This mathematical expression includes PLC references and constants that solve to a value. 

[name1,242]+[name2,243] 
Information from multiple PLCs can be included in the same expression. In this expression, word 
242 in PLC name1 is added to word 243 in PLC name2. 

Refer to the list of Conditional Expression Operators for more information. 

Value 2: Allows you to enter a value expression. The result of this expression will be the value 
displayed in the Readout Template. 

When viewing the Readout Template, Value 2 will be at the bottom of the template. It is most often 
used as the setpoint for the device. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refer to the list of Conditional Expression Operators for more information. 
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High Alarm: Allows you to enter a High Alarm Expression. The results of the High Alarm 
Expression are compared to the results of the Value 1 Expression. If Value 1 exceeds the High Alarm 
Expression value, an alarm message is placed in the alarm list. When in an alarm state, the template 
will be displayed as follows: 

• For PanelMate Grayscale units, the template will be displayed with medium intensity 
characters on a blinking high intensity background. 

• For PanelMate Color units, the template will be displayed with white characters on a blinking 
red background. 

The High Alarm Expression can include multiple PLC word and bit references. Mathematical and 
Boolean expressions may be used including multiplication, division, addition, and subtraction. You 
may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change 
the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

This is an optional entry. If no alarm is desired for this device, leave this field blank. 

Refer to the list of Conditional Expression Operators for more information. 

Low Alarm: Allows you to enter a Low Alarm Expression. The results of the Low Alarm Expression 
are compared to the results of the Value 1 Expression. If Value 1 is less than the Low Alarm 
Expression value, an alarm message is placed in the alarm list. When in an alarm state, the template 
will be displayed as follows: 

• For PanelMate Grayscale units, the template will be displayed with medium intensity 
characters on a blinking high intensity background. 

• For PanelMate Color units, the template will be displayed with white characters on a blinking 
red background. 

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical and 
Boolean expressions may be used including multiplication, division, addition, and subtraction. You 
may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change 
the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

This is an optional entry. If no alarm is desired for this device, leave this field blank. 

Refer to the list of Conditional Expression Operators for more information. 

Deadband Range: Allows you to enter a number between 0-99 that will represent the percentage of 
the high alarm value minus the low alarm value that defines the width of the deadband. 

The deadband range is an area below the high alarm value and above the low alarm value, that must be 
crossed before Value is considered to have returned to normal status (go out of alarm). The deadband 
range prevents multiple alarm messages from being generated when Value is hovering around an 
alarm threshold. 
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Alarm Acknowledge: Allows you to determine if the associated alarm must be acknowledged before 
the alarm is removed from the alarm list. 

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not 
selected, the alarm message will be automatically removed from the list when the alarm condition 
clears.  

Note that a cleared alarm message will be sent to the printer if one is configured. 
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Readout Template – Control Definitions Tab 
The Readout Template - Control Definitions Tab dialog box is shown below. 

  
The fields in the Readout Template - Control Definitions Tab dialog box are described below. 

Control Type: Allows you to define the control type used for the template. The selections are 
described below. 

None: Allows the template to show a value that the operator cannot control. 

Buttons: Requires the operator to use control buttons to change a setpoint value. If you choose 
Buttons, the dialog box will change. Refer to the Readout Template - Control Definitions Tab 
with Button Control topic for more information. 

Numeric: Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box 
will change. Refer to the Readout Template - Control Definitions Tab with Numeric Control 
topic for more information. 

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the 
template to indicate to the operator that a control function is available. 
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Readout Template – Control Definitions Tab with Button Control 
The Readout Template - Control Definitions Tab dialog box with button control is shown below. 

  

The Readout Template - Control Definitions Tab dialog box with button control defines the control 
buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower 
left corner of the template to indicate to the operator that a control function is available.When a control 
button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 
00]) to 1. When the button is released, a separate command is sent to set the bit to 0, thus providing a 
momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic. 

The fields in the Readout Template - Control Definitions Tab dialog box are described below. 

Control Label/PLC Bit Reference: Displays the control button labels and the associated PLC Bit 
Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button 
down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a 
control button at that location. 

Control Label: Allows you to enter the control button label. The Control Label field accepts three 
lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the 
desired location. Note that on the configuration page, the text displayed in the control button will be 
truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to 
the next line, you can eliminate a carriage return in some cases. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

PLC Bit Reference: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. Expressions or conditional logic cannot be entered. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Readout Template – Control Definitions Tab with Numeric Control 
The Readout Template - Control Definitions Tab dialog box with numeric control is shown below. 

  
The fields in the Readout Template - Control Definitions Tab dialog box with numeric control are 
described below. 

Input Value Expression: Allows you to enter any mathematical expression that must be performed on 
the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is 
used to designate the operator input. The expression entered here may include as many PLC word or 
bit references as needed, as well as mathematical operations. Parentheses may be used to change the 
order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples 
below. 

([?]-32)*5/9 
The operator’s input is changed from Fahrenheit to Celsius. 

[?]*([?]>=0)*([?]<=100)+([?]<0)*[123]+([?]>100)*[123] 
Target Word Address is [123] 
This expression limits entries between 0 and 100 to the PLC register. Any value outside this range 
has no effect on the value in the register. 

Refer to the list of Conditional Expression Operators for more information. 

Target Word Address: Allows you to define the location of the operator’s input in the PLC as the 
result of the Input. 

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address 
[364#S16]. 

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual 
for information regarding the format for specific PLC word references. 

If the template is configured to have numeric control, a target address and input expression must be 
entered. Failure to include this information will result in a Watchdog Time-out error when the template 
is selected online. 

 



172 Configuration Editor User’s Guide 

Password Protection: Allows you to lock out access to numeric entry unless the operator provides the 
correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are 
listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
Password protection must be validated each time the template is selected for numeric entry. 

The template will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 
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Bar Template 
Bar Templates are designed to be used as the analog meters and faceplates on a control panel and are 
used to indicate a value in analog fashion, with a bar graph. The bar graph can show current value, 
setpoint, and high and low alarm levels. The current value and setpoint are also displayed digitally. 
The PanelMate unit also provides two ways for the operator to change a PLC value. 

  
The Bar Template consists of three tabbed dialog boxes that are displayed below. 

• Bar Template - Bar Attributes Tab 

• Bar Template - Expressions Tab 

• Bar Template - Control Definitions Tab 
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Bar Template – Bar Attributes Tab 
The Bar Template - Bar Attributes Tab dialog box is shown below. 

  

The fields in the Bar Template - Bar Attributes Tab dialog box are described below. 

Device Name: Allows you to enter a device name. The device name will display in the upper area of 
the template in the normal font. You may press the Return key to insert a carriage return.  

The Device Name field has an auto centering capability. If you wish to center the Device Name, check 
the Device Names box in the Auto Centering field in the Configuration Properties dialog box. 

Note that the name used in the Device Name field may be part of an alarm message. Be aware that 
only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. 
The Device Name field allows you to enter more than 22 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 

Template Size In Cells 
Height: Allows you to enter the height of the Bar Template as 2 or 3. 

Width: Displays the width of the Bar Template as 1. This value cannot be changed. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the template to be refreshed to properly reflect the layering of 
objects on the page whenever the template is updated. 

Units: Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” 
or “gals”. The Units field accepts alphanumeric characters. 

Enable Conditional Visibility: Allows you to determine if the Bar Template will appear on a page 
based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not 
checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 
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If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Bar Template – Expression Tab 
The Bar Template - Expressions Tab dialog box is shown below. 

  
The fields in the Bar Template - Expressions Tab dialog box are described below. 

Value 1: Allows you to enter a value expression. The result of this expression will be the value 
displayed in the Bar Template. 

When viewing the Bar Template, Value 1 will be displayed as follows: 

• For PanelMate Grayscale units, Value 1 is displayed as a high intensity bar on the template. 

• For PanelMate Color units, Value 1 is displayed as a green bar on the template. 
The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

The following examples of expressions use a generic format. Refer to the appropriate Communication 
Driver Manual for information regarding the format for specific PLC word references. 

[123] 
The expression can be a single word reference. This example references word 123. 

([123]*10)+[124] 
This mathematical expression includes PLC references and constants that solve to a value. 

[name1,242]+[name2,243] 
Information from multiple PLCs can be included in the same expression. In this expression, word 
242 in PLC name1 is added to word 243 in PLC name2. 

Refer to the list of Conditional Expression Operators for more information. 
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Value 2: Allows you to enter a value expression. The result of this expression will be the value 
displayed in the Bar Template. 

When viewing the Bar Template, Value 2 will be displayed as follows: 

• For PanelMate Grayscale units, Value 2 is displayed as a medium intensity horizontal line to 
the right of the Value 1 bar. 

• For PanelMate Color units, Value 2 is displayed as a white horizontal line to the right of the 
Value 1 bar. It is most often used as the setpoint for the device. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refer to the list of Conditional Expression Operators for more information. 

High Alarm: Allows you to enter a High Alarm Expression. The results of the High Alarm 
Expression are compared to the results of the Value 1 Expression. If Value 1 exceeds the High Alarm 
Expression value, an alarm message is placed in the alarm list. When in an alarm state, the bar will be 
displayed as follows: 

• For PanelMate Grayscale units, ALARM! will appear on the template (below the Device 
Name) in medium foreground intensity on blinking high intensity background. A High Alarm 
bar is shown in high intensity to the right of the Value 1 bar. 

• For PanelMate Color units, ALARM! will appear on the template (below the Device Name) 
in white on blinking red. A High Alarm bar is shown in red to the right of the Value 1 bar. 

The High Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also enter 
a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of 
operations. This is an optional entry. If no alarm is desired for this device, leave this field blank. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refer to the list of Conditional Expression Operators for more information. 

Low Alarm: Allows you to enter a Low Alarm Expression. The results of the Low Alarm Expression 
are compared to the results of the Value 1 Expression. If Value 1 is less than the Low Alarm 
Expression value, an alarm message is placed in the alarm list. When in an alarm state, the bar will be 
displayed as follows: 

• For PanelMate Grayscale units, ALARM! will appear on the template (below the Device 
Name) in medium foreground intensity on blinking high intensity background. A Low Alarm 
bar is shown in high intensity to the right of the Value 1 bar. 

• For PanelMate Color units, ALARM! will appear on the template (below the Device Name) 
in white on blinking red. A Low Alarm bar is shown in red to the right of the Value 1 bar. 

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also enter 
a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of 
operations. This is an optional entry. If no alarm is desired for this device, leave this field blank. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Refer to the list of Conditional Expression Operators for more information. 
Max Calibration: Allows you to determine the highest point of the Value 1 bar. This value displays 
on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed 
anywhere in the field. 

On a 3-high Bar Template, the PanelMate unit will use the Maximum and Minimum Calibrations to 
calculate the bar’s midpoint and will place that value on the template. 

Min Calibration: Allows you to determine the lowest point of the Value 1 bar trend. This value 
displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point 
placed anywhere in the field. 

On a 3-high Bar Template, the PanelMate unit will use the Maximum and Minimum Calibrations to 
calculate the bar’s midpoint and will place that value on the template. 

Deadband Range: Allows you to enter a number between 0-99 that will represent the percentage of 
the high alarm value minus the low alarm value that defines the width of the deadband. 

The deadband range is an area below the high alarm value and above the low alarm value, that must be 
crossed before Value is considered to have returned to normal status (go out of alarm). The deadband 
range prevents multiple alarm messages from being generated when Value is hovering around an 
alarm threshold. 

Alarm Acknowledge: Allows you to determine if the associated alarm must be acknowledged before 
the alarm is removed from the alarm list. 

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not 
selected, the alarm message will be automatically removed from the list when the alarm condition 
clears.  

Note that a cleared alarm message will be sent to the printer if one is configured. 
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Bar Template – Control Definitions Tab 
The Bar Template - Control Definitions Tab dialog box is shown below. 

  
The fields in the Bar Template - Control Definitions Tab dialog box are described below. 

Control Type: Allows you to define the control type used for the template. The selections are 
described below. 

None: Allows the template to show a value that the operator cannot control. 

Buttons: Requires the operator to use control buttons to change a setpoint value. If you choose 
Buttons, the dialog box will change. Refer to the Bar Template - Control Definitions Tab with 
Button Control topic for more information. 

Numeric: Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box 
will change. Refer to the Bar Template - Control Definitions Tab with Numeric Control topic 
for more information. 

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the 
template to indicate to the operator that a control function is available. 
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Bar Template – Control Definitions Tab with Button Control 
The Bar Template - Control Definitions Tab dialog box with button control is shown below. 

  

The Bar Template - Control Definitions Tab dialog box with button control defines the control 
buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower 
left corner of the template to indicate to the operator that a control function is available. 

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the 
referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the 
bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be 
latched in PLC logic. 

The fields in the Bar Template - Control Definitions Tab dialog box  are described below. 

Control Label/PLC Bit Reference: Displays the control button labels and the associated PLC Bit 
Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button 
down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a 
control button at that location. 

Control Label: Allows you to enter the control button label. The Control Label field accepts three 
lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the 
desired location. Note that on the configuration page, the text displayed in the control button will be 
truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to 
the next line, you can eliminate a carriage return in some cases. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

PLC Bit Reference: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. Expressions or conditional logic cannot be entered. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Bar Template – Control Definitions Tab with Numeric Control 
The Bar Template - Control Definitions Tab dialog box with numeric control is shown below. 

  

The fields in the Bar Template - Control Definitions Tab dialog box with numeric control are 
described below. 

Input Value Expression: Allows you to enter any mathematical expression that must be performed on 
the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is 
used to designate the operator input. The expression entered here may include as many PLC word or 
bit references as needed, as well as mathematical operations. Parentheses may be used to change the 
order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples 
below. 

([?]-32)*5/9 
The operator’s input is changed from Fahrenheit to Celsius. 

[?]*([?]>=0)*([?]<=100)+([?]<0)*[123]+([?]>100)*[123] 
Target Word Address is [123] 
This expression limits entries between 0 and 100 to the PLC register. Any value outside this range 
has no effect on the value in the register. 

Refer to the list of Conditional Expression Operators for more information. 

Target Word Address: Allows you to define the location of the operator’s input in the PLC as the 
result of the Input. 

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address 
[364#S16]. 

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual 
for information regarding the format for specific PLC word references. 

If the template is configured to have numeric control, a target address and input expression must be 
entered. Failure to include this information will result in a Watchdog Time-out error when the template 
is selected online. 
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Password Protection: Allows you to lock out access to numeric entry unless the operator provides the 
correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are 
listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
Password protection must be validated each time the template is selected for numeric entry. 

The template will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 
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Table Template 
Table Templates are designed to display a table of values and accept numeric entry for all the items in 
the table. Table Templates can be used for machine setup, recipe entry, or for any application requiring 
a high-density display and entry of information. 

  
Table Templates can support up to 50 independent entries. Each entry has a tag name, current value, 
edit value, and a units field. The Table Template has built-in scroll capabilities to allow you to select 
the desired entry field. A scroll indicator at left side of the template indicates top and bottom with stop 
bars. The presence of more items is identified by up or down arrows. The control buttons on the right 
of the screen permit up/down scrolling, return to home or open a selected field for numeric entry. 

The control indicator at the bottom left of the template indicates control is available for a particular 
entry. You can configure each entry for numeric entry or for display only. 

The Table Template consists of two tabbed dialog boxes that are listed below. 

• Table Template - Table Attributes Tab 

• Table Template - Table Entries Tab 
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Table Template – Table Attributes Tab 
The Table Template - Table Attributes Tab dialog box is shown below. 

  

The fields in the Table Template - Table Attributes Tab dialog box are described below. 

Device Name: Allows you to enter a device name. The device name will display in the upper area of 
the template in the normal font. You may press the Return key to insert a carriage return.  

The Device Name field has an auto centering capability. If you wish to center the Device Name, check 
the Device Names box in the Auto Centering field in the Configuration Properties dialog box. 

Note that the name used in the Device Name field may be part of an alarm message. Be aware that 
only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. 
The Device Name field allows you to enter more than 22 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 

Template Size In Cells 

Height: Allows you to enter the height of the Table Template as 1, 2, or 3. The height of the 
Table Template determines the number of table entries that can be displayed at one time. 

• A 1-high template can display 2 table entries. 

• A 2-high template can display 9 table entries. 

• A 3-high template can display 16 table entries. 
Width: Allows you to enter the width of the Table Template as 2 or 3. 

Parameters Tag: Allows you to enter a title for the Parameters column in the Table Template. The 
Parameters Tag field accepts 12 normal-sized characters in a 2-wide template and accepts 18 normal-
sized characters in a 3-wide template. 

Edit Value Tag: Allows you to enter a title for the Edit Values column in the Table Template. The 
Edit Value field is enabled only when a 3-Wide template is being configured. The field accepts up to 6 
normal-sized characters. These values are the operator’s input. The Edit Value Tag field values remain 
until the Table Template is re-selected or when the page is first displayed. Refer to the Input Value 
Expression field in the Table Template - Table Entries Tab topic for more information. 
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Current Value Tag: Allows you to enter a title for the Current Values column in the Table Template. 
The Current Value Tag field accepts up to 7 normal-sized characters. Refer to the Value Expression 
field in the Table Template - Table Entries Tab topic for more information. 

Units Tag: Allows you to enter a title for the Units column in the Table Template. The Units Tag field 
accepts up to 5 normal-sized characters. 

Password Protection: Allows you to lock out access to numeric entry unless the operator provides the 
correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are 
listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
Password protection must be validated each time the template is selected for numeric entry. 

The template will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the template to be refreshed to properly reflect the layering of 
objects on the page whenever the template is updated. 

Enable Conditional Visibility: Allows you to determine if the Table Template will appear on a page 
based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not 
checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Table Template – Table Entries Tab 
he Table Template - Table Entries Tab dialog box is shown below. T

  

The fields in the Table Template - Table Entries Tab dialog box are described below. 

Parameters/Value Expression/Input Value Expression/Target Word Address: Displays 
parameters, value expression, input value expressions, and target word address configured for the 
Table Template. You can configure up to 50 independent display/entry fields. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Line 1 of the table corresponds to the first item, line 2 corresponds to the second line, etc. It is not 
necessary to use all 50 lines. When the PanelMate unit goes online, the scroll will stop at the last 
completed entry. You may leave blank lines in the table and use lines for display purposes only. 

Parameters: Allows you to enter the descriptor for each individual table entry. 

The Parameter field information is saved to disk only if there is a number in the Value Expression 
Column. To save parameter text for test purposes, enter a Value Expression of 1. 

Decimal Places: Allows you to determine how the number will be formatted when displayed in the 
Current Value field and the Edit Value field. This field accepts the numbers 0 through 5. 

Value Expression: Allows you to enter a value expression. The result of this expression will be the 
value displayed in the Table Template. This expression is any mathematical operation to be performed 
on the monitored value before it is displayed on the screen. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 
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The following examples of expressions use a generic format. Refer to the appropriate Communication 
Driver Manual for information regarding the format for specific PLC word references. 

[123] 
The expression can be a single word reference. This example references word 123. 

([123]*10)+[124] 
This mathematical expression includes PLC references and constants that solve to a value. 

[name1,242]+[name2,243] 
Information from multiple PLCs can be included in the same expression. In this expression, word 
242 in PLC name1 is added to word 243 in PLC name2. 

Refer to the list of Conditional Expression Operators for more information. 

Input Value Expression: Allows you to enter any mathematical expression that must be performed on 
the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is 
used to designate the operator input. The expression entered here may include as many PLC word or 
bit references as needed, as well as mathematical operations. Parentheses may be used to change the 
order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples 
below. 

([?]-32)*5/9 
The operator’s input is changed from Fahrenheit to Celsius. 

[?]*([?]>=0)*([?]<=100)+([?]<0)*[123]+([?]>100)*[123] 
Target Word Address is [123] 
This expression limits entries between 0 and 100 to the PLC register. Any value outside this range 
has no effect on the value in the register. 

Refer to the list of Conditional Expression Operators for more information. 

If an expression is defined for an individual entry, a small arrow will be displayed in the lower left 
corner of the template to indicate that numeric entry is available while the template is selected. 

Target Word Address: Allows you to define the location of the operator’s input in the PLC as the 
result of the Input. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address 
[364#S16]. 

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual 
for information regarding the format for specific PLC word references. 

If the template is configured to have numeric control, a target address and input expression must be 
entered. Failure to include this information will result in a Watchdog Time-out error when the template 
is selected online. 

Units: Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” 
or “gals”. The Units field accepts alphanumeric characters. 
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Bar Trend Template 
Bar Trend Templates are designed to collect, store, and represent data in a manner that provides a 
historical perspective on how a single data point has changed and that provides some insight on how 
the data point may behave in the future. 

The Bar Trend Template shows current value, setpoint, and high and low alarm levels. The current 
value and setpoint display digitally. 

  
The Bar Trend Template consists of three tabbed dialog boxes that are listed below. 

• Bar Trend Templates - Bar Trend Attributes Tab 

• Bar Trend Templates - Expressions Tab 

• Bar Trend Templates - Control Definitions Tab 
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Bar Trend Template – Bar Trend Attributes Tab 
he Bar Trend Template - Bar Trend Attributes Tab dialog box is shown below. T

  

The fields in the Bar Trend Template - Bar Trend Attributes Tab dialog box are described below. 

Device Name: Allows you to enter a device name. The device name will display in the upper area of 
the template in the normal font. You may press the Return key to insert a carriage return.  

The Device Name field has an auto centering capability. If you wish to center the Device Name, check 
the Device Names box in the Auto Centering field in the Configuration Properties dialog box. 

Note that the name used in the Device Name field may be part of an alarm message. Be aware that 
only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. 
The Device Name field allows you to enter more than 22 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 
Template Size In Cells 

Height: Allows you to enter the height of the Bar Trend Template as 1, 2, or 3. 

Width: Allows you to enter the width of the Bar Trend Template as 2 or 3. The width of the Bar 
Trend Template determines the number of trend samples that can be displayed at one time. 

• A 2-wide template can display 16 trend samples. 

• A 3-wide template can display 29 trend samples. 
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Trigger Type: Allows you to select the trigger type for the trending. The selections are described 
below. 

Interval: Allows you to sample a trend value when a time period has elapsed. The Interval in 
conjunction with the Trend Scan Delay designates the time interval between trend samples. (The 
Trend Scan Delay is configured in the System Parameters - Communications Tab dialog box.) 

The following equation is used to calculate the time interval between trend samples: 

Trend Scan Delay x Interval = Sample Rate 

For example, if the Trend Scan Delay is 2 seconds and the Interval is 3, the sample rate will be 6 
seconds. 

If the Interval trigger type is selected, the Interval Expression field will be displayed. 

Discrete: Allows you to sample a trend value when an external value (e.g., a bit reference in the 
PLC) changes resulting in the Interval Expression value changing from false to true. If the 
Discrete trigger type is selected, the Discrete Expression field will be displayed. 

Change: Allows you to sample a trend value when the Value 1 Expression (trend value) changes. 
If the Change trigger type is selected, the Interval Expression field and the Discrete Expression 
field will not be displayed. 

If the Bar Trend Template has the Change trigger type configured and the source data is floating 
point instead of integer, the data in the template will only update when the value prior to the 
decimal point changes. When trending floating point values, it is better to use either the Interval or 
Discrete trigger types. 

Interval Expression: Appears only when the Interval trigger type is selected. The Interval Expression 
field allows you to enter an expression that will determine the trend value sample rate. The result of 
the Interval Expression multiplied by the Trend Scan Delay (set in the System Parameters - Remote 
Tab dialog box) determines the trend value sample rate. The sample rate can range from 1 to 
2,147,483 seconds. 

For example, if the Trend Scan Delay is configured for 2 seconds and the Interval Expression 
evaluates to 5, the trend will be updated every 10 seconds. If the resulting sample rate is 0, the data 
collection for the trend template will be disabled. If the Trend Scan Delay is 0, it is assumed as 1 
second when calculating the sample rate. 

Note that if an interval is selected that is too rapid for the PanelMate unit or PLC to keep up with the 
request, a blank bar will appear where any interval has been missed. Low sample values might also 
cause a blank bar to appear. To distinguish as low sample value from a missed interval, configure the 
minimum calibration lower than the lowest expected minimum value. 

• For PanelMate Grayscale units, Interval is the value that displays as a medium intensity 
horizontal bar to the right of the Value 1 bar. 

• For PanelMate Color units, Interval is the value that displays as a blue horizontal bar to the 
right of the Value 1 bar. 

Mathematical operations that may be used are multiplication, division, addition, and subtraction. You 
may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change 
the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refer to the list of Conditional Expression Operators for more information. 
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Discrete Expression: Appears only when the Discrete trigger type is selected.  The Discrete 
Expression field allows you to enter an expression so that a trend will be sampled when the result of 
the expression changes from false to true. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the template to be refreshed to properly reflect the layering of 
objects on the page whenever the template is updated. 

Units: Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” 
or “gals”. The Units field accepts alphanumeric characters. 

Enable Conditional Visibility: Allows you to determine if the Bar Trend Template will appear on a 
page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not 
checked, the template will always appear on the page. 
It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Bar Trend Template – Expressions Tab 
The Bar Trend Template - Expressions Tab dialog box is shown below. 
  

The fields in the Bar Trend Template - Expressions Tab dialog box are described below. 

Value 1: Allows you to enter a value expression. The result of this expression will be the value 
displayed in the Bar Trend Template. 

When viewing the Bar Trend Template, Value 1 will be displayed as follows: 

• For PanelMate Grayscale units, Value 1 is displayed as a no intensity horizontal bar in the 
center of the template. 

• For PanelMate Color units, Value 1 is displayed as a green horizontal bar in the lower center 
of the template. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

The following examples of expressions use a generic format. Refer to the appropriate Communication 
Driver Manual for information regarding the format for specific PLC word references. 

[123] 
The expression can be a single word reference. This example references word 123. 

([123]*10)+[124] 
This mathematical expression includes PLC references and constants that solve to a value. 

[name1,242]+[name2,243] 
Information from multiple PLCs can be included in the same expression. In this expression, word 
242 in PLC name1 is added to word 243 in PLC name2. 

Refer to the list of Conditional Expression Operators for more information. 

Note that Bar Trend Templates will not update if all references in these templates are unsolicited. If at 
least one reference in a Bar Trend Template is not unsolicited, then all references will update. 
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When floating point references are used, be certain the maximum possible value will not exceed the 
PanelMate unit’s unsigned 32-bit word limit (4,294,967,295). A value exceeding the limit will cause a 
Watchdog Time-out error or generate an Exception error during online or runtime operation. You may 
wish to consider using scaled integer values instead of floating point values. 

Value 2: Allows you to enter a value expression. The result of this expression will be the value 
displayed in the Bar Trend Template. 

When viewing the Bar Trend Template, Value 2 will be displayed as follows: 

• For PanelMate Grayscale units, Value 2 is displayed as a high intensity bar to the left of the 
Value 1 bar. 

• For PanelMate Color units, Value 2 is displayed as a white horizontal bar to the left of the 
Value 1 bar. It is most often used as the setpoint for the device. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refer to the list of Conditional Expression Operators for more information. 
Note that Bar Trend Templates will not update if all references in these templates are unsolicited. If at 
least one reference in a Bar Trend Template is not unsolicited, then all references will update. 

When floating point references are used, be certain the maximum possible value will not exceed the 
PanelMate unit’s unsigned 32-bit word limit (4,294,967,295). A value exceeding the limit will cause a 
Watchdog Time-out error or generate an Exception error during online or runtime operation. You may 
wish to consider using scaled integer values instead of floating point values. 

High Alarm: Allows you to enter a High Alarm Expression. The results of the High Alarm 
Expression are compared to the results of the Value 1 Expression. If Value 1 exceeds the High Alarm 
Expression value, an alarm message is placed in the alarm list. When in an alarm state, the trend 
sample will be displayed as follows: 

• For PanelMate Grayscale units, the trend sample is displayed in high intensity. The trend 
sample will continue to be displayed in high intensity as other trend samples are being 
collected as long as Value 1 exceeds the High Alarm Expression value. A High Alarm bar is 
shown in high intensity to the left of the Bar Trend Template. 

• For PanelMate Color units, the trend sample is displayed in red. The trend sample will 
continue to be displayed in red as other trend samples are being collected as long as Value 1 
exceeds the High Alarm Expression value. A High Alarm bar is shown in red to the left of the 
Bar Trend Template. 

The High Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also enter 
a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of 
operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

This is an optional entry. If no alarm is desired for this device, leave this field blank. 

Refer to the list of Conditional Expression Operators for more information. 
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Low Alarm: Allows you to enter a Low Alarm Expression. The results of the Low Alarm Expression 
are compared to the results of the Value 1 Expression. If Value 1 is less than the Low Alarm 
Expression value, an alarm message is placed in the alarm list. When in an alarm state, the trend 
sample will be displayed as follows: 

• For PanelMate Grayscale units, the variable-sized template is displayed in high intensity. The 
trend sample will continue to be displayed in high intensity as other trend samples are being 
collected as long as Value 1 is less than the Low Alarm Expression value. A Low Alarm bar 
is shown in high intensity to the left of the Bar Trend Template. 

• For PanelMate Color units, the variable-sized template is displayed in red. The trend sample 
will continue to be displayed in red as other trend samples are being collected as long as 
Value 1 is less than the Low Alarm Expression value. A Low Alarm bar is shown in red to 
the left of the Bar Trend Template. 

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also enter 
a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of 
operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

This is an optional entry. If no alarm is desired for this device, leave this field blank. 

Refer to the list of Conditional Expression Operators for more information. 

Max Calibration: Allows you to determine the highest point of the line trend. This value displays on 
the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed 
anywhere in the field. 

Min Calibration: Allows you to determine the lowest point of the line trend. This value displays on 
the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed 
anywhere in the field. 

Deadband Range: Allows you to enter a number between 0-99 that will represent the percentage of 
the high alarm value minus the low alarm value that defines the width of the deadband. 

The deadband range is an area below the high alarm value and above the low alarm value, that must be 
crossed before Value is considered to have returned to normal status (go out of alarm). The deadband 
range prevents multiple alarm messages from being generated when Value is hovering around an 
alarm threshold. 

Alarm Acknowledge: Allows you to determine if the associated alarm must be acknowledged before 
the alarm is removed from the alarm list. 

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not 
selected, the alarm message will be automatically removed from the list when the alarm condition 
clears.  

Note that a cleared alarm message will be sent to the printer if one is configured. 
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Bar Trend Template – Control Definitions Tab 
The Bar Trend Template - Control Definitions Tab dialog box is shown below. 

  
The fields in the Bar Trend Template - Control Definitions Tab dialog box are described below. 

Control Type: Allows you to define the control type used for the template. The selections are 
described below. 

None: Allows the template to show a value that the operator cannot control. 

Buttons: Requires the operator to use control buttons to change a setpoint value. If you choose 
Buttons, the dialog box will change. Refer to the Bar Trend Template - Control Definitions 
Tab with Button Control topic for more information. 

Numeric: Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box 
will change. Refer to the Bar Trend Template - Control Definitions Tab with Numeric 
Control topic for more information. 

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the 
template to indicate to the operator that a control function is available. 
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Bar Trend Template – Control Definitions Tab with Button Control 
he Bar Trend Template - Control Definitions Tab dialog box with button control is shown below. T

  

The Bar Trend Template - Control Definitions Tab dialog box with button control defines the 
control buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the 
lower left corner of the template to indicate to the operator that a control function is available. 

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the 
referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the 
bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be 
latched in PLC logic. 

The fields in the Bar Trend Template - Control Definitions Tab dialog box with button control are 
described below. 

Control Label/PLC Bit Reference: Displays the control button labels and the associated PLC Bit 
Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button 
down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a 
control button at that location. 

Control Label: Allows you to enter the control button label. The Control Label field accepts three 
lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the 
desired location. Note that on the configuration page, the text displayed in the control button will be 
truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to 
the next line, you can eliminate a carriage return in some cases. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 
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PLC Bit Reference: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. Expressions or conditional logic cannot be entered. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Bar Trend Template – Control Definitions Tab with Numeric Control 
The Bar Trend Template - Control Definitions Tab dialog box with numeric control is shown 

elow. b
  

The fields in the Bar Trend Template - Control Definitions Tab dialog box with numeric control 
are described below. 

Input Value Expression: Allows you to enter any mathematical expression that must be performed on 
the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is 
used to designate the operator input. The expression entered here may include as many PLC word or 
bit references as needed, as well as mathematical operations. Parentheses may be used to change the 
order of operations. 

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples 
below. 

([?]-32)*5/9 
The operator’s input is changed from Fahrenheit to Celsius. 

[?]*([?]>=0)*([?]<=100)+([?]<0)*[123]+([?]>100)*[123] 
Target Word Address is [123] 
This expression limits entries between 0 and 100 to the PLC register. Any value outside this range 
has no effect on the value in the register. 

Refer to the list of Conditional Expression Operators for more information. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Target Word Address: Allows you to define the location of the operator’s input in the PLC as the 
result of the Input. 

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address 
[364#S16]. 

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual 
for information regarding the format for specific PLC word references. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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If the template is configured to have numeric control, a target address and input expression must be 
entered. Failure to include this information will result in a Watchdog Time-out error when the template 
is selected online. 

Password Protection: Allows you to lock out access to numeric entry unless the operator provides the 
correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are 
listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
Password protection must be validated each time the template is selected for numeric entry.  

The template will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 
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Line Trend Template 
Note that the Advanced Trending option must installed in the PanelMate unit and the Advanced 
Trending Template box must be selected in the New Configuration dialog box or in the 
Configuration Properties dialog box before a Line Trend Template can be created. 

Line Trend Templates are designed to collect, store, and represent data in a manner that provides a 
historical perspective on how a single data point has changed and some insight on how the data point 
may behave in the future. 

The Line Trend Template show current value, setpoint, and high and low alarm levels. The current 
value and setpoint display digitally. 

  
The Line Trend Template consists of three tabbed dialog boxes that are listed below. 

• Line Trend Template - Line Trend Attributes Tab 

• Line Trend Template - Pen Definitions Tab 

• Line Trend Template - Control Definitions Tab 
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Line Trend Template – Line Trend Attributes Tab 
The Line Trend Template - Line Trend Attributes Tab dialog box is shown below. 
  

The fields in the Line Trend Template - Line Trend Attributes Tab dialog box are described below. 

Device Name: Allows you to enter a device name. The device name will display in the upper area of 
the template in the normal font. You may press the Return key to insert a carriage return.  

The Device Name field has an auto centering capability. If you wish to center the Device Name, check 
the Device Names box in the Auto Centering field in the Configuration Properties dialog box. 

Note that the name used in the Device Name field may be part of an alarm message. Be aware that 
only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. 
The Device Name field allows you to enter more than 22 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 

Template Size In Cells 

Height: Allows you to enter the height of the Line Trend Template as 1, 2, or 3. The height of the 
Line Trend Template determines the number of trend samples that can be displayed at one time. 

Width: Allows you to enter the width of the Line Trend Template as 2, 3, 4, or 5. 
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Trigger Type: Allows you to select the trigger type for the trending. The selections are described 
below. 

Interval: Allows you to sample a trend value when a time period has elapsed. The Interval in 
conjunction with the Trend Scan Delay designates the time interval between trend samples. (The 
Trend Scan Delay is configured in the System Parameters - Communications Tab dialog box.) 

The following equation is used to calculate the time interval between trend samples: 

Trend Scan Delay x Interval = Sample Rate 

For example, if the Trend Scan Delay is 2 seconds and the Interval is 3, the sample rate will be 6 
seconds. 

If the Interval trigger type is selected, the Interval Expression field will be displayed. 

Discrete: Allows you to sample a trend value when an external value (e.g., a bit reference in the 
PLC) changes resulting in the Interval Expression value changing from false to true. If the 
Discrete trigger type is selected, the Discrete Expression field will be displayed. 

Change: Allows you to sample a trend value when the Value 1 Expression (trend value) changes. 
If the Change trigger type is selected, the Interval/Discrete Expression field will not be displayed. 

If the Line Trend Template has the Change trigger type configured and the source data is floating 
point instead of integer, the data in the template will only update when the value prior to the 
decimal point changes. When trending floating point values, it is better to use either the Interval or 
Discrete trigger types. 

Interval Expression: Appears only when the Interval trigger type is selected. The Interval Expression 
field determines the trend value sample rate. The result of the Interval Expression multiplied by the 
Trend Scan Delay (set in the System Parameters - Remote Tab dialog box) determines the trend 
value sample rate. The sample rate can range from 1 to 2,147,483 seconds. 

For example, if the Trend Scan Delay is configured for 2 seconds and the Interval Expression 
evaluates to 5, the trend will be updated every 10 seconds. If the resulting sample rate is 0, the data 
collection for the trend template will be disabled. If the Trend Scan Delay is 0, it is assumed as 1 
second when calculating the sample rate. 

Note that if an interval is selected that is too rapid for the PanelMate unit or PLC to keep up with the 
request, a blank space will appear where any interval has been missed. Low sample values might also 
cause a blank space to appear. To distinguish as low sample value from a missed interval, configure 
the minimum calibration lower than the lowest expected minimum value. 

• For PanelMate Grayscale units, Interval is the value that displays as a medium intensity 
horizontal bar to the right of the Value 1 bar. 

• For PanelMate Color units, Interval is the value that displays as a blue horizontal bar to the 
right of the Value 1 bar. 

Mathematical operations that may be used are multiplication, division, addition, and subtraction. You 
may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change 
the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refer to the list of Conditional Expression Operators for more information. 

 

 



 Chapter 10: Templates 203 

Discrete Expression: Appears only when the Discrete trigger type is selected.  The Discrete 
Expression field allows you to enter an expression so that a trend will be sampled when the result of 
the expression changes from false to true. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Deadband Range: Allows you to enter a number between 0-99 that will represent the percentage of 
the high alarm value minus the low alarm value that defines the width of the deadband. 

The deadband range is an area below the high alarm value and above the low alarm value, that must be 
crossed before Value is considered to have returned to normal status (go out of alarm). The deadband 
range prevents multiple alarm messages from being generated when Value is hovering around an 
alarm threshold. 

Alarm Acknowledge: Allows you to determine if the associated alarm must be acknowledged before 
the alarm is removed from the alarm list. 

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not 
selected, the alarm message will be  removed from the list when the alarm condition clears. Note that a 
cleared alarm message will be sent to the printer if one is configured. 

Chart Bg: Allows you to select the background color or intensity for the chart. The Chart Bg button 
will display the standard Color Selection Palette. 

Grid Line Setup 

These controls define a grid that displays on the Line Trend Template. 

Horizontal Lines: Allows you to elect the number of horizontal grid lines displayed for the Line 
Trend Template. 

Vertical Lines Every n Samples: Allows you to determine the spacing of the vertical grid lines. 

Color: Allows you to select the foreground color or intensity for the grid lines. The Color button 
will display the standard Color Selection Palette. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the template to be refreshed to properly reflect the layering of 
objects on the page whenever the template is updated. 

Enable Conditional Visibility: Allows you to determine if the Line Trend Template will appear on a 
page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not 
checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

 



204 Configuration Editor User’s Guide 

Line Trend Template – Pen Definitions Tab 
he Line Trend Template - Pen Definitions Tab dialog box is shown below. T

  

The fields in the Line Trend Template - Pen Definitions Tab dialog box are described below. 

Name/Max. Cal./Min. Cal. Value Expression: Line 1 in this list box corresponds to the top pen; line 
2 corresponds to the next pen, etc. It is not necessary to use all pens. If you do not want a particular 
pen, leave the line blank. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Name: Allows you to enter a name for the pen. The Name field accepts alphanumeric characters. 

Units: Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” 
or “gals”. The Units field accepts alphanumeric characters. 

Pen Color: Allows you to select the foreground color or intensity for the pen. The Pen Color button 
will display the standard Color Selection Palette. 

Alarm Color: Allows you to select the foreground color or intensity for the pen when the monitored 
value goes into an alarm condition. The Alarm Color button will display the standard Color Selection 
Palette. 

Max Calibration: Allows you to determine the highest point of the line trend. This value displays on 
the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed 
anywhere in the field. 

Min Calibration: Allows you to determine the lowest point of the line trend. This value displays on 
the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed 
anywhere in the field. 
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Value Expression: Allows you to enter a value expression. The result of this expression will be the 
value displayed in the Line Trend Template. This expression is any mathematical operation to be 
performed on the monitored value before it is displayed on the screen. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

The following examples of expressions use a generic format. Refer to the appropriate Communication 
Driver Manual for information regarding the format for specific PLC word references. 

[123] 
The expression can be a single word reference. This example references word 123. 

([123]*10)+[124] 
This mathematical expression includes PLC references and constants that solve to a value. 

[name1,242]+[name2,243] 
Information from multiple PLCs can be included in the same expression. In this expression, word 
242 in PLC name1 is added to word 243 in PLC name2. 

Refer to the list of Conditional Expression Operators for more information. 

Note that Line Trend Templates will not update if all references in these templates are unsolicited. If at 
least one reference in a Line Trend Template is not unsolicited, then all references will update. 

When floating point references are used, be certain the maximum possible value will not exceed the 
PanelMate unit’s unsigned 32-bit word limit (4,294,967,295). A value exceeding the limit will cause a 
Watchdog Time-out error or generate an Exception error during online or runtime operation. You may 
wish to consider using scaled integer values instead of floating point values. 

High Alarm Expression: Allows you to enter a High Alarm Expression. The results of the High 
Alarm Expression are compared to the results of the Value Expression. If Value exceeds the High 
Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the trend 
sample will be displayed as follows: 

• For PanelMate Grayscale units, the trend sample is displayed in the color defined in the 
Alarm Color field. The trend sample will continue to be displayed in the alarm color as other 
trend samples are being collected as long as Value exceeds the High Alarm Expression value. 
A High Alarm bar is shown in high intensity to the left of the Line Trend Template. 

• For PanelMate Color units, the trend sample is displayed in the color defined in the Alarm 
Color field. The trend sample will continue to be displayed in the alarm color as other trend 
samples are being collected as long as Value exceeds the High Alarm Expression value. A 
High Alarm bar is shown in red to the left of the Line Trend Template. 

The High Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also enter 
a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of 
operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

This is an optional entry. If no alarm is desired for this device, leave this field blank. 

Refer to the list of Conditional Expression Operators for more information.

 



206 Configuration Editor User’s Guide 

Low Alarm Expression: Allows you to enter a Low Alarm Expression. The results of the Low Alarm 
Expression are compared to the results of the Value Expression. If Value is less than the Low Alarm 
Expression value, an alarm message is placed in the alarm list. When in an alarm state, the trend 
sample will be displayed as follows: 

• For PanelMate Grayscale units, the trend sample is displayed in the Alarm Color field high 
intensity. The trend sample will continue to be displayed in the alarm color as other trend 
samples are being collected as long as Value is less than the Low Alarm Expression value. A 
Low Alarm bar is shown in high intensity to the left of the Line Trend Template. 

• For PanelMate Color units, the trend sample is displayed in the Alarm Color field. The trend 
sample will continue to be displayed in the alarm color as other trend samples are being 
collected as long as Value is less than the Low Alarm Expression value. A Low Alarm bar is 
shown in red to the left of the Line Trend Template. 

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also enter 
a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of 
operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

This is an optional entry. If no alarm is desired for this device, leave this field blank. 

Refer to the list of Conditional Expression Operators for more information. 
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Line Trend Template – Control Definitions Tab 
The Line Trend Template - Control Definitions Tab dialog box is shown below. 
  

The fields in the Line Trend Template - Control Definitions Tab dialog box are described below. 

Input Value Expression: Allows you to enter any mathematical expression that must be performed on 
the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is 
used to designate the operator input. The expression entered here may include as many PLC word or 
bit references as needed, as well as mathematical operations. Parentheses may be used to change the 
order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples 
below. 

([?]-32)*5/9 
The operator’s input is changed from Fahrenheit to Celsius. 

[?]*([?]>=0)*([?]<=100)+([?]<0)*[123]+([?]>100)*[123] 
Target Word Address is [123] 
This expression limits entries between 0 and 100 to the PLC register. Any value outside this range 
has no effect on the value in the register. 

Refer to the list of Conditional Expression Operators for more information. 
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Target Word Address: Allows you to define the location of the operator’s input in the PLC as the 
result of the Input. 

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address 
[364#S16]. 

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual 
for information regarding the format for specific PLC word references. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the template is configured to have numeric control, a target address and input expression must be 
entered. Failure to include this information will result in a Watchdog Time-out error when the template 
is selected online. 

Password Protection: Allows you to lock out access to numeric entry unless the operator provides the 
correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are 
listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
Password protection must be validated each time the template is selected for numeric entry. 

The template will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 

Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 
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Display Template 
Display Templates are designed to be used like standard LED or LCD message units or displays. They 
are most effective when used for informational messages and not as alarm messages. Up to three 
independent lines of text can be written in a Display Template. 

  
The actual creation of the message is done in the Message Library that can be selected from the 
Display Template - Expressions Tab dialog box or the Database Treeview Window. 

The Display Template consists of three tabbed dialog boxes that are listed below. 

• Display Template - Display Attributes Tab 

• Display Template - Expressions Tab 

• Display Template - Control Definitions Tab 
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Display Template – Display Attributes Tab 
he Display Template - Display Attributes Tab dialog box is shown below. T

  

The fields in the Display Template - Display Attributes Tab dialog box are described below. 

Template Size In Cells 
Height: Displays the height of the Display Template as 1. This value cannot be changed. 

Width: Allows you to enter the width of the Display Template as 3, 4, or 5. 

• A 3-wide template can display a message of up to 36 normal font characters 

• A 4-wide template can display up to 49 characters  

• A 5-wide template can display up to 62 characters. 
Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the template to be refreshed to properly reflect the layering of 
objects on the page whenever the template is updated. 

Enable Conditional Visibility: Allows you to determine if the Display Template will appear on a 
page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not 
checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Display Template – Expressions Tab 
he Display Template - Expressions Tab dialog box is shown below. w. T

    

The fields in the Display Template - Expressions Tab dialog box are described below. The fields in the Display Template - Expressions Tab dialog box are described below. 

Line/Message Expression/Test Msg#: Displays line numbers, message expressions, and test message 
numbers configured for the Display Template. The Line/Message Expression/Test Msg# box may 
contain up to three message expressions. Each line represents a single message and is numbered 1, 2, 
and 3 at the left of the line. 

Line/Message Expression/Test Msg#: Displays line numbers, message expressions, and test message 
numbers configured for the Display Template. The Line/Message Expression/Test Msg# box may 
contain up to three message expressions. Each line represents a single message and is numbered 1, 2, 
and 3 at the left of the line. 

Message Expression: Allows you to enter a message expression. The value of the Message 
Expression selects which message will be displayed. The result of the Message Expression should be a 
number that represents the number of a message in the Message Library. The message will be 
displayed in the Display Template. If the Message Expression results in a number greater than the 
maximum number allowed in the Message Library or less than 0 when running online, the previously 
displayed message will be erased. 

Message Expression: Allows you to enter a message expression. The value of the Message 
Expression selects which message will be displayed. The result of the Message Expression should be a 
number that represents the number of a message in the Message Library. The message will be 
displayed in the Display Template. If the Message Expression results in a number greater than the 
maximum number allowed in the Message Library or less than 0 when running online, the previously 
displayed message will be erased. 

If you have an associated .csv file for tags, you can access your tag names and references by using the If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the message expression results in an invalid equation (e.g., division by a value of zero, etc.), no 
message displays. If a message expression previously resulted in a valid value, but in a later scan 
results in an invalid equation, the previously displayed message will be erased. 

To display a message based on a bit, multiply the bit reference times the message number to produce 
the message number. For example, to display message #25 when bit [127 14] is on, enter [127 14]*25 
in the Message Expression field. 

The message expression can be as simple as a word reference (e.g., [253]) or a mathematical 
expression which solves to a value corresponding to a message number (e.g., [254]+12). The message 
expression can contain multiple PLC references. Note that the preceding examples are shown using a 
generic format. Refer to the appropriate Communication Driver Manual for information regarding the 
format for specific PLC word references. 

When the Message Expression is true, embedded references are updated on the screen and not sent to 
the printer. Messages configured for BOTH or PRINTER are sent to the printer when the Message 
Expression changes and also when changing pages. 
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Note that when going to a new page that has non-global messages, messages set for PRINTER or 
BOTH will print once for each PLC reference in the message expression. Non-global messages on a 
page set for PRINTER or BOTH will print when returning from the Alarm Page, Screen Blanking, and 
when pressing the Enable Fault Relay control button, since these actions are treated as page changes.  

Refer to the list of Conditional Expression Operators for more information. 

The Display Template also supports the display of ASCII strings from the PLC. To display ASCII 
strings, place the starting address of the ASCII characters within the Message Expression field, 
followed by the format specifier #ASC which then is followed by the number of characters to be 
displayed. When the PanelMate unit recognizes an ASCII format specifier (#ASC) in the message 
expression, the PanelMate unit will display the ASCII string from the PLC. Optionally, a byte-swap 
format specifier, #BSW, can be added to swap the order of character presentation on a word-by-word 
basis. The following table shows a block of generic PLC registers and the decimal, hex, and ASCII 
values for the registers.  

 
Registers 

Decimal 
Value 

Hex  
Value 

ASCII  
Value 

100 16706 4142 AB 
101 17220 4344 CD 
102 17734 4546 EF 
103 18248 4748 GH 
104 18762 494A IJ 
105 19276 4B4C KL 
106 19790 4D4E MN 
107 20304 4F50 OP 
108 20818 5152 QR 
109 21332 5354 ST 

If the following expressions are entered in the Message Expression field, the string will be displayed 
as shown below. 

Message Expression Displayed String 
[100#ASC20] ABCDEFGHIJKLMNOPQRS

T 
[100#BSW#ASC20] BADCFEHGJILKNMPORQT

S 
[105#ASC7] KLMNOPQ 
[105#BSW#ASC7] LKNMPOR 

ASCII registers displayed in this manner will appear in normal font with white foreground and black 
background. These display attributes (font size, foreground color, and background color) may be 
changed by defining them in the first two words of the string.  

The most significant byte of the first word must contain a 1. This will signal the PanelMate unit that 
the attributes are to be altered. The least significant byte of the first word must contain the font size 
key. 

01 = Normal 

02 = Graphic 

03 = Double-High 

04 = Quad 
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The most significant byte of the second word contains the foreground color, and the least significant 
byte contains the background color. The colors are numbered 1 through 255 and can be determined by 
using the Color Palette in the Configuration Software, counting left to right and top to bottom (e.g., 
black=1, blue=2, green=3, cyan=4, red=5, magenta=6, yellow=7, etc.). Refer to the examples below. 

Examples: 

If register 98 has a value of 260 (Hex 0104), and register 99 has a value of 1287 (hex 0507), then 
the message [98#ASC6] would display the string ABCDEF in Quad font with red characters on 
yellow background.  

If the byte swap format is used, then the bytes of the first two words need to be swapped. Register 
98 will have a value of 1025 (hex 0401) and register 99 will have a value of 1797 (Hex 0705). 
The message [98#BSW#ASC6] would then display the string BADCFE in Quad font with yellow 
characters on a red background. 

Test Message Number: Allows you to enter a test message number. To view a message on the page 
during configuration, a message number may be entered into the Test Message field. The message 
corresponding to this number will be displayed at the Display Template’s origin. If there is not a 
message defined for that number, the template will be blank. 

<Message Library>: Opens the Message Library dialog box. Refer to the Message Library topic 
for more information. 

 



214 Configuration Editor User’s Guide 

Display Template – Control Definitions Tab 
he Display Template - Control Definitions Tab dialog box is shown below. T

  

The fields in the Display Template - Control Definitions Tab dialog box are described below. 

Control Label/PLC Bit Reference: Displays the control labels and PLC bit references and allows 
you to define the control buttons on the right side of the PanelMate unit. Line 1 corresponds to the top 
control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all 
control buttons. Simply leave a line blank if you do not want a control button at a particular location. 

If a control button is defined, a small arrow will be displayed in the lower left corner of a template to 
indicate to the operator that a control function is available. 

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the 
referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the 
bit to a 0 (zero), thus providing a momentary input to the PLC. If a maintained input is desired, the bit 
may be latched in PLC logic. 

Control Label: Allows you to enter a label for a control button. This field accepts three lines of 
normal-sized alphanumeric characters. The text does not automatically wrap. Press the Return key to 
insert a carriage return. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

PLC Bit Reference: Allows you to enter a PLC bit reference for the control button. This field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. You cannot use expressions or conditional logic. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags.
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Variable-Sized Templates 
 

11 

In this chapter, you will learn: 

• About the Variable-Sized Indicator Template 

• About the Variable-Sized Bar Template 

• About the Variable-Sized Readout Template 

• About the Variable-Sized Display Template 

• About the Variable-Sized Graphic Template 

• About the Variable-Sized Control Button Template 
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Variable-Sized Indicator Template 
Variable-Sized Indicator Templates provide the ability to create high-density status displays. One of 5 
pre-defined indicators can be used to indicate the status of a device. To tie a state to information in the 
PLC, a conditional expression may be entered which, when evaluated to true, displays the 
characteristics defined for that line. The expression may be as simple as the condition of a single bit in 
the PLC (true = ON; false = OFF), a value comparison (register > constant), or a Boolean expression 
of up to 70 characters in length. 

  
The Variable-Sized Indicator Template consists of two tabbed dialog boxes which are listed below. 

• Variable-Sized Indicator Template - VS Indicator Attributes Tab 

• Variable-Sized Indicator Template - VS Indicator States Tab 
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Variable-Sized Indicator Template – VS Indicator Attributes Tab 
The Variable-Sized Indicator Template - VS Indicator Attributes Tab dialog box is shown below. 

The fields in the Variable-Sized Indicator Template - VS Indicator Attributes Tab dialog box are 
described below. 

Pixel Location 
X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Indicator 
Template. 

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Indicator 
Template. 

Template Size In Pixels 
Height: Allows you to enter the height in pixels for the Variable-Sized Indicator Template. Note 
that you can also re-size the template by dragging one of the selection handles (squares) in any 
direction. 

Width: Allows you to enter the width in pixels for the Variable-Sized Indicator Template. Note 
that you can also re-size the template by dragging one of the selection handles (squares) in any 
direction. 
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Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the variable-sized template to be refreshed to properly reflect the 
layering of objects on the page whenever the template is updated. 

Alarm Device Name: Allows you to enter a device name to be used as part of an alarm message. The 
Alarm Device Name field accepts normal-sized characters. 

The name used in the Alarm Device Name field may be part of an alarm message. Be aware that only 
25 characters for the Alarm Device Name will appear when the alarm message displays in Run Mode. 
The Alarm Device Name field allows you to enter more than 25 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 

Enable Conditional Visibility: Allows you to determine if the Variable-Sized Indicator Template will 
appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility 
box is not checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

 



 Chapter 11: Variable-Sized Templates 219 

Variable-Sized Indicator Template – VS Indicator States Tab 
The Variable-Sized Indicator Template - VS Indicator States Tab dialog box is shown below. 

The fields in the Variable-Sized Indicator Template - VS Indicator States Tab dialog box are 
described below. 

Alarm Message/Conditional Expression/Alm/Ack: Displays alarm messages, conditional 
expressions, alarms, and alarm acknowledgments configured for the Variable-Sized Indicator 
Template. If the conditional expression evaluates to true, the associated template characteristics will be 
displayed in Run Mode. Each Variable-Sized Indicator Template can display up to five alarm 
messages, depending upon conditions you define. Each line in this list represents one of the alarm 
messages. 

Conditional Expression: Allows you to enter a conditional expression. The conditional expression 
can be a numerical, logical or relational expression that evaluates to true or false. When a numerical 
expression is evaluated if the result is even (least significant bit = 0), the value is false, and if the result 
is odd (least significant bit = 1), the value is true.  

In Run Mode, if an expression is satisfied (true or false), the characteristics defined for that line are 
used to display the template. If more than one expression is satisfied at the same time, the line with the 
highest priority displays. Line 1 has the highest priority and line 5 has the lowest. 

When an expression results in an invalid equation (e.g., division by zero, etc.), no value or graphics 
are displayed.If a true expression goes false in a later scan, the display for the true expression is 
erased. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Refer to the appropriate Communication Driver Manual for information regarding the format for 
specific PLC word references. 

Refer to the list of Conditional Expression Operators for more information. 
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Colors 
Pen: Allows you to select the foreground color or intensity for the template. The Pen button will 
display the standard Color Selection Palette. 

Fill: Allows you to select the background color or intensity for the template. The Fill button will 
display the standard Color Selection Palette. 

Alarm 
Alarm: Allows you to designate any line of the template definition as an alarm state. If the Alarm 
box is selected and the conditional expression evaluates to be true, an alarm message will be 
placed in the alarm list and sent to the printer if one is configured. 

If the Alarm box is selected, the condition associated with the alarm will be monitored at all times, 
regardless of the page being displayed. Judicious use of the alarm state is recommended to 
maximize the response time of the PanelMate unit. 

Acknowledge: Allows you to determine if the associated alarm must be acknowledged before the 
alarm is removed from the alarm list. 

If the Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Acknowledge box is not 
selected, the alarm message will be automatically removed from the list when the alarm condition 
clears.  

Note that a cleared alarm message will be sent to the printer if one is configured. 

Alarm Message: Allows you to enter the alarm message that will be displayed on the alarm line 
when the state goes into alarm and to a printer if one is configured.  
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Variable-Sized Bar Template 
Variable-Sized Bar Templates are designed to replace analog meters and face plates found on a 
conventional control panel. The Variable-Sized Bar Templates can also be used along with Symbols or 
Graphic elements to simulate tank fills, pipe flow, conveyors, and other specific applications. They 
also allow for definition of high and low alarm levels. 

  
The Variable-Sized Bar Template consists of three tabbed dialog boxes which are listed below. 

• Variable-Sized Bar Template - VS Bar Attributes Tab 

• Variable-Sized Bar Template - Expressions Tab 

• Variable-Sized Bar Template - Control Definitions Tab 
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Variable-Sized Bar Template – VS Bar Attributes Tab 
The Variable-Sized Bar Template - VS Bar Attributes Tab dialog box is shown below. 

The fields in the Variable-Sized Bar Template - VS Bar Attributes Tab dialog box are described 
below. 

Pixel Location 
X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Bar 
Template. 

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Bar 
Template. 

Template Size In Pixels 
Height: Allows you to enter the height in pixels for the Variable-Sized Bar Template. Note that 
you can also re-size the template by dragging one of the selection handles (squares) in any 
direction. 

Width: Allows you to enter the width in pixels for the Variable-Sized Bar Template. Note that 
you can also re-size the template by dragging one of the selection handles (squares) in any 
direction. 

Alarm Device Name: Allows you to enter a device name to be used as part of an alarm message. The 
Alarm Device Name field accepts normal-sized characters. 

The name used in the Alarm Device Name field may be part of an alarm message. Be aware that only 
25 characters for the Alarm Device Name will appear when the alarm message displays in Run Mode. 
The Alarm Device Name field allows you to enter more than 25 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 
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Colors 
Bar: Allows you to select the foreground color or intensity for the template. The Bar button will 
display the standard Color Selection Palette. 

Erase: Allows you to select the background color or intensity for the template. The Erase button 
will display the standard Color Selection Palette. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the variable-sized template to be refreshed to properly reflect the 
layering of objects on the page whenever the template is updated. 

Direction: Allows you to determine which direction the dynamic portion of the bar will move. The 
selections are Up, Down, Left, and Right. 

Enable Conditional Visibility: Allows you to determine if the Variable-Sized Bar Template will 
appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility 
box is not checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

 



224 Configuration Editor User’s Guide 

Variable-Sized Bar Template – Expressions Tab 
The Variable-Sized Bar Template - Expressions Tab dialog box is shown below. 

The fields in the Variable-Sized Bar Template - Expressions Tab dialog box are described below. 

Expressions 
Value: Allows you to enter a value expression. The result of this expression will be the bar height 
displayed in the Variable-Sized Bar Template. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

Refer to the list of Conditional Expression Operators for more information. 

High Alarm: Allows you to enter a High Alarm Expression. The results of the High Alarm 
Expression are compared to the results of the Value Expression. If Value exceeds the High Alarm 
Expression value, an alarm message is placed in the alarm list. When in an alarm state, the bar 
color will be displayed as follows: 

• For PanelMate Grayscale units, the Variable-Sized Bar template is displayed with 
medium intensity characters on a blinking high intensity background. 

• For PanelMate Color units, the variable-sized template is displayed in white with a 
blinking red background. 

Note that if the high alarm value is greater than or equal to the Max Calibration value, the entire 
bar will be displayed in white and no blinking red will be shown. 

The High Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also 
enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the 
order of operations.This is an optional entry. If no alarm is desired for this device, leave this field 
blank. 
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If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

Refer to the list of Conditional Expression Operators for more information. 

Low Alarm: Allows you to enter a Low Alarm Expression. The results of the Low Alarm 
Expression are compared to the results of the Value Expression. If Value is less than the Low 
Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the 
bar colors will be displayed as follows: 

• For PanelMate Grayscale units, the variable-sized template is displayed with medium 
intensity characters on a blinking high intensity background. 

• For PanelMate Color units, the variable-sized template is displayed in white with a 
blinking red background. 

Note that if the low alarm value is less than or equal to the Min Calibration, the entire bar will be 
displayed in blinking red and no white will be shown. 

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also 
enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the 
order of operations.This is an optional entry. If no alarm is desired for this device, leave this field 
blank. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

Refer to the list of Conditional Expression Operators for more information. 

Maximum Calibration: Allows you to determine the highest point of the bar. This value displays on 
the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed 
anywhere in the field. 

Minimum Calibration: Allows you to determine the lowest point of the bar. This value displays on 
the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed 
anywhere in the field. 

Deadband Range: Allows you to enter a number between 0-99 that will represent the percentage of 
the high alarm value minus the low alarm value that defines the width of the deadband. 

The deadband range is an area below the high alarm value and above the low alarm value, that must be 
crossed before Value is considered to have returned to normal status (go out of alarm). The deadband 
range prevents multiple alarm messages from being generated when Value is hovering around an 
alarm threshold. 

Alarm Acknowledge: Allows you to determine if the associated alarm must be acknowledged before 
the alarm is removed from the alarm list. 

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not 
selected, the alarm message will be automatically removed from the list when the alarm condition 
clears.  

Note that a cleared alarm message will be sent to the printer if one is configured. 
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Variable-Sized Bar Template – Control Definitions Tab 
The Variable-Sized Bar Template - Control Definitions Tab dialog box is shown below.  

  
The fields in the Variable-Sized Bar Template - Control Definitions Tab dialog box are described 
below. 

Control Type: Allows you to define the control type used for the template. The selections are 
described below. 

None: Allows the template to show a value that the operator cannot control. 

Buttons: Requires the operator to use control buttons to change a setpoint value. If you choose 
Buttons, the dialog box will change. Refer to the Variable-Sized Bar Template - Control 
Definitions Tab with Button Control topic for more information. 

Numeric: Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box 
will change. Refer to the Variable-Sized Bar Template - Control Definitions Tab with 
Numeric Control topic for more information. 

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the 
template to indicate to the operator that a control function is available. 
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Variable-Sized Bar Template – Control Definitions Tab with Button Control 
The Variable-Sized Bar Templates - Control Definitions Tab dialog box with button control is 
shown below. 

The Variable-Sized Bar Template - Control Definitions Tab dialog box with button control defines 
the control buttons on your PanelMate unit. If a control button is defined, a small arrow will display in 
the lower left corner of the template to indicate to the operator that a control function is available. 

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the 
referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the 
bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be 
latched in PLC logic. 

The fields in the Variable-Sized Bar Template - Control Definitions Tab dialog box with button 
control are described below. 

Control Indicator 
Position: Allows you to select the position inside of the Variable-Sized Bar Template for control 
indicator arrow. The selections are listed below. 

• Left 
• Below 
• Right 
• Above 

Display: Allows you to determine if the arrow will always be visible or visible only when the 
template is selected. The selections are Always and On Selection. 
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Control Label/PLC Bit Reference: Displays the control button labels and the associated PLC Bit 
Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button 
down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a 
control button at that location. 

Control Label: Allows you to enter the control button label. The Control Label field accepts three 
lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the 
desired location. Note that on the configuration page, the text displayed in the control button will be 
truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to 
the next line, you can eliminate a carriage return in some cases. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

PLC Bit Reference: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. Expressions or conditional logic cannot be entered. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

 



 Chapter 11: Variable-Sized Templates 229 

Variable-Sized Bar Template – Control Definitions Tab with Numeric  Control  
The Variable-Sized Bar Templates - Control Definitions Tab dialog box with numeric control is 
shown below. 

The fields in the Variable-Sized Bar Template - Control Definitions Tab dialog box with numeric 
control are described below. 

Control Indicator 
Position: Allows you to select the position inside of the Variable-Sized Bar Template for control 
indicator arrow. The selections are listed below. 

• Left 
• Below 
• Right 
• Above 

Display: Allows you to determine if the arrow will always be visible or visible only when the 
template is selected. The selections are Always and On Selection. 
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Input Value Expression: Allows you to enter any mathematical expression that must be performed on 
the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is 
used to designate the operator input. The expression entered here may include as many PLC word or 
bit references as needed, as well as mathematical operations. Parentheses may be used to change the 
order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples 
below. 

([?]-32)*5/9 
The operator’s input is changed from Fahrenheit to Celsius. 

[?]*([?]>=0)*([?]<=100)+([?]<0)*[123]+([?]>100)*[123] 
Target Word Address is [123] 
This expression limits entries between 0 and 100 to the PLC register. Any value outside this range 
has no effect on the value in the register. 

Refer to the list of Conditional Expression Operators for more information. 

Target Word Address: Allows you to define the location of the operator’s input in the PLC as the 
result of the Input. 

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address 
[364#S16]. 

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual 
for information regarding the format for specific PLC word references. 

If the template is configured to have numeric control, a target address and input expression must be 
entered. Failure to include this information will result in a Watchdog Time-out error when the template 
is selected online. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

Password Protection: Allows you to lock out access to numeric entry unless the operator provides the 
correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are 
listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
Password protection must be validated each time the template is selected for numeric entry. 

The template will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 
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Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 
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Variable-Sized Readout Template 
Variable-Sized Readout Templates are designed to replace numeric and digital readout devices found 
on a conventional control panel, and to supply the functionality often provided by CRT-based devices. 
Displayed values can be scaled by the PanelMate unit without requiring any additional logic in the 
PLC. 

  
The Variable-Sized Readout Template consists of three tabbed dialog boxes that are listed below. 

• Variable-Sized Readout Template - VS Readout Attributes Tab 

• Variable-Sized Readout Template - Expressions Tab 

• Variable-Sized Readout Template - Control Definitions Tab 
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Variable-Sized Readout Template – VS Readout Attributes Tab 
The Variable-Sized Readout Template - VS Readout Attributes Tab dialog box is shown below. 

The fields in the Variable-Sized Readout Template - VS Readout Attributes Tab dialog box are 
described below. 

Pixel Location 
X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Readout 
Template. 

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Readout 
Template. 

Template Size In Characters 
Height: Displays the height of the Variable-Sized Readout Template as 1. This value cannot be 
changed. 

Width: Allows you to enter the width of the Variable-Sized Readout Template. Note that you can 
also re-size the width of the template by dragging the middle selection handle (square) on the right 
of the template. 
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Alarm Device Name: Allows you to enter a device name to be used as part of an alarm message. The 
Alarm Device Name field accepts normal-sized characters. 

The name used in the Alarm Device Name field may be part of an alarm message. Be aware that only 
25 characters for the Alarm Device Name will appear when the alarm message displays in Run Mode. 
The Alarm Device Name field allows you to enter more than 25 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 

Colors 
FG: Allows you to select the foreground color or intensity for the template. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the template. The BG button will 
display the standard Color Selection Palette. 

Font: Allows you to choose the font that is used to display the Variable-Sized Readout Template on 
the page. The selections are Normal, Double High and Quad. 

If redefined fonts are used in a Variable-Sized Readout Template, the associated Control Arrow may 
appear in the wrong position during online or runtime operation. 

Direction: Allows you to select the orientation in which the readout value is displayed. The selections 
are Horizontal (left-to-right) and Vertical (top-to-bottom). 

Decimal Places: Allows you to determine how the number will be formatted when displayed. This 
field accepts the numbers 0 through 9. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the variable-sized template to be refreshed to properly reflect the 
layering of objects on the page whenever the template is updated. 

Enable Conditional Visibility: Allows you to determine if the Variable-Sized Readout Template will 
appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility 
box is not checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Variable-Sized Readout Template – Expression Tab 
The Variable-Sized Readout Template - Expressions Tab dialog box is shown below. 

The fields in the Variable-Sized Readout Template - Expressions Tab dialog box are described 
below. 

Expressions 
Value: Allows you to enter a value expression. The result of this expression will be the value 
displayed in the Variable-Sized Readout Template. 

The expression entered may include as many PLC word or bit references as needed, as well as 
mathematical operations. Parentheses may be used to change the order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

Note that if a value is too large to display in the variable-size template, a string of Xs (XXXXX) 
will be displayed for the value. For example, if a Variable-Sized Readout Template was defined as 
three characters in length, but the value to be displayed was four characters, XXX would be 
displayed for the value. 

Refer to the list of Conditional Expression Operators for more information. 

High Alarm: Allows you to enter a High Alarm Expression. The results of the High Alarm 
Expression are compared to the results of the Value Expression. If Value exceeds the High Alarm 
Expression value, an alarm message is placed in the alarm list. 

• For PanelMate Grayscale units, the variable-sized template is displayed with medium 
intensity characters on a blinking high intensity background. 

• For PanelMate Color units, the variable-sized template is displayed with white characters 
on a blinking red background. 
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The High Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also 
enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the 
order of operations.This is an optional entry. If no alarm is desired for this device, leave this field 
blank. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

Refer to the list of Conditional Expression Operators for more information. 

Low Alarm: The results of the Low Alarm Expression are compared to the results of the Value 
Expression. If Value is less than the Low Alarm Expression value, an alarm message is placed in 
the alarm list. 

• For PanelMate Grayscale units, the variable-sized template is displayed with medium 
intensity characters on a blinking high intensity background. 

• For PanelMate Color units, the template is displayed with white characters on a blinking 
red background. 

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical 
operations that may be used are multiplication, division, addition, and subtraction. You may also 
enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the 
order of operations.This is an optional entry. If no alarm is desired for this device, leave this field 
blank. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 

Refer to the list of Conditional Expression Operators for more information. 

Deadband Range: Allows you to enter a number between 0-99 that will represent the percentage of 
the high alarm value minus the low alarm value that defines the width of the deadband. 

The deadband range is an area below the high alarm value and above the low alarm value, that must be 
crossed before Value is considered to have returned to normal status (go out of alarm). The deadband 
range prevents multiple alarm messages from being generated when Value is hovering around an 
alarm threshold. 

Alarm Acknowledge: Allows you to determine if the associated alarm must be acknowledged before 
the alarm is removed from the alarm list. 

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not 
selected, the alarm message will be automatically removed from the list when the alarm condition 
clears.  

Note that a cleared alarm message will be sent to the printer if one is configured. 
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Variable-Sized Readout Template – Control Definitions Tab 
The Variable-Sized Readout Template - Control Definitions Tab dialog box is shown below. 

  
The fields in the Variable-Sized Readout Template - Control Definitions Tab dialog box are 
described below. 

Control Type: Allows you to define the control type used for the template. The selections are 
described below. 

None: Allows the template to show a value that the operator cannot control. 

Buttons: Requires the operator to use control buttons to change a setpoint value. If you choose 
Buttons, the dialog box will change. Refer to the Variable-Sized Readout Template - Control 
Definitions Tab with Button Control topic for more information. 

Numeric: Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box 
will change. Refer to the Variable-Sized Readout Template - Control Definitions Tab with 
Numeric Control topic for more information. 

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the 
template to indicate to the operator that a control function is available. 
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Variable-Sized Readout Template – Control Definitions Tab with Button Control 
The Variable-Sized Readout Template - Control Definitions Tab dialog box with button control is 
shown below. 

The Variable-Sized Readout Template - Control Definitions Tab dialog box with button control 
defines the control buttons on your PanelMate unit. If a control button is defined, a small arrow will 
display in the lower left corner of the template to indicate to the operator that a control function is 
available. 

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the 
referenced bit (e.g., [120 00] to 1. When the button is released, a separate command is sent to set the 
bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be 
latched in PLC logic. 

The fields in the Variable-Sized Readout Template - Control Definitions Tab dialog box with 
button control are described below. 

Control Indicator 
Position: Allows you to select the position inside of the Variable-Sized Readout Template for 
control indicator arrow. The selections are listed below. 

• Left 

• Below 

• Right 

• Above 
When redefined fonts are used, the position of the control indicator arrow for a Variable-Sized 
Readout Template may appear in the wrong position in Run Mode. 

Display: Allows you to determine if the arrow will always be visible or visible only when the 
template is selected. The selections are Always and On Selection. 
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Control Label/PLC Bit Reference: Displays the control button labels and the associated PLC Bit 
Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button 
down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a 
control button at that location. 

Control Label: Allows you to enter the control button label. The Control Label field accepts three 
lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the 
desired location. Note that on the configuration page, the text displayed in the control button will be 
truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to 
the next line, you can eliminate a carriage return in some cases. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

PLC Bit Reference: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. Expressions or conditional logic cannot be entered. 
 
If you have an associated .csv file for tags, you can access your tag names and references by using the 

 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 
entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Variable-Sized Readout Template – Control Definitions Tab with Numeric Control 
The Variable-Sized Readout Templates - Control Definitions Tab dialog box with numeric control 
is shown below. 

The fields in the Variable-Sized Readout Template - Control Definitions Tab dialog box with 
numeric control are described below. 

Control Indicator 
Position: Allows you to select the position inside of the Variable-Sized Readout Template for 
control indicator arrow. The selections are listed below. 

• Left 
• Below 
• Right 
• Above 

Display: Allows you to determine if the arrow will always be visible or visible only when the 
template is selected. The selections are Always and On Selection. 
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Input Value Expression: Allows you to enter any mathematical expression that must be performed on 
the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is 
used to designate the operator input. The expression entered here may include as many PLC word or 
bit references as needed, as well as mathematical operations. Parentheses may be used to change the 
order of operations. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples 
below. 

([?]-32)*5/9 
The operator’s input is changed from Fahrenheit to Celsius. 

[?]*([?]>=0)*([?]<=100)+([?]<0)*[123]+([?]>100)*[123] 
Target Word Address is [123] 
This expression limits entries between 0 and 100 to the PLC register. Any value outside this range 
has no effect on the value in the register. 

Refer to the list of Conditional Expression Operators for more information. 

Target Word Address: Allows you to define the location of the operator’s input in the PLC as the 
result of the Input. 

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address 
[364#S16]. 

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual 
for information regarding the format for specific PLC word references. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the template is configured to have numeric control, a target address and input expression must be 
entered. Failure to include this information will result in a Watchdog Time-out error when the template 
is selected online. 

Password Protection: Allows you to lock out access to numeric entry unless the operator provides the 
correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are 
listed below: 

• None 

• Keyswitch Only 

• Keyswitch and Password A 

• Keyswitch and Password B 

• Keyswitch and Password A or B 

• Password A Only 

• Password B Only 

• Password A or B 
Password protection must be validated each time the template is selected for numeric entry. 

The template will not be displayed unless the operator provides the correct password or unlocks the 
security keyswitch wired to the PanelMate unit. 
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Password A and Password B are defined in the System Parameters - Password Tab dialog box. 

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer 
Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate 
Power Series 1500 or PanelMate Pro LT 1100, and is not available for PanelMate PC. 
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Variable-Sized Display Template 
Variable-Sized Display Templates are designed to replace LED or LCD message units or display 
readouts. They are most effective when used for informational messages (e.g., prompting or diagnostic 
information). 

  
The actual creation of the message is done in the Message Library  selected from the Variable-Sized 
Display Template - Expressions Tab dialog box. 

The Variable-Sized Display Template consists of three tabbed dialog boxes that are listed below. 

• Variable-Sized Display Template - VS Display Attributes Tab 

• Variable-Sized Display Template - Expressions Tab 

• Variable-Sized Display Template - Control Definitions Tab 
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Variable-Sized Display Template – VS Display Attributes Tab 
The Variable-Sized Display Template - VS Display Attributes Tab dialog box is shown below. 

The fields in the Variable-Sized Display Template - VS Display Attributes Tab dialog box are 
described below. 

Pixel Location 
X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Display 
Template. 

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Display 
Template. 

Template Size In Characters 
Height: Displays the height of the Variable-Sized Display Template as 1. This value cannot be 
changed. 

Width: Allows you to enter the width of the Variable-Sized Display Template. Note that you can 
also re-size the width of the template by dragging the middle selection handle (square) on the right 
of the template. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the variable-sized template to be refreshed to properly reflect the 
layering of objects on the page whenever the template is updated. 

Direction: Allows you to select the orientation in which the message is displayed. The selections are 
Horizontal (left-to-right) and Vertical (top-to-bottom). 
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Enable Conditional Visibility: Allows you to determine if the Variable-Sized Display Template will 
appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility 
box is not checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

It is not recommended to use the Conditional Visibility feature with Variable-Sized Display 
Templates. If a message is updated due to a PLC reference change, it may display the message 
regardless of the Visibility Expression. An alternative method of achieving the same result would be to 
use the Message Expression multiplied by the Visibility Expression and then deselect the Enable 
Conditional Visibility field. For example, if the Message Expression is [40210] and the Visibility 
Expression is [10322], then the new Message Expression would be [40210]*[10322] and Enable 
Conditional Visibility field would be deselected. When the Visibility Expression reference [10322] is 
false, the result would be to display the Message Number 0 which would display nothing. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 

If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Variable-Sized Display Template – Expressions Tab 
The Variable-Sized Display Template - Expressions Tab dialog box is shown below. 

The fields in the Variable-Sized Display Template - Expressions Tab dialog box are described 
below. 

Message Expression: Allows you to enter a message expression in the Variable-Sized Display 
Template. The result of the Message Expression represents the number of the message from the 
Message Library that will be displayed.  

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

If the Message Expression results in a number greater than the maximum number allowed in the 
Message Library or less than 0 when running online, the previously displayed message will be erased. 

If the message expression results in an invalid equation (e.g., division by a value of zero, etc.), no 
message displays. If a message expression previously resulted in a valid value, but in a later scan 
results in an invalid equation, the previously displayed message will be erased. 

To display a message based on a bit, multiply the bit reference times the message number to produce 
the message number. For example, to display message #25 when bit [127 14] is on, enter [127 14]*25 
in the Message Expression field. 

The message expression can be as simple as a word reference (e.g., [253]) or a mathematical 
expression which solves to a value corresponding to a message number (e.g., [254]+12). The message 
expression can contain multiple PLC references. Note that the preceding examples are shown using a 
generic format. Refer to the appropriate Communication Driver Manual for information regarding the 
format for specific PLC word references. 

When the Message Expression is true, embedded references are updated on the screen and not sent to 
the printer. Messages configured for BOTH or PRINTER are sent to the printer when the Message 
Expression changes and also when changing pages. 

Note that when going to a new page that has non-global messages, messages set for PRINTER or 
BOTH will print once for each PLC reference in the message expression. Non-global messages on a 
page set for PRINTER or BOTH will print when returning from the Alarm Page, Screen Blanking, and 
when pressing the Enable Fault Relay control button, since these actions are treated as page changes.  

When running online, if the message expression results in a value less than 0 or greater than permitted, 
then the previously displayed message will be erased. 
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Refer to the list of Conditional Expression Operators for more information. 

The Variable-Sized Display Template also supports the display of ASCII strings from the PLC. To 
display ASCII strings, place the starting address of the ASCII characters within the Message 
Expression field, followed by the format specifier #ASC which then is followed by the number of 
characters to be displayed. When the PanelMate unit recognizes an ASCII format specifier (#ASC) in 
the message expression, the PanelMate unit will display the ASCII string from the PLC. Optionally, a 
byte-swap format specifier, #BSW, can be added to swap the order of character presentation on a 
word-by-word basis. The following table shows a block of generic PLC registers and the decimal, hex, 
and ASCII values for the registers.  

 
Registers 

Decimal 
Value 

Hex  
Value 

ASCII  
Value 

100 16706 4142 AB 

101 17220 4344 CD 

102 17734 4546 EF 

103 18248 4748 GH 

104 18762 494A IJ 

105 19276 4B4C KL 

106 19790 4D4E MN 

107 20304 4F50 OP 

108 20818 5152 QR 

109 21332 5354 ST 

If the following expressions are entered in the Message Expression field, the string will be displayed 
as shown below. 

Message Expression Displayed String 

[100#ASC20] ABCDEFGHIJKLMNOPQRS
T 

[100#BSW#ASC20] BADCFEHGJILKNMPORQT
S 

[105#ASC7] KLMNOPQ 

[105#BSW#ASC7] LKNMPOR 

ASCII registers displayed in this manner will appear in normal font with white foreground and black 
background. These display attributes (font size, foreground color, and background color) may be 
changed by defining them in the first two words of the string.  

The most significant byte of the first word must contain a 1. This will signal the PanelMate unit that 
the attributes are to be altered. The least significant byte of the first word must contain the font size 
key. 

01 = Normal 

02 = Graphic 

03 = Double-High 

04 = Quad 
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The most significant byte of the second word contains the foreground color, and the least significant 
byte contains the background color. The colors are numbered 1 through 255 and can be determined by 
using the Color Palette in the Configuration Software, counting left to right and top to bottom (e.g., 
black=1, blue=2, green=3, cyan=4, red=5, magenta=6, yellow=7, etc.). Refer to the examples below. 

Examples: 

If register 98 has a value of 260 (Hex 0104), and register 99 has a value of 1287 (hex 0507), then 
the message [98#ASC6] would display the string ABCDEF in Quad font with red characters on 
yellow background.  

If the byte swap format is used, then the bytes of the first two words need to be swapped. Register 
98 will have a value of 1025 (hex 0401) and register 99 will have a value of 1797 (Hex 0705). 
The message [98#BSW#ASC6] would then display the string BADCFE in Quad font with yellow 
characters on a red background. 

Test Message Number: Allows you to enter a test message number. To view a message on the page 
during configuration, a message number may be entered into the Test Message field. The message 
corresponding to this number will be displayed at the Variable-Sized Display Template’s origin. If 
there is not a message defined for that number, the template will be blank. 

Global Message: Allows you to determine if the Variable-Sized Display Template will be a global 
message. To make a Variable-Sized Display Template global, select the Global Message box. The 
selection allows the PanelMate unit to monitor other Variable-Sized Display Templates not on the 
page being displayed in Run Mode. (Normally, the PanelMate unit only monitors the Variable-Sized 
Display Templates on the currently-visible page in Run Mode.) Templates on other pages are referred 
to as “global” templates. 

Any Global Message triggered during online operation will be sent to the printer if they have 
destination settings of Printer or Both. Global Messages are not sent to the screen if the page where 
they were configured is not visible. 

Global Messages only print when the Message Expression changes, not when the embedded references 
change. When you change to a page with Global messages, the Global Message will not print. If a 
hard-coded value (e.g. 100) is placed in the Message Expression, the Global Message will print only 
once at bootup. 

<Message Library>: Opens the Message Library dialog box. Refer to the Message Library topic 
for more information. 
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Variable-Sized Display Template – Control Definitions Tab 
The Variable-Sized Display Template - Control Definitions Tab dialog box is shown below. 

The Variable-Sized Display Template - Control Definitions Tab dialog box defines the control 
buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower 
left corner of the template to indicate to the operator that a control function is available. 

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the 
referenced bit (e.g., [120 00] to 1. When the button is released, a separate command is sent to set the 
bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be 
latched in PLC logic. 

The fields in the Variable-Sized Display Template - Control Definitions Tab dialog box are 
described below. 

Control Indicator 
Position: Allows you to select the position inside of the Variable-Sized Display Template for 
control indicator arrow. The selections are listed below. 

• Left 

• Below 

• Right 

• Above 
Display: Allows you to determine if the arrow will always be visible or visible only when the 
template is selected. The selections are Always and On Selection. 

Control Label/PLC Bit Reference: Displays the control button labels and the associated PLC Bit 
Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button 
down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a 
control button at that location. 
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Control Label: Allows you to enter the control button label. The Control Label field accepts three 
lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the 
desired location. Note that on the configuration page, the text displayed in the control button will be 
truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to 
the next line, you can eliminate a carriage return in some cases. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

PLC Bit Reference: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. Expressions or conditional logic cannot be entered. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Variable-Sized Graphic Template 
Variable-Sized Graphic Templates are similar in function and purpose to Indicator Templates except 
that the Indicator Template uses a pre-defined graphic while the Variable-Sized Graphic Template uses 
user-defined symbols for status indication. For more information on creating symbols, refer to the 
Make Symbol topic. 

Variable-Sized Graphic Templates can be used to indicate the status of a device and to control the 
device (e.g., by turning it ON or OFF). There are five lines to define the various states of the device. 
To tie a state to information in the PLC, a conditional expression may be entered which, when 
evaluated to true, displays the characteristics defined in the Pen and Fill fields for the Variable-Sized 
Graphic Template. The expression may be as simple as the condition of a single bit in the PLC (true = 
ON; false = OFF), a value comparison (register > constant), or a Boolean expression of up to 70 
characters in length. 

  
Note that when you select the Variable-Sized Graphic Template from the tool palette and click on the 
configuration page, the Select Symbol dialog box will appear. Select a symbol and click the OK 
button. The symbol you select is only a placeholder for the Variable-Sized Graphic Template you will 
configure. 

The Variable-Sized Graphic Template consists of three tabbed dialog boxes that are listed below. 

• Variable-Sized Graphic Template - VS Graphic Attributes Tab 

• Variable-Sized Graphic Template - VS Graphic States Tab 

• Variable-Sized Graphic Template - Control Definitions Tab 
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Variable-Sized Graphic Template – VS Graphics Attributes Tab 
The Variable-Sized Graphic Template - VS Graphics Attributes Tab dialog box is shown below. 

The fields in the Variable-Sized Graphic Template - VS Graphics Attributes Tab dialog box are 
described below. 

Pixel Location 
X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Graphic 
Template. 

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Graphic 
Template. 

Alarm Device Name: Allows you to enter a device name to be used as part of an alarm message. The 
Alarm Device Name field accepts normal-sized characters. 

The name used in the Alarm Device Name field may be part of an alarm message. Be aware that only 
25 characters for the Alarm Device Name will appear when the alarm message displays in Run Mode. 
The Alarm Device Name field allows you to enter more than 25 characters to allow for control key 
combinations for the redefined characters in the Font Editor. For more information on redefined 
characters, refer to the Font Editor topic. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of variable-sized template to be refreshed to properly reflect the 
layering of objects on the page whenever the variable-sized template is updated. 

Enable Conditional Visibility: Allows you to determine if the Variable-Sized Graphic Template will 
appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility 
box is not checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 
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If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Variable-Sized Graphic Template – VS Graphic States Tab 
The Variable-Sized Graphic Template - VS Graphic States Tab dialog box is shown below. 

The fields in the Variable-Sized Graphic Template - VS Graphic States Tab dialog box are 
described below. 

Symbol Name/Conditional Expression/Alm/Ack: Displays symbol names, conditional expressions, 
alarms, and alarm acknowledgments configured for the Variable-Sized Graphic Template. If the 
conditional expression evaluates to true, the associated symbol will be displayed in Run Mode. Each 
Variable-Sized Graphic Template can display up to five symbols, depending upon conditions you 
define. Each line in this list represents one of the symbols. 

Symbol: Allows you to enter the name of the symbol to be displayed when the corresponding 
conditional expression becomes true. 

Conditional Expression: Allows you to enter a conditional expression. The conditional expression 
can be a numerical, logical or relational expression that evaluates to true or false. When a numerical 
expression is evaluated if the result is even (least significant bit = 0), the value is false, and if the result 
is odd (least significant bit = 1), the value is true.  

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 

In Run Mode, if an expression is satisfied (true or false), the characteristics defined for that line are 
used to display the template. If more than one expression is satisfied at the same time, the line with the 
highest priority displays. Line 1 has the highest priority and line 5 has the lowest. 

When an expression results in an invalid equation (e.g., division by zero, etc.), no value or graphics 
are displayed. 

If a true expression goes false in a later scan, the display for the true expression is erased. 

Refer to the appropriate Communication Driver Manual for information regarding the format for 
specific PLC word references. 

Refer to the list of Conditional Expression Operators for more information. 
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Override Colors: Allows you to select colors for a symbol that displays as a result of a conditional 
expression. These colors are used instead of the colors defined when the symbol was created. A 
symbol’s objects for which the foreground or background is configured as None (transparent) are not 
affected by the Override Colors. 

Pen: Allows you to select the foreground color or intensity for the symbol. The Pen button will 
display the standard Color Selection Palette. 

Fill: Allows you to select the background color or intensity for the symbol. The Fill button will 
display the standard Color Selection Palette. 

Alarm 
Alarm: Allows you to designate any line of the template definition as an alarm state. If the Alarm 
box is selected and the conditional expression evaluates to be true, an alarm message will be 
placed in the alarm list and sent to the printer if one is configured. 

If the Alarm box is selected, the condition associated with the alarm will be monitored at all times, 
regardless of the page being displayed. Judicious use of the alarm state is recommended to 
maximize the response time of the PanelMate unit. 

Acknowledge: Allows you to determine if the associated alarm must be acknowledged before the 
alarm is removed from the alarm list. 

If the Acknowledge box is selected, the operator must acknowledge the corresponding alarm 
message before the alarm will be removed from the alarm list. If the Acknowledge box is not 
selected, the alarm message will be automatically removed from the list when the alarm condition 
clears.  

Note that a cleared alarm message will be sent to the printer if one is configured. 

<Symbol Library>: Opens the Select Symbol dialog box. Refer to the Select Symbol topic for more 
information. 
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Variable-Sized Graphic Template – Control Definitions Tab 
The Variable-Sized Graphic Template - Control Definitions Tab dialog box is shown below. 

The Variable-Sized Graphic Template - Control Definitions Tab dialog box defines the control 
buttons on your PanelMate unit. If a control button is defined, a control arrow will display inside the 
symbol at its origin to indicate to the operator that a control function is available. 

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the 
referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the 
bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be 
latched in PLC logic. 

The fields in the Variable-Sized Graphic Template - Control Definitions Tab dialog box are 
described below. 

Control Indicator 
Since the default location of the control arrow for a Variable-Sized Graphic Template is placed inside 
the symbol at it’s origin, the control arrow may be overwritten even if the Control Indicator Display 
field is configured as Always. To avoid overwriting the control arrow, reposition the control arrow to 
the left of the symbol origin by eight pixels by configuring the Control Indicator Arrow X and Y 
fields. 

X: Allows you to move the control indicator arrow in the Variable-Sized Graphic Template to the 
left or right. Note that this field is disabled until you configure the Control Label field or the Bit 
Reference field. 

Y: Allows you to move the control indicator arrow in the Variable-Sized Graphic Template up or 
down. Note that this field is disabled until you configure the Control Label field or the Bit 
Reference field. 
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Arrow: Allows you to choose the position of the control indicator arrow. The selections are listed 
below. 

• Right 

• Left 

• Up 

• Down 

• Right/Up 

• Right/Dn 

• Left/Up 

• Left/Dn 
Display: Determines if the arrow is always visible or visible only when the template is selected. 

Control Label/PLC Bit Reference: Displays the control button labels and the associated PLC Bit 
Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button 
down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a 
control button at that location. 

Control Label: Allows you to enter the control button label. The Control Label field accepts three 
lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the 
desired location. Note that on the configuration page, the text displayed in the control button will be 
truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to 
the next line, you can eliminate a carriage return in some cases. 

The Control Label field has an auto centering capability. If you wish to center the Control Label, 
check the Control Button Labels box in the Auto Centering field in the Configuration Properties 
dialog box. 

FG: Allows you to select the foreground color or intensity for the control label. The FG button will 
display the standard Color Selection Palette. 

BG: Allows you to select the background color or intensity for the control label. The BG button will 
display the standard Color Selection Palette. 

PLC Bit Reference: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts 
alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding 
control button. Expressions or conditional logic cannot be entered. 

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Variable-Sized Control Button Template 
The Variable-Sized Control Button is a one-touch button you can place anywhere a template or 
element can be placed. The Direct Select (Touchscreen Only) feature is intended for use on PanelMate 
touchscreen units and PanelMate NT units only. This template is intended for use with touchscreen 
units and should be used with the Direct Select feature in the System Parameters - General Tab 
dialog box. If the Direct Select feature is not enabled or if you use the Variable-Sized Control Button 
Template on a touchpanel unit, it becomes a two-step (select and execute) button. 

The Variable-Sized Control Button Template is used to provide a momentary control to the PLC (e.g., 
start and stop machinery) or to issue a local page change command. 

  
CAUTION: When placing a Variable-Sized Control Button on a page to issue a page 

change command, make sure there is not a Variable-Sized Control Button 
occupying the same location on the destination page. If multiple touches are 
attempted on the Variable-Sized Control Button, all touches after the first 
will be applied to the destination page. This will cause the Variable-Sized 
Control Button on the destination page to be executed, thus possibly 
resulting in unintended machinery operation or unintended page changes. 

When using the Variable-Sized Control Button Template to start machinery or to perform page 
changes, make sure you label the template clearly so it can be easily recognized and make the template 
large enough to ensure easy one-touch operation. This button is not labeled the same as standard 
control buttons. You must supply the appropriate dynamics graphics, static graphics, and/or text for 
the button. Note that if you wish to use a dynamic graphic to label the Variable-Sized Control Button, 
you must follow the steps below. 

• Configure the Lens Color field in the Variable-Sized Control Button - VS Control Button 
Attribute Tab dialog box as transparent by selecting None for the color. 

• Place the dynamic graphic and/or text behind the Variable-Sized Control Button by selecting 
the button and choosing the Bring to Front selection in the Object Menu. 

If these steps are not performed, the areas in the Variable-Sized Control Button covered by the 
dynamic graphic used in the label will not respond to the touch. 

The Variable-Sized Control Button Template consists of two tabbed dialog boxes that are listed below. 

• Variable-Sized Control Button Template - VS Control Button Attributes Tab 

• Variable-Sized Control Button Template - Control Definitions Tab 
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Variable-Sized Control Button Template – VS Control Button Attributes Tab 
The Variable-Sized Control Button Template - VS Control Button Attributes Tab dialog box is 
shown below. 

The fields in the Variable-Sized Control Button Template - VS Control Button Attributes Tab 
dialog box are described below. 

Pixel Location 
X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Control 
Button Template. 

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Control 
Button Template. 

Size in Pixels 
Height: Allows you to enter the height of the Variable-Sized Control Button Template in pixels. 

Width: Allows you to enter the width of the Variable-Sized Control Button Template in pixels. 

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and 
graphics that lie within the area of the variable-sized control button to be refreshed to properly reflect 
the layering of objects on the page whenever the variable-sized control button is updated. 

Lens Color: Allows you to select the color of the area inside the Variable-Sized Control Button. This 
button displays the standard Color Selection Palette. 

Enable Conditional Visibility: Allows you to determine if the Variable-Sized Control Button 
Template will appear on a page based on the value of the Visibility Expression. If the Enable 
Conditional Visibility box is not checked, the template will always appear on the page. 

It is important to note that a template, which is invisible because the Visibility Expression evaluates to 
false, will still impose the same memory and polling response impact as when the template is visible. 
Therefore, the visibility feature should not be used to circumvent page number or capacity limitations. 

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional 
Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the 
template will be erased and all template updating will be deactivated when in Run Mode. If the 
Visibility Expression evaluates to true (not equal to zero), the template will appear and all 
template updating will be activated when in Run Mode. 
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If you have an associated .csv file for tags, you can access your tag names and references by using 
the  button. You can also access them by entering a left bracket ([) or by entering a comma (,) 
after entering the PLC device name. For more information on tags, refer to Chapter 12: Using 
Tags. 
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Variable-Sized Control Button Template – Control Definitions Tab 
The Variable-Sized Control Button Template - Control Definitions Tab dialog box is shown 
below. 

The fields in the Variable-Sized Control Button Template - Control Definitions Tab dialog box are 
described below. 

Type: Allows you to select the type of control definition. The selections are described below. 

Normally Open, Momentary: Defines the PLC bit reference to be set to 1 when the 
corresponding control button is pressed. When the control button is released, the PLC bit 
reference will be set to 0. 

Normally Close, Momentary: Defines the PLC bit reference to be set to 0 when the 
corresponding control button is pressed. When the control button is released, the PLC bit 
reference will be set to 1. 

Normally Open, Maintained: Defines the PLC bit reference to be set to 1 when the 
corresponding control button is pressed. When the control button is released, there is no action. 

Normally Close, Maintained: Defines the PLC bit reference to be set to 0 when the 
corresponding control button is pressed. When the control button is released, there is no action. 

Toggle: Defines the PLC bit reference to be set to the inverse of the last setting when the 
corresponding control button is pressed. 

Page Change: Determines the page to be displayed when the page number is calculated in the 
Expression field. Note that the Expression field appears on the Variable-Sized Control Button 
Template – Control Definitions Tab dialog box when Page Change is selected in the Type field. 

Reference or Expression: Depending upon your selection in the Type field, this box will be labeled 
Reference or Expression. The Reference field will be displayed if you select Normally Opened 
Momentary, Normally Closed Momentary, Normally Opened Maintained, Normally Closed 
Maintained, or Toggle in the Type field. The Expression field will be displayed if you select Page 
Change in the Type field.  
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The selections are described below. 

Reference: Allows you to enter the PLC bit to be set while an operator presses the corresponding 
control button. This field accepts alphanumeric characters. Expressions or conditional logic 
cannot be entered. 

Expression: Allows you to determine the destination page when the corresponding control button 
is pressed. This field accepts numeric characters. Note that brackets are not required.  

If you have an associated .csv file for tags, you can access your tag names and references by using the 
 button. You can also access them by entering a left bracket ([) or by entering a comma (,) after 

entering the PLC device name. For more information on tags, refer to Chapter 12: Using Tags. 
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Using Tags  
 

12 

In this chapter, you will learn: 

• Advantages of Using Tags 

• About Tag Database Files 

• How Configuration Software Processes Tag References 

• How to Access Your Tags 

• How to Construct Expressions Using Tags 

• How to Edit Tags 

• How to Create a .CSV File 

• How the I/O Limit in a PanelMate Pro LT 1100 works 
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Tag Usage Overview 
Tags are used as a convenient method of referencing the I/O address in a PLC reference. A tag “name” 
can be directly associated with a specific PLC I/O address, ie: GATE OPEN = [B450/104]. There are 
several advantages for using tags in your PanelMate configuration: 

• After defining a tag, the tag can be reused anywhere in your PanelMate configuration. Instead 
of retyping the I/O address, you simply type in the tag name or select it from a pull down list 
or dialog box. 

• You can quickly change multiple, identical I/O addresses in your configuration by just editing 
the PLC address associated with the tag. 

• You can reuse tags in other PanelMate configurations. After you have developed a tag 
database, you can reuse the database in future PanelMate configurations. 

• You can adapt tag databases developed for other applications/products (ie: your PLC) for use 
with your PanelMate application., without defining the relationship between tags and 
addresses twice. 

• You can reduce development time and typing errors by selecting tags from pull down lists 
and dialog boxes instead of typing them. 

Tag Database Files 
Tags are stored in a tag database. There are many third-party software packages that can be used for 
creating and editing tag databases, including Microsoft Excel. Depending on the intended application 
for the tag database, the database may contain a variety of data related to each tag. For your PanelMate 
application, the Configuration software only requires two types of information: 

The Tag Name 

The PLC I/O address reference 

The Configuration software reads the tag name and I/O address information from a comma separated 
variable (.csv) file. Most third-party software packages will allow you to create a .csv file from your 
tag database. 

Note:  The .csv file is the only place where tag information can be stored. The file can be 
located anywhere accessible to the PanelMate Configuration software, but it can not be 
edited by the Configuration software. It is the user’s responsibility to maintain the 
content of the .csv file. 

.CSV File Format Parameters 
1 The following parameters must be followed when creating the tag name .csv file: 

2 A column ending is delimited by a comma character (0x2c). 

3 A row is delimited by a lline feed character (0x0a) and a carriage return character (0x0d). 

4 A row must contain 2 or more columns. One of the columns must be the Tag Name and another 
column must be the PLC I/O Address reference. 

5 Blank rows are permitted. 

6 A comma after the last column of a row is optional. 
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How Configuration Software Processes Tag References 
Tag name information is processed exclusively by the Configuration software. When a configuration 
is exported for downloading to a PanelMate online unit, the .pps file contains only the I/O address 
information. The tag name is not retained in the .pps file. 

The Configuration software processes tag references in four situations: 

• Entering tag information when configuring a template 
• Saving a configuration 
• Reference-to-tag replacement operations (tag refresh) 
• Exporting a configuration 

Entering Tag Information 
If a device in a configuration has an associated .csv file, when a reference is entered into the template’s 
Control Definition PLC Bit Reference field or Conditional Expression field (see Chapter 10), the 
reference is validated. The Configuration software searches the tag name field of the .csv file for the 
tag name that was referenced. If the tag name is found, the I/O address corresponding with the tag 
name is validated. If the tag name is not found in the .csv file, the configuration software assumes the 
tag name to be an I/O address and validates it. 

Note:  When the Configuration software searches for a tag name in a .csv file, the search is 
case insensitive. 

Saving A Configuration 

When a configuration is saved, the Configuration software will save the .csv file location and 
format information into the PLC Name and Port Table in the PanelMate database. When the 
configuration is opened, the configuration software will automatically open the associated 
.csv file. 

Note:  When opening a configuration, if the .csv file specified in the PLC Name and Port Table 
can not be found, the tags in the .csv file will not be loaded and a warning message will 
appear. 

Reference-To-Tag Replacement Operations 
A reference-to-tag replacement operation is performed when a user wants to replace an existing I/O 
address with a tag name. This operation is especially useful when importing a .pps file into the 
PanelMate database. Because .pps files do not contain tag references, the imported configuration will 
only contain I/O references. By associating a .csv file with the imported configuration, the user can 
replace all of the I/O references with the corresponding tag names. 

When performing a reference-to-tag replacement operation, the Configuration software searches the 
I/O Address Field of the .cvs file. If the I/O address is found in the I/O Address Field, the 
corresponding tag name will replace the I/O address throughout the configuration. If the I/O address is 
not found in the .csv file, the Tag Name Column is searched to verify that the tag exists in the .csv file. 
Tags that are not found in either the I/O Address Field or the Tag Name Column are listed in pop-up 
dialog box, allowing you to resolve the status of the unknown I/O address. 

CAUTION:  Prior to performing a reference–to-tag operation, confirm that your .csv file does not 
contain any duplicate tag name (same tag name, different I/O address). Duplicate tag 
names WILL NOT be replaced during reference-to-tag operations. 
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Note:  When the Configuration software searches for an I/O address in a .csv file, the search is case 
insensitive. If there is more than one tag name associated with the same I/O address, then the 
first one found in the .csv file is used.  

Note:  To perform a reference-to-tag operation, you must select the configuration in your Treeview. 
If you have a page selected, or any of the sub-categories (such as configuration pages, screen 
fonts, etc.) the Reference-To-Tag selection will not be accessible. Once the name of the 
configuration is selected, select the file pull-down menu in the configuration software and the 
References>Tags selection will be enabled. Click the References>Tags selection to complete 
the process. 

 

Exporting A Configuration 
When a configuration is exported and a .pps file is created, the Configuration software validates the 
information contained in the configuration. When a reference is validated, the configuration software 
searches the tag name field of the .csv file for the tag name that was referenced. If the tag name is 
found, the I/O address associated with the tag name is validated. If the tag name is not found in the 
.csv file, theconfiguration software assumes the tag name to be an I/O address and validates it. 
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Accessing Tags 
When building a PanelMate application, you may enter a tag name into any expression or reference 
field . An example of an expression and reference field is shown below. 

Expression Field

Reference Field

You can access your tag names and references by doing any of the following: 

• Enter a left bracket ( [ )  

• Enter a comma ( , ) after entering the PLC device name.  

• Click on the  button.  

If you enter a left bracket ( [ ) or the PLC device name and a comma ( , ), a drop down list will appear, 
shown below. You can enter the tag information to the expression or reference field by double clicking 
on the desired tag in the list. Or you can manually enter the tag, if desired. 

 

When you double click the  button associated with any reference or expression field, the Expression 
Edit dialog box will appear.  
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The Expresion Edit dialog box allows you to: 
 Select tags 
 Construct expresions 
 See where tags are used in your configuration 
 
The Expression Edit dialog box can be used in two views:  

 Tags From Tag Name File view  - displays all tags in tag file 

 Tag Cross Reference view – only displays tags used in the configuration  

 

The fields in the Expression Edit dialog box are described below: 
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Devices Field: Displays the device associated with the tag (.csv) file. 

Tag Name and Reference Field – Tags From Tag Name File Tab: The upper field displays the 
Tag Name and Reference. The lower field displays the Tag Name and Reference column 
information. Double clicking on a Tag Name and Reference in the upper field and pressing the 
OK button will select the tag and close the Expression Edit dialog box. 

Tag Name and Reference Field – Tag Cross Reference Tab: The upper field displays the Tag 
Name and References used in the configuration. When a Tag Name/Reference is highlighted, the 
lower field displays the specific “where used” information. 

Sort List By: Determines the order of information displayed in the Tag Name and Reference 
field. 

Tag Exp: This field displays the tag names and operators used in the Tag Expression.  For more 
information, refer to Constructing Expressions Using Tags. 

Ref Exp: This field displays the tag references and operators used in the Tag Expression.  For 
more information, refer to Constructing Expressions Using Tags. 

Operator Description Field: Displays the operators and descriptions commonly used in 
constructing expressions. Double clicking on an operator will add that operator to the expressions 
in the Tag Exp and Ref Exp fields. 

Edit File By: (Tags From Tag Name File view only) Launches Microsoft Notepad or Excel. For 
more information, refer to Editing Tags. 

Used Tag Update: (Tag Cross Reference view only) This button refreshes the list of used tags 
displayed in the Tag Name and Reference field. 
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Constructing Expressions Using Tags 
The Expression Edit dialog box provides an easy, powerful method of constructing expressions 
incorporating tag names and references.  

The following steps describe a typical expression construction process: 

Click on the  button associated with any reference or expression field to open the 
Expression Edit dialog box. 

1. 

2. Double click on the first Tag Name/Reference needed for the expression.  
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3. 

4. 

5. 

6. 

The Tag Name and Reference will appear in the Tag Exp and Ref Exp fields. 

Double click on the Operator needed for the expression. 

The Operator will appear in the Tag Exp and Ref Exp fields. 

Continue repeating Steps 2-4 until the expression is completed. Press the OK button to close 
the Expression Edit dialog box 

For more information on constructing expressions, refer to Appendix A: Conditional Expression 
Operators. 
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Editing Tags 
Your Configuration Editor can not edit a .csv file. You must use a third party software package such as 
Microsoft Excel or Notepad if you need to make changes to your .csv file. For convenience, you can 
launch Excel or Notepad from your Configuration Editor. Two launch points are available: 
Tag Name File dialog box 

This dialog box is accessed from the PLC Name and Port Table dialog box. Click on the Tag Name 
button to activate the Tag Name File dialog box. Select the Excel or Notepad radio buttons and then 
press the Edit… button. This launches the selected program. When you exit the program, you will 
return to the Tag Name File dialog box. 

Expression Edit dialog box 

This dialog box is accessed by clicking on the  button from any dialog box containing PLC 
references fields. In the Expression Edit dialog box, click on either the Excel or Notepad button to 
launch the desired program. When you exit the program, you will return to the Expression Edit dialog 
box. 
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Creating a .CSV File in Microsoft Excel 
If you would like to use tags in your PanelMate application but do not have an existing tag database, 
you can develop one using Microsoft Excel spreadsheet software. If you are not familiar with 
Microsoft Excel, you may wish to read the Microsoft Excel software user’s manual prior to starting 
your tag database. 

The Configuration software only requires two types of information: the Tag Name and the PLC I/O 
Address reference. In your Excel spreadsheet, designate one column as the tag name and a second 
column as the I/O address. You may wish to use additional columns to add notes or other information, 
however these columns will not recognized or used by the Configuration software. They will, 
however, be displayed in the  Excel spreadsheet. An example is shown below. 

Column 2
contains the

 I/O Address

Columns 3,4,5,& 6 contain additional 
data that is not recognized or used by
the PanelMate Configuration software

Column 1
contains the

 Tag Name

When you have finished entering all of your tag names and associated I/O address references, you 
must save the file as a .csv file. For easier future modifications, you should also consider saving the 
file as an Excel spreadsheet (.xls) 

After saving as a .csv file, you can associate the .csv file with your PanelMate configuration using the 
PLC Name and Port Table (see Chapter 7). 
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Creating a .CSV File From Your PanelMate Configuration 
If you have a PanelMate configuration that was developed without tags, you can export your 
references to a .csv file using the PLC Name and Port dialog box. Once created, you can associate the 
.csv file with a device in your source configuration or any other PanelMate configuration. To create a 
.csv file, use the following procedure: 

Step 1 
Open the PLC name and Port Table and click on the Tag File... button 

Click on 
Tag File...
button

Go to the
PLC Name and
Port Table
dialog box

 

Step 2 
Click on the NEW... button in the Tag Name File dialog box 

Click on the 
New... button
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Step 3 
Choose a file name and path for the .csv file in the Create a New Tag Name dialog box. 

Step 4 
A Message box will appear asking if you want to create cross reference information. Both a  “NO” or 
“YES” response will produce a .csv file.  

A “NO” response will produce a simple Tag Name file with two columns of information: the Tag 
Name and the Tag Reference. 

A “YES” response will produce a Tag Name file with additional columns of data containing PLC 
cross reference information. 

Samples of both types of .csv files are shown in Step 6. 

Step 5 
After selecting “NO” or “YES”, the .csv file is automatically generated.and associated with the device 
in your configuration. The Tag Name File dialog box will reappear, displaying the reference data. 

Although the .csv file is now associated with your device and configuration, it only contains tag 
reference data. The reference data is displayed in both the Tag Name Column and the Reference 
Column. To make the .csv useful, you will need to assign tag names to the references. 
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Step 6 
To assign tag names to the references, select the Excel radio button and then click on the Edit... 
button. This will launch Excel and display your .csv file data in a spreadsheet format for easy editing. 

 If you chose a “NO” response in Step 4, your tag name and reference data will appear in the first two 
columns of the Excel spreadsheet as shown below: 

Column 1 
contains 
Tag Names

Column 2 
contains 
References

Note:  Since your configuration did not contain any tag names, the PLC reference information 
is placed in both the Tag Name column and the Reference column. You will need to 
assign actual tag names, as described in Step 7. 

If you chose a “YES” response in Step 4, your tag name and reference data will appear in the first two 
columns, and your PLC reference data will appear in columns 3, 4, etc. Although data in columns 3 
and beyond are not used by the Configuration software, the data does provide an overall summary of 
your configuration. An example is shown below: 

Column 1 
contains 
Tag Names

Column 2 
contains 
References

Columns 3 and beyond contain 
PLC cross reference information 
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Step 7 
The final step is to replace the duplicate references in the Tag Name Column with actual tag names. 
After tag names have been assigned to the references, your edits are saved and the .csv file can now be 
use to convert your configuration’s references to tags. See “References to Tag Replacement 
Operations” for more information. 

Convert duplicate references
to Tag Names
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Tags and I/O References in the PanelMate Pro LT 1100 
When building a PanelMate application for the PanelMate Pro LT 1100, there is an I/O reference 
count limit that applies to the application.  The number of I/O references that are allowed in a 
PanelMate Pro LT 1100 application depends on the number of I/O expansion options that have been 
applied to the 1100.  The default limit is 64 I/O references.  Expansion options are available in 64 
reference blocks, up to a maximum total of 512 I/O references. 

CAUTION: Once a tag upgrade is loaded onto a PanelMate Pro LT 1100, it is there permanently. It 
cannot be removed or relocated to another unit or back to the tag key. Careful planning in determining 
the number of actual tag references that are to be used should be exercised before loading a tag 
upgrade. 

An I/O reference is any unique I/O address used by the configuration, including scratchpad 
references (internal references created by the user but local to the PanelMate).  An individual I/O 
reference may be used as many times as needed by the configuration, and will only count as a single 
I/O reference.  Each additional different reference counts as another I/O reference against the total I/O 
count limit. 

When using Tags in the configuration, the PanelMate Power Pro software resolves the Tag names into 
I/O references at the time of Export.  Each unique tag name that references a different I/O address 
counts as an I/O reference against the total I/O count limit.  Multiple tag names that reference the same 
I/O address will only count as a single I/O reference against the total.  Unused tag names do not count 
against the total I/O count. 

A list of tag names and I/O references used by an application are given below as an example: 

BELT REVERSE B450/122 
BELT RUN  B450/124 
BELT STOP  B450/120 
COUNT 1 RS B450/110 
COUNT 2 RS B450/112 
COUNT 1 CV B450/110 
(No tagname) B450/124 

In the list shown above, there are 7 tags and I/O references.  Of the 7 tags and references, there are 
only 5 unique I/O references.  This list would count for 5 I/O references against the total I/O count 
limit. 

A quick way of calculating the number of unique tags and I/O references used by a configuration is to 
use the Create New Tag File feature in the PLC Name and Port Table (refer to Chapter 7: PLC Name 
and Port Table).  To create a new tag file for a communication device, use the following procedure: 

1. Open the PLC Name and Port Table 
2. Select a communication device from the PLC Name Parameters section 
3. Click on the Tag File… button 
4. In the Tag File dialog box, click on the New… button 
5. Enter a name for the .CSV file to be created, and click OK 

On file creation, the Configuration Editor displays the new file’s contents.  The fourth line of the file 
will display the number of unique tags for the selected device, plus one for the input expression 
operator ([?]).  By repeating the above process for each communication device in the PLC Name 
Parameters section, the total unique I/O reference count can be obtained, excluding internal scratchpad 
references.  Note that if an existing tag file is used for editing, Cancel the new tag file creation, and 
not save the newly created tag file. 

An additional method for calculating the number of unique tags and I/O references used by a 
configuration is to use the Tag Cross Reference feature of the Expression Edit Dialog box, and 
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manually count the listed references. See the previous section, Accessing Tags, for more information 
on using the Tag Cross Reference feature. 

The final calculation of the total number of I/O references used in an application is made by the 
PanelMate Pro LT 1100.  If the I/O reference count exceeds the allowable count for the 1100, the unit 
displays an error message showing the number of references exceeding the limit when loading the 
application.  After displaying the error message, the 1100 resets to the offline menu.  Refer to the 
PanelMate Power Pro Online Operation User’s Guide for more information. 
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Conditional Expression Operators 
 

A 

In this chapter, you will learn: 

• About the Conditional Expression Operators 
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Conditional Expression Operators 
The operators are listed in order of precedence. Level 1 has the highest precedence and level 14 has 
the lowest precedence. All operators on the same level are evaluated left to right. You can use 
parentheses to change the order of operation. For more information on the conditional expressions, 
refer to the Conditional Expression Examples topic. 

No. Operator Description No. Operator Description 

1  sqr()  Square root 1  abs() Absolute value 

1  log() Base 10 log 1  nlog()  Natural log 

1  sin() Sine 1   cos() Cosine 

1  tan()  Tangent 1   asin()  Arcsine 

1  acos()  Arccosine 1  atan()  Arctangent 

2  ~  NOT (bit-wise) 3  exp  Exponential 

4  **  Power 5  *  Multiply 

5  /  Divide 5  %  Modulo 

6  -  Subtract 6  + Add 

7  >>  Shift right 7  <<  Shift left 

8  < Less than 8  <= Less than or equal 
to 

8  > Greater than 8  >= Greater than or 
equal to 

9  = Equal to 9  <>  Not equal to 

10  &  AND (bit-wise) 11  ^  XOR (bit-wise) 

12  |  OR (bit-wise) 13  &&  Logical AND 

14  ||  Logical OR    

Note the following items: 

• All operators must be lower case when entered in a conditional expression. 

• The results of all trigonometric functions are in radians. 

• A space is required before and after the exp operator. For example: 2 exp 5. 
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Conditional Expression Examples 
The following conditional expression examples are grouped into categories. Refer to the sections 
below. 

Note that spaces are not required between references. 

General Examples 
The following general examples are shown using a generic format. See the appropriate 
Communication Driver Manual sent with your PanelMate software for more specific information. 

[204 06] 
A conditional expression can be as simple as a single bit reference that resolves to true if the bit is 
on. 

[204 03] && [204 04] && [205 07] 
This conditional expression resolves to true if bit 3 of word 204, bit 4 of word 204, and bit 7 of 
word 205 are all on. 

[35] >500 
This conditional expression resolves to true if the value of word 35 is greater than 500. 

[?]*([?]>=0)*([?]<=100)+([?]<0)*[123]+([?]>100)*[123] 
This conditional expression limits entries between 0 and 100 to the PLC register. Any value 
outside this range has no effect on the value in the register. 

Trigonometry Function Examples 
sin([1]) will return the sine of the contents of register 1. 

abs([1]) will return the absolute value of the contents of register 1. 
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Bit-wise Function Examples (using 8 bits) 
Bit-wise functions produce numerical answers based on the numerical values of the operands and the 
operation being performed. Assume [1] contains the value 5 (0000 0101 binary) and [1] contains the 
value 6 (0000 0110 binary). 

~[1] =  ~(0000 0101) = 1111 1010 

[1] & [2] =  0000 0101 
  & 0000 0110 
   -------------- 
   0000 0100 = 4 

[1] | [2] =  0000 0101 
  | 0000 0110 
   -------------- 
   0000 0111 

[1] ^ [2] =  0000 0101 
  ^ 0000 0110 
   -------------- 
   0000 0011 

[1] >> 2 = 0000 0101 >> 2 = 0000 0001 = 1. 

[1] << 3 = 0000 0101 << 3 = 0010 1000 = 40. 

Logical Function Examples 
Logical functions produce answers that are either TRUE (1) or FALSE (0) by performing operations 
on their operands using either their numerical value for comparisons or their logical value such that 
FALSE = 0 and TRUE = anything but 0 (zero). Assume that the address [1] contains the value 5, the 
address [1] contains the value 6, and the address [3] contains the value 0. 

[1] > [2] = 5 > 6 = false = 0. 

[1] < [2] = 5 < 6 = true = 1. 

[1] || [2] = 5 || 6 = true || true = true = 1. 

[2] && [3] = 6 && 0 = true && false = false = 0. 

Note that =, <>, >=, and <= work similarly. 

Exponential Function Examples 
Assume that the address [1] contains the value 5 and the address [2] contains the value 6. 

[1] ** [2] = 5 ** 6 = 5 raised to the 6th power. 

[1] exp [2] = 5 exp 6 = 5 times 10 raised to the 6th power. 
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Word and Bit References 
 

B 

In this chapter, you will learn: 

• About the Word and Bit References 
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Word and Bit References 
This topic describes the word and bit formats used by the PanelMate unit for reading and writing data 
to/from the PLC. 

PLC Word References 
All of the editors use the same format for referencing PLC words. To refer to a specific word in any 
expression, use the following format ... 

[plcname,word#format] 

The fields plcname and #format are optional. If no information is entered in these fields, default values 
are used. 

PLC Word Format Fields 
plcname, The six character (or less) name of the designated PLC followed by a 

comma. The PLC name is defined in the PLC Name and Port Table dialog 
box. See the PLC Name and Port Table topic for more information about 
this name. 

If plcname is omitted, the default PLC (defined in the PLC Name and Port 
Table dialog box) is used. 

This field is optional. 

word The actual PLC reference number of the word to be read or written, using 
the addressing nomenclature of the PLC defined by plcname. 

See the specific PLC section for more information about word reference 
numbers.  

#format A three-character or four-character code preceded by a number sign (#). 
This code specifies the format of all PLC data read or written. 

If #format is omitted, the default formats will be used as noted in the 
Communication Driver Manuals. 
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The PanelMate unit recognizes the following formats ... 

#S16 Signed, 16 bit integer between -32768 and 32767 inclusive. The sign is 
defined by the high order bit. 

#U16 Unsigned, 16 bit integer between 0 and 65535 inclusive.  

#S32* Signed, 32 bit integer between -2,147,483,648 and 2,147,483,647 inclusive. 
The sign is defined by the high order bit. 

#U32* Unsigned, 32 bit integer between 0 and 4,294,967,295 inclusive.  

#BCD3 Three-digit binary coded decimal number between 0 and 999. 

#BCD4 Four-digit binary coded decimal number between 0 and 9,999. 

#BCD6* Six-digit binary coded decimal number between 0 and 999,999. 
The number is stored in two contiguous registers, three digits per register. 

#BCD8* Eight-digit binary coded decimal number between 0 and 99,999,999. 
The number is stored in two contiguous registers, four digits per register. 

#BIN3 Three-digit decimal number between 0 and 999. 

#BIN4 Four-digit decimal number between 0 and 9,999. 

#BIN6* Six-digit decimal number between 0 and 999,999. 
The number is stored in two contiguous registers, three digits per register. 

#BIN8* Eight-digit decimal number between 0 and 99,999,999. 
The number is stored in two contiguous registers, four digits per register. 

* When specifying these data formats, the address specified for word defines the first of 
the two registers (the one with the lower reference). This register will contain the most 
significant portion of the number. 
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#FP 32-bit floating point number between +/-1.20x10^-38 and 3.40x10^38 using the 
IEEE format. The 32 bits contain three fields: 

• 1 sign bit 

• Eight-bit biased exponent 

• 23-bit mantissa with a 24th implicit normalized bit. 

The normalized bit is always 1 for non-zero numbers. The bit is recognized 
implicitly and not stored. The decimal point is placed immediately to the right 
of the implicit normalized bit. 

The exponent has a bias of 7F HEX (127 decimal). 

The mantissa is precise to seven decimal places. 

The PanelMate unit does not convert the bits in the PLC to any other data type, 
but reads the bits as they are stored in the PLC. The PLC stores the bits as 
shown below ... 

---------------------------------------------- 
MSB.........................LSB 
1 Bit | 8 Bits  |  23 Bits 
Sign | Exponent |  Mantissa 
---------------------------------------------- 

When the number of significant digits in a value exceeds the number of digits 
for the display, the value is displayed in exponential notation provided the 
length of the value field is equal to or greater than ... 

• five for positive numbers 

• six for negative numbers 

The exponential format is ... 

• [-]n.nnnE-nn for negative exponents 

• [-]n.nnnE nn for positive exponents 

Note that seven significant digits (not including the sign and decimal point) are 
valid. If the field is longer than seven significant digits, the additional 
information may be erroneous. 

When you send data to the PLC, the PanelMate unit deletes any high order bits above the range 
allowed. 

BCD and BIN formats do not support negative values. Expressions can be used to scale values in the 
PanelMate unit so the operator enters and reads negative numbers, but positive numbers are written to 
or read from the PLC. 

Note: For PMPC/ePro configurations, set up to communicate through an OPC server. Refer to the 
appropriate help documentation for details on configuring the floating point format type. 
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PLC Bit References 
All of the editors use the same format for referencing PLC bits. To refer to a specific bit in any 
expression, use the following format ... 

[plcname,bit] 

The field plcname is optional. If no information is entered in this field, default values are used. 

PLC Bit Format Fields 

plcname, The six character (or less) name of the designated PLC followed by a 
comma. The PLC name is defined in the PLC Name and Port Table 
dialog box. See the PLC Name and Port Table topic for more 
information about this name. 

If plcname is omitted, the default PLC (defined in the PLC Name and 
Port Table dialog box) is used. 

This field is optional. 

bit The actual PLC reference number of the bit to be read or written, using 
the addressing nomenclature of the PLC defined by plcname. 

See the specific PLC section for more information about word reference 
numbers.  
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Using Graphics from other Software 
 

C 

In this chapter, you will learn: 

• About using graphics from other software 
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Using Graphics from other Software 
You can cut and copy graphics from other window-based packages (such as CorelDraw and AutoCad) 
and paste the graphics into the Configuration Software using the Windows clipboard. The graphic will 
be converted to a bitmap or PowerGraphic. Once the graphic has been inserted, you can make it a 
symbol. 

The other application must be able to output to the Windows clipboard in a Windows bitmap or 
metafile format.  
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Editing Graphics  
 

D 

In this chapter, you will learn: 

• About editing graphics 
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Editing Graphics 
You can use the keyboard keys to move, resize, or select objects. The following lists some suggestions 
for using the keyboard keys. 

• The Arrow keys will move the selected object(s) one pixel. 

• The SHIFT key with the Arrow keys will move the selected object(s) five pixels. 

• The CTRL key with the Arrow keys will re-size the selected object(s) one pixel. 

• The TAB key will select the next object that was created on a page. 

• The SHIFT and TAB keys will select the previous object that was created on a page. 

• The F2 key will open the Object Properties dialog box when the object is selected. 
Keyboard keys used to select, resize, move, select next, or select previous objects will not function on 
a configuration page when another window has been selected. For example, if an object is selected and 
the cursor is placed inside of the color selection palette and the Arrow keys are used to select different 
colors on the palette, the Arrow keys cannot be used to move the selected object unless the 
configuration page and the object are re-selected. This also applies when an object is selected and the 
cursor is placed inside of the Select Font box or the Pen Width box on the toolbar.  

 



 Appendix E: Configuration Editor Problems 293 

Configuration Editor Problems  
 

E 

In this chapter, you will learn: 

• Solutions to some common Configuration Editor problems 
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Configuration Editor Problems 
Some common configuration editor problems and solutions are listed below.  

For information on online or transfer problems, refer to the Online Operation User’s Guide or the 
Transfer Utility User’s Guide. 

Problem Possible Cause Corrective Action 

Configuration Editor could not 
open the database. 

1. Share.exe is not loaded. 1. Load share. 

 2. The NetNamePath in the 
win.ini file under [Paradox 
Engine] is not pointing to a 
valid pathname. 

2. Change the path to the 
correct database directory. 

 3. pmconfig.db is not found in 
the specified directory. 

3. Ensure the path points to a 
valid database directory. 

 4. The database path in 
pmconfig.ini (in Windows 
directory) does not point to a 
valid database. 

4. Ensure the database path 
points to a valid database. 
Note that this is updated 
automatically when the 
database path is changed 
within the Configuration 
Editor. 

 5. The database resides on a 
shared drive on a network and 
is currently open by another 
user. 

5. Once the other user closes 
the database, you will be able 
to open it. 

 6. The Configuration Editor 
terminated abnormally through 
a General Protection Fault or 
hardware power failure and 
left the database in a “locked” 
state. 

6. If you are absolutely sure 
the database is not open on 
your system, or another system 
from a network connection: 
delete the two lockfiles in the 
database, paradox.lck and 
pdoxusrs.lck. 
Then, re-open the database. 

The pull down menu font 
selection does not display all 
options when a large font 
video driver is used. 

 Use the arrow keys to view all 
font selections. 
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Problem Possible Cause Corrective Action 

The error “General Protection 
Fault” occurs during an export 
of a configuration containing 
bitmaps. 

Incompatibility with the video 
driver. 

Replace the video driver with a 
standard Windows (VGA) 
driver and re-export. 

The error “File exception 
occurred while reading 
database” appears in the 
Configuration Software while 
trying to export a 
configuration. 

Insufficient disk space. Ensure there is sufficient disk 
space where the Temp 
directory or folder is located. 

Colors or blinks shown in the 
editor do not match those 
shown in the online unit. 

1. Switching between 
Windows applications that use 
different color palettes. 

1. Try switching out of the 
editor and back again or close 
the editor and re-open it. If 
these actions correct the 
problem, then the video driver 
has a bug. Proceed to 
corrective action 3. 

 2. The video driver selected in 
the Windows Control Panel is 
not a 256-color driver. 

2. Select a 256-color driver 
from the video driver list in the 
Windows Control Panel. 

 3. The selected video driver 
has a bug. 

3. Contact the video card 
manufacturer for an updated 
version that corrects this driver 
bug. 

PanelMate Series 1500 unit 
has sluggish performance 
when layered symbols are used 
and the Conditional Visibility 
feature is enabled.  

 Install the Dynamic Graphics 
option and use Variable-Sized 
Graphic objects instead of 
layered symbols. 
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